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Chapter 1

Welcome to Live

1.1 The Ableton Team Says: Thank You

Live is the result of musicians wanting a better way to create, produce and perform music
using a computer. A great deal of effort has been put into making Live easy and fun to
use, yet at the same time capable of helping you create music with unlimited depth and
sophistication. This effort continues even as you read these lines... in fact, a new, improved
Live version might already be available for download! Please check on our website now1,
or choose �Check for Updates� from the Help menu.

We hope you enjoy using Live and that it enhances your creative process. Should you have
suggestions about how we can improve Live, please let us know2.

1http://www.ableton.com/downloads
2contact@ableton.com
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Your Ableton Team.

1.2 What's New in Live 5?

1.2.1 Remix Features

� Support for MP3, Ogg Vorbis, Ogg FLAC and FLAC compressed audio �les

� Auto-Warp

� Complex Warp Mode for warping music containing beats, tones and textures

� Clip scrub, nudge and improved transport controls

1.2.2 Organizational Tools for Files and Sets

� File search function

� Better browsing for �les and folders

� Live Clip format for easy storage and retrieval of clip and device settings

� Import and export of Live Sets and their components directly from the Browser

� Open Recent Set command

1.2.3 Clip and Track Enhancements

� Track Freeze for conserving CPU resources and simplifying project sharing
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� Track Delay controls to control for human, acoustic and hardware delays

� Multi-selection clip editing

� Clip deactivation option

1.2.4 Working with Arrangements

� Launchable Arrangement Locators

� New Arrangement Transport

� Track I/O in the Arrangement View

1.2.5 Editing MIDI

� Detailed and adaptive MIDI quantization options

� Preview in the MIDI Editor

� MIDI note deactivation option

1.2.6 MIDI and Key Remote Control

� Mackie Control support

� Improved mapping for the crossfader
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1.2.7 Resources

� Valuable library of clips, device presets and Live Sets

� Library expansion and customization with Live Packs

� New interactive built-in program lessons

1.2.8 Live Effects and Instruments

� Beat Repeat for reorganizing and �shredding� beats and vocals

� Phaser and Flanger

� Auto Pan for LFO-driven manipulation of amplitude and panning

� Saturator for subtle-to-drastic distortion effects

� Arpeggiator

� New features for Simpler and Operator

1.2.9 Using Devices

� Browser-based device preset management

� Device groups for saving multi-effect combinations together with instruments

� Device delay compensation for Live and plug-in instruments and effects

� Live can receive MIDI messages from plug-ins

� VST Plug-ins can be stored in various directories
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1.2.10 Miscellaneous

� (PC) / Ctrl (Mac) context menus for many commands and settings

� Zoom-adaptive or �xed grid options

� Count-in recording

� Monitoring status easily visible when the In/Out section is hidden

� Files, Sets and presets can be dragged into Live from the Explorer (Windows) / Finder
(Mac)



Chapter 2

First Steps

When you install Live and run it for the �rst time, you will be presented with the Products
Preferences tab.

If you own Live, you can authorize your copy of the software by selecting it from the listed
products and clicking the Unlock button at the bottom of the window. Please see the chapter
on unlocking Live should you have questions or concerns that arise during the unlocking
process.

If you do not (yet) own Live, you can close the Preferences and proceed, as Live will run in
Demo Mode by default. In Demo Mode, you will be able to work with all of Live's features
with the exception of saving and exporting.
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2.1 Learn About Live

Live comes with a set of interactive lessons to take you step by step through the key features
of the program. The lessons are organized in a table of contents, which can be opened
directly in the program via the Help menu. We highly recommend following the lessons.
Many users have told us that the lessons helped them get familiar with the program very
quickly.

We also recommend that you read the Live Basics chapter, which encapsulates everything
that Live is and can do, and is therefore a worthwhile read for both beginners and expe-
rienced users. The remaining chapters of this manual serve as in-depth reference for the
material introduced in Live Basics.

2.1.1 Using the Info View and Index

Live's Info View tells you the name and function of the user interface element currently under
the mouse.
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The Info View.

If you require more information on a speci�c user interface element or topic, please consult
this reference manual. The index, found at the end of the manual, contains the names of all
user interface elements and will lead you to the relevant section.

2.2 Setting up Preferences

Live's Preferences dialog is where you can �nd various settings that govern how Live looks,
behaves and interfaces with the outside world. This dialog is accessed with the Options
menu's (Windows) / Live menu's (Mac OS X) �Preferences� entry.

Live's Preferences are distributed over several tabs:

� The Audio Preferences are used to set up Live's audio connections with the outside
world via an audio interface. Please take the time to follow the program's built-in
�Setting up Audio I/O� lesson, which will walk you through all the steps required to
set up and optimize the settings for any given system. To access the lesson, choose
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�Lessons Table of Contents� from the Help menu.

� The MIDI/Sync Preferences are used to help Live recognize MIDI devices for three
separate and distinct purposes:

� Playing MIDI notes. To learn how to route an external device into Live for MIDI
input, or how to send MIDI to an external device, please see the chapter on
routing.

� Controlling parts of the interface remotely. This subject is covered in detail in the
chapter on remote control.

� Syncing the program with an external sequencer or drum machine, either as a
master or a slave. Please see the manual section on sync for details.

� The Plug-In Preferences pertain to the use of plug-in virtual instruments and effects,
as described in the chapter on using plug-ins.

� The Default Preferences allow customizing the default state for new projects and their
components, as well as selecting options for new recordings.

� The Misc(ellaneous) Preferences include various options. Here, you can select Live's
system language and a color scheme, or �skin,� for the Live user interface.

� The Products Preferences are used to manage licensing and installation of the Live
platform, and add-on components like the Operator instrument and Live Pack library
packages.

2.3 The Main Live Screen

Most of your work in Live happens in the main Live screen. This screen consists of a number
of views. Each view manages a speci�c aspect of your project. As screen space is limited,
the Live views cannot all be up at the same time.
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Each one of the selector buttons at the screen borders calls up a speci�c view; click this one,
for instance, to access the Live devices:

A View Selector.

To hide one of Live's views and free up screen space, click on the triangle-shaped button
next to it. To restore the view, click the button again.

A View Show/Hide
Button.

You can run Live in Full Screen Mode by selecting �Full Screen� from the View menu. To
leave Full Screen Mode, click the button that appears in the lower right corner of the screen.
Full Screen Mode can also be toggled by pressing the F11 key.

You can adjust the main window's horizontal split by dragging.
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Adjusting the Main
Window Split.



Chapter 3

Unlocking Live

Live is protected against illegal use by a copy protection scheme. This scheme has been
designed to meet the highest security standards while avoiding hassles for the customer. If
you �nd this procedure to be an inconvenience, please understand that the copy protection
secures your investment: It allows Ableton to provide you with support and to continue
developing Live.

Authorization of Ableton products takes place in the Preferences' Products tab, which will
appear when you start Live for the �rst time.

Here you can choose to authorize (�unlock�) or purchase any Ableton products available to
you, for example the Operator instrument.

Please note that products such as Operator are sold separately from Live but are unlocked
using the same procedure described in the following sections. They can also be individually
set to Demo Mode in the Products tab so that you can try them out.

12
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The Products Tab in the
Preferences.

Clicking on any product listed in the Products tab will give you the option of unlocking or
buying that product. Please click the Unlock button here to complete the unlocking process
in two steps. If you have not yet purchased the product, you can do so online by clicking the
Buy button. You can always return to the Products Preferences tab later or visit the Ableton
webshop1 to make a purchase. Live's Preferences are available via the Options menu (or
the Live menu in Mac OS X).

Selecting the Unlock
Button in the Products
Tab.

1http://www.ableton.com/shop

http://www.ableton.com/shop
http://www.ableton.com/shop
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3.1 Step 1: Entering Your Serial Number

As an owner of Live, you have received a Serial Number from Ableton, either via e-mail (if
you ordered Live directly from Ableton), or on a card as part of the Live package.

The Fields for Entering
Your Serial Number.

After selecting �Unlock� in the Products tab, you will be presented with six �elds for typing
in your Serial Number. Each �eld holds four characters. The Serial Number is composed of
numbers 0..9 and letters A..F. If you accidentally type the wrong string into a �eld, the �eld
will turn red. When you have successfully entered the Serial Number, click the �Ok� button
to proceed.

The Serial Number identi�es your ownership of Live. Because your Serial Number is a
valuable good, you should keep it in a safe place and out of reach of unauthorized hands.
Please be aware that sharing your Serial Number will render it unusable. The only way for
Ableton technical support to help you get back your Serial Number if you lose it is via your
registration data. Therefore, please register your product2, as otherwise you might lose
your property!

3.2 Step 2: Unlocking Live

The second step of authorizing Live is called �unlocking.� Unlocking means associating
your Serial Number with a speci�c computer. Please be aware that the standard Live license
grants you the right to use Live on only one computer at a time. You can, however, unlock

2http://www.ableton.com/register

http://www.ableton.com/register
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Live with your Serial Number more than once under the legal and technical conditions
described later.

3.2.1 The Unlock Key

For unlocking, you require an Unlock Key that can only be created by the Ableton server.
Unlocking therefore requires access to the Internet. The computer from which you connect
to the Internet does not have to be the same computer for which you wish to unlock Live,
but it does make things easier.

3.2.2 The Challenge Code

The Ableton server creates the Unlock Key from your Serial Number and a so-called Chal-
lenge Code. The Challenge Code is a ��ngerprint� that Live takes of your computer's
components. For details, please see the corresponding section.

3.2.3 Unlocking Online

Unlocking Live Online.

If the computer you want to unlock Live for is connected to the Internet, the only thing you
need to do is press the Unlock Online button. Live will then create a connection to the
Ableton server, send your Serial Number and Challenge Code, and receive the Unlock Key
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from the server. No information other than this is exchanged between your computer and
the Ableton server.

3.2.4 Unlocking Of�ine

Unlocking Live Of�ine.

If the computer you want to unlock Live for is not connected to the Internet, you can use
any other computer to access the Ableton server's web interface3. This is a website with
�elds for entering your Serial Number and the Challenge Code, which you can copy from
Live's Unlock dialog.

The Live Unlocking Web
Site.

3http://www.ableton.com/unlock

http://www.ableton.com/unlock


3.2. STEP 2: UNLOCKING LIVE 17

If you have entered your Serial Number and Challenge Code correctly, another website will
appear to provide you with the Unlock Key. There now are two options for transferring the
Unlock Key to the computer that is to be unlocked:

Follow the weblink to download the Unlock Key as a �le. Transfer the �le to the target
computer via a diskette or CD-ROM. Then, press the Unlock dialog's Load Unlock Key
button to load the Unlock Key �le.

The Unlock Key Can Be
Downloaded as a Text
File.

OR it might be more convenient to print the webpage with the Unlock Key on it. On the
target computer, press the Enter Unlock Key button to open a dialog with �elds for typing
in the Unlock Key. Typing it in is easier than it �rst appears, because the �elds will turn red
if you type the wrong string.
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Manually Enter Your
Unlock Key.
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3.3 Copy Protection FAQs

3.3.1 Can I Use Live or Other Ableton Products Without a Serial Num-
ber?

If you do not (yet) own Live, you can work with Live in Demo Mode. Demo Mode offers
Live's complete functionality, but saving and exporting are disabled.

Live will run in Demo Mode by default if it has not been authorized. You can try out other
Ableton products, such as the Operator instrument, by individually switching them to Demo
Mode in the Products tab of the Preferences.

Demo Mode can also be deactivated on a product-by-product basis in the Product Prefer-
ences.

If running Live or another product in Demo Mode raises your interest in purchasing it, please
select it from the Products Preferences tab and then click the Buy button, or visit the Ableton
webshop4. This site contains information about Ableton's distributor and dealer network.
It also offers you the opportunity to buy Ableton products online. Live's Preferences are
available via the Options menu (or the Live menu in Mac OS X).

4http://www.ableton.com/shop

http://www.ableton.com/shop
http://www.ableton.com/shop
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Click Here if You Are
Interested in Buying
Live.

3.3.2 What if I Change My Computer's Components?

If the Challenge Code of your computer changes for some reason, Live will indeed ask
you to unlock the software another time. The Challenge Code does not change, however,
when computer peripherals are replaced (audio or MIDI hardware, printers, modems). The
Challenge Code may change if the motherboard, processor or network card is replaced. On
some computers, reformatting a hard drive also changes the Challenge Code.

3.3.3 Can I Unlock Live More than Once?

The standard Live license allows you to use Live on only one computer at a time. However,
if you have registered your product5, the Ableton server will provide you with two Unlock

5http://www.ableton.com/register

http://www.ableton.com/register
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Keys in good faith that you will use Live on only one machine at a time. Just proceed as
described in the corresponding section.

You can therefore run Live on both a studio desktop computer and a tour laptop, but not at
the same time.

Should the Ableton server reject your demand for another Unlock Key, please contact
Ableton's technical support.

They can be reached by:

� E-mail6;

� Telephone: +49 (0)30 - 288 763 151 (available Monday to Friday 11 to 15hrs CET);

� Fax: +49 (0)30 - 288 763 11.

To speed up the process, please:

� Register your copy of Live7;

� Include a brief explanation of the circumstances.

To use Live on more than one computer at a time, you require a secondary license or a site
license. Ableton offers these licenses at special rates. Please contact the sales team8 for
details.

3.3.4 Can I Play my Set from a Computer That Is Not Unlocked?

In Demo Mode, you can load and perform a Live Set with no time limitation. You cannot,
however, save or export your work. When you go on tour, consider taking along your Live

6support@ableton.com
7http://www.ableton.com/register
8orders@ableton.com

mailto:support@ableton.com
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program CD and a CD with the last state of your Live Set(s). In case of an emergency, you
can install and run Live on any computer available and play your backup Live Set(s).

3.3.5 How Can I Turn Demo Mode Off?

If Live is unlocked but other products are set to Demo Mode, Live will also run in Demo
Mode, and you will not be allowed to save or export your work. To turn Demo Mode off
in this case, activate the Hide option for each additional product in its respective Product
Preference page.

Click Here to Hide a
Product's Features.

You can always choose to show a product again later, and then try out its features by using
them in Demo Mode.
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3.3.6 What Do I Do About Problems or Questions Regarding Copy Pro-
tection?

Please contact technical support9. They are happy to help!

9support@ableton.com

mailto:support@ableton.com


Chapter 4

Live Basics

This chapter introduces the essential concepts of Live. We advise you to read this chapter
early in your Live career, as a solid understanding of the program's basic principles will help
you fully exploit Live's potential for your music-making.

4.1 Live Sets

The type of document that you create and work on in Live is called a Live Set. Live Sets can
be opened either through the File menu's Open command or via the built-in File Browsers.
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A Live Set in the
Browser, Accessed via
the Library Button.

Pressing the Library button in Live's Browser will take you to Live's library of creative tools.
There are a number of starter Sets here; double-clicking a Live Set's name in the Browser
will open that Live Set.

4.2 Arrangement and Session

The basic musical building blocks of Live are called clips. A clip is a piece of musical material:
a melody, a drum pattern, a bass line or a complete song. Live allows you to record and
alter clips, and to create larger musical structures from them: songs, remixes, DJ sets or
stage shows.

A Live Set consists of two environments that can hold clips: The Arrangement is a layout of
clips along a musical timeline; the Session is a real-time-oriented �launching base� for clips.
Every Session clip has its own play button that allows launching the clip at any time and in
any order. Each clip's behavior upon launch can be precisely speci�ed through a number of
settings.

Clips in the Session View
(Left) and in the
Arrangement View
(Right).

The Arrangement is accessed via the Arrangement View and the Session via the Session
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View; you can toggle between the two views using the computer's Tab key or their respective
selectors. Because the two views have distinct applications, they each hold individual
collections of clips. However, it is important to understand that �ipping the views simply
changes the appearance of the Live Set and does not switch modes, alter what you hear or
change what is stored.

The Arrangement and
Session View Selectors.

Arrangement and Session interact in useful (though potentially confusing) ways. One can,
for instance, improvise with Session clips and record a log of the improvisation into the
Arrangement for further re�nement. This works because Arrangement and Session are
connected via tracks.

4.3 Tracks

Tracks host clips and also manage the �ow of signals, the creation of new clips through
recording, sound synthesis, effects processing and mixing.
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A Track in the
Arrangement View.

Session and Arrangement share the same set of tracks. The tracks are vertically laid out from
left to right in the Session View, and horizontally from top to bottom in the Arrangement
View. A simple rule governs the cohabitation of clips in a track:

A track can only play one clip at a time.

Therefore, one usually puts clips that should play alternatively in the same Session View
column, and spreads out clips that should play together across tracks in rows, or so-called
scenes.

A Scene in the Session
View.

The exclusivity of clips in a track also implies that, at any on time, a track will either play a
Session clip or an Arrangement clip, but never both. So, who wins? When a Session clip
is launched, the respective track stops whatever it is doing to play that clip. In particular, if
the track was playing an Arrangement clip, it will stop it in favor of the Session clip � even
as the other tracks continue to play what is in the Arrangement. The track will not resume
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Arrangement playback until explicitly told to do so. The Play, Stop, Record
and Back to
Arrangement Buttons.

This is what the Back to Arrangement button, found in the Control Bar at the top of the
Live screen, is for. This button lights up to indicate that one or more tracks are currently not
playing the Arrangement, but are playing a clip from the Session instead.

We can click this button to make all tracks go back to the Arrangement. Or, if we like what
we hear, we can capture the current state into the Arrangement by activating the Record
button. Disengaging Record Mode or stopping Live using the Stop button leaves us with
an altered Arrangement.

4.4 Audio and MIDI

Clips represent recorded signals. Live deals with two types of signals: audio and MIDI. In the
digital world, an audio signal is a series of numbers that approximates a continuous signal
as generated by a microphone or delivered to a loudspeaker. A MIDI signal is a sequence
of commands, such as �now play a C4 at mezzo piano.� MIDI is a symbolic representation
of musical material, one that is closer to a written score than to an audio recording. MIDI
signals are generated by input devices such as MIDI or USB keyboards1.

It takes an instrument to convert MIDI signals into audio signals that can actually be heard.
Some instruments, such as Live's Simpler, are for chromatic playing of one sound via the
keyboard. Other instruments, such as Live's Impulse, have a different percussion sound
assigned to each keyboard key.

Audio signals are recorded and played back using audio tracks, and MIDI signals are

1For an introduction to digital audio and MIDI, please see http://img.uoregon.edu/emi/emi.php and
http://www.midi.org/
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recorded and played back using MIDI tracks. The two track types have their own corre-
sponding clip types. Audio clips cannot live on MIDI tracks and vice versa.

Information about inserting, reordering and deleting audio and MIDI tracks is found here.

4.5 Audio Clips and Samples

An audio clip contains a reference to a sample (also known as a �sound �le� or �audio �le�)
or a compressed sample (such as an MP3 �le). The clip tells Live where on the computer's
drives to �nd the sample, what part of the sample to play and how to play it.

When a sample is dragged in from one of Live's built-in File Browsers, Live automatically
creates a clip to play that sample. Prior to dragging in a sample, one can audition or
preview it directly in the Browser; the switch in the Browser with the headphone icon
activates previewing.

Samples Are Dragged in
from Live's File Browsers.

Live offers many options for playing samples in exciting new ways, allowing you to create an
abundance of new sounds without actually changing the original sample � all the changes
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are computed in real time, while the sample is played. The respective settings are made in
the Clip View, which appears on screen when a clip is double-clicked.

An Audio Clip's
Properties as Displayed
in the Clip View.

Many powerful manipulations arise from Live's warping capabilities. Warping means chang-
ing the speed of sample playback independently from the pitch so as to match the project
tempo as adjusted in the Control Bar's Tempo Field.

The Control Bar's Tempo
Field.

The most elementary use of this technique, and one that usually requires no manual setup,
is synchronizing sample loops to the chosen tempo. Live's Auto-Warp algorithm actually
makes it easy to line up any sample with the project tempo, such as a recording of a drunk
jazz band's performance. It is also possible to radically change the sonic signature of a
sound using extreme warp settings.

4.6 MIDI Clips and MIDI Files

A MIDI clip contains musical material in the form of MIDI notes and controller envelopes.
When MIDI is imported from a MIDI �le, the data gets incorporated into the Live Set, and



4.6. MIDI CLIPS AND MIDI FILES 31

the original �le is not referenced thereafter. In the Live File Browsers, a MIDI �le appears
as a folder that can be opened to reveal its individual component tracks, which can be
selectively dragged into the Live Set.

MIDI Files Are Dragged
in from Live's File
Browsers.

As expected, a MIDI clip's contents can be accessed and edited via the Clip View, for
instance to change a melody or �paint� a drum pattern.

A MIDI Clip's Properties
as Displayed in the Clip
View.
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4.7 Devices and the Mixer

A track can have not only clips but also a chain of devices for processing signals. Double-
clicking a track's title bar brings up the Track View, which shows the track's device chain.

The Track View
Displaying an Audio
Track's Device Chain.

Live's built-in audio effects, MIDI effects and instruments are available from the Device
Browser and can be dragged from there into the Track View or onto a track title bar.
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Live's Built-in Devices
Are Available from the
Device Browser.

You can also use plug-in devices in Live. VST and Audio Units (Mac OS X only) Plug-ins are
available from the Plug-In Device Browser.

Plug-In Devices Are
Available from the
Plug-In Device Browser.

Consider an audio clip playing in an audio track. The audio signal from the clip reaches the
leftmost device in the chain. This device processes (changes) the signal and feeds the result
into the next device, and so on. The number of devices per track is theoretically unlimited.
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In practice, the computer's processor speed does impose a limit on the number of devices
you can use at the same time, a topic that deserves separate discussion. Note that the
signal connections between audio devices are always stereo, but the software's inputs and
outputs can be con�gured to be mono in the Audio Preferences.

When the signal has passed through the device chain, it ends up in Live's mixer. As Session
and Arrangement share the same set of tracks, so they share the mixer. The mixer can be
shown in both views for convenience. To optimize the screen layout, the individual mixer
sections can be shown or hidden using the View menu's entries.
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The Live Mixer in the
Arrangement View (Top)
and Session View
(Bottom).

The mixer has controls for volume, pan position and sends, which adjust the contribution
each clip track makes to each return track's input. Return tracks cannot host clips, only
effects. Via their sends, all tracks can feed a part of their signal into a return track and share
its effects.

The mixer also includes a crossfader, which can create smooth transitions between clips
playing on different tracks. Live's crossfader works like a typical DJ mixer crossfader, except
that it allows crossfading not only two but any number of tracks � including the returns.



4.7. DEVICES AND THE MIXER 36

Live's Crossfader.

Devices that receive and deliver audio signals are called audio effects. Audio effects are the
only type of device that �t in an audio track or a return track. However, two more types of
devices are available for use in MIDI tracks: MIDI effects and instruments.

Consider a MIDI track playing a clip. The MIDI signal from the clip is fed into the track's device
chain. There, it is �rst processed by any number of MIDI effects. A MIDI effect receives
and delivers MIDI signals. One example is the Scale effect, which maps the incoming
notes onto a user-de�ned musical scale. The last MIDI effect in the chain is followed by an
instrument. Instruments, for instance Live's Simpler and Impulse, receive MIDI and deliver
audio. Following the instrument, there can be any number of audio effects � as in an audio
track.

MIDI Effects, an
Instrument and Audio
Effects in a MIDI Track.

If a MIDI track has no instrument (and no audio effects), then the track's output is a plain
MIDI signal, which has to be sent somewhere else to be converted into audio. In this case,
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the track's mix and Send controls disappear from the mixer.

The Mixer for a MIDI
Track without an
Instrument.

4.8 Presets and Device Groups

Every Live device can store and retrieve particular sets of parameter values as presets. As
presets are stored independently from Live Sets, new presets become part of a library that
any project can draw from.

Live's Device Groups allow saving combinations of devices and their settings as a single
preset. This feature allows for the creation of powerful multi-device creations and effectively
adds all the capabilities of Live's MIDI and audio effects to the built-in instruments.

4.9 Routing

As we have seen, all tracks deliver signals, either audio or MIDI. Where do these signals
go? This is set up in the mixer's In/Out section, which offers, for every track, choosers to
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select a signal source and destination. The In/Out section, accessible through the View
menu's �In/Out� entry, is Live's �patchbay.� Its routing options enable valuable creative
and technical methods such as resampling, submixing, layering of synths, complex effects
setups and more.

Track Routing Is Set up
Using the In/Out Section
in the Arrangement
(Top) or Session View
(Bottom).

Signals from the tracks can be sent to the outside world via the computer's audio and MIDI
interfaces, to other programs that are connected to Live via ReWire or to other tracks or
devices within Live.

Likewise, a track can be set up to receive an input signal to be played through the track's
devices. Again, tracks can receive their input from the outside, from a ReWire program or
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from another track or device in Live. The Monitor controls regulate the conditions under
which the input signal is heard through the track.

4.10 Recording New Clips

Audio tracks and MIDI tracks can record their input signal and thereby create new clips.
Recording is enabled on a track by pressing its Arm button (Hold down the Ctrl (PC) /

(Mac) modi�er to arm several tracks at once). When the Control Bar's Record button
is on, every armed track records its input signal into the Arrangement. Every take yields a
new clip per track.

A Track Arm Button, as
Appears in the Session
View.

It is also possible to record into Session View slots on the �y. This technique is very
useful for the jamming musician, as Session recording does not require stopping the music.
When a track is armed, its Session slots exhibit Clip Record buttons, and clicking one of
these commences recording. Clicking the Clip Record button again de�nes the end of
the recording and launches the new clip. As these actions are subject to real-time launch
quantization, the resulting clips can be automatically cut to the beat.

The Control Bar's
Quantization Chooser.

Session recording in conjunction with the Overdub option and Record Quantization is the



4.11. AUTOMATION ENVELOPES 40

method of choice for creating drum patterns, which are built up by successively adding
notes to the pattern while it plays in a loop. It only takes a MIDI keyboard (or the computer
keyboard) and a MIDI track with Live's Impulse percussion instrument to do this.

4.11 Automation Envelopes

Often, when working with Live's mixer and effects, you will want the controls' movements
to become part of the Arrangement. The movement of a control across the Arrangement
timeline is called automation; a control whose value changes in the course of this timeline is
automated. Automation is represented in the Arrangement View by breakpoint envelopes,
which can be edited and drawn.

The Automated Pan
Control and its
Envelope.

Practically all mixer and effect controls in Live can be automated, even the song tempo.
Creating automation is straightforward: All changes of a control that occur while the Control
Bar's Record switch is on become automation.

Changing an automated control's value while not in Record Mode is similar to launching a
Session clip while the Arrangement is playing: It deactivates the control's automation (in
favor of the new control setting). The control will stop tracking its automation and rest
with the new value until the Back to Arrangement button is pressed, which will resume
Arrangement playback.
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4.12 Clip Envelopes

Envelopes can be found not only in tracks but also in clips. Clip envelopes are used
to modulate device and mixer controls. Audio clips have, in addition, clip envelopes to
in�uence the clip's pitch, volume and more; these can be used to change the melody and
rhythm of recorded audio. MIDI clips have additional clip envelopes to represent MIDI-
controller data. Clip envelopes can be unlinked from the clip to give them independent
loop settings, so that larger movements (like fade-outs) or smaller gestures (like an arpeggio)
can be superimposed onto the clip's material.

An Envelope for Clip
Transposition.

4.13 MIDI and Key Remote

To liberate the musician from the mouse, most of Live's controls can be �remote-controlled�
via an external MIDI controller. Remote mappings are established in MIDI Map Mode, which
is engaged by pressing the MIDI switch in the Control Bar.
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In this mode, you can click on any mixer or effect control, and then assign it to a controller
simply by sending the desired MIDI message (for example, by turning a knob on your MIDI
control box). Your assignments take effect immediately after you leave MIDI Map Mode.
Session clips can be mapped to a MIDI key or even a keyboard range for chromatic playing.

MIDI keys and controllers that have been mapped to Live's controls are not available for
recording via MIDI tracks. These messages are �ltered out before the incoming MIDI is
passed on to the MIDI tracks.

The Key/MIDI Map
Controls.

Session clips, switches, buttons and radio buttons can be mapped to computer keyboard
keys as well. This happens in Key Map Mode, which works just like MIDI Map mode.

Live offers, in addition to this general purpose mapping technique, dedicated support for
Mackie Control-compatible mixer surfaces, which allows for mouse-free operation of the
program.

4.14 Saving and Exporting

Saving a Live Set saves everything it contains, including all clips, their positions and settings,
and settings for devices and controls. An audio clip can, however, lose the reference to its
corresponding sample if it is moved or deleted from disk. The links between samples and
their clips can be preserved with a special command, the Save Set Self-Contained command,
which makes a copy of each sample and stores it in a �Sounds� folder along with the Live
Set.

A separate Save button in the Clip View saves a set of default clip settings along with the
sample, so that each time the sample is dragged into the program, it will automatically
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appear with these settings. This is especially useful if you have made warp settings for a clip
and want to use it in multiple Live Sets.

Exporting audio from Live can be done from both the Session and Arrangement Views.
Live will export the audio coming through on the Master output as an audio �le of your
speci�cations via Render to Disk.

Live can also export individual MIDI clips as MIDI �les.

Exporting and saving material for later use in Live can be done very conveniently with the
Live Clip format. Session View clips can be dragged back out of a Live Set to the File
Browsers, and thereby exported to disk as Live Clips.

A Live Clip in the File
Browser.

Live Clips are a very powerful way of storing ideas, as they save not only the clip's Clip View
settings, but also the corresponding track's instruments and effects chain. Live Clips in the
Browser can be previewed and added to any open Live Set just like sample �les. In the Live
Set, they restore the original clip's creative options.

Using Live Clips, you can build your own personalized library of:

� MIDI sequences with matching instruments and effects, e.g., a MIDI drum pattern with
the associated Impulse and effects settings;

� Different regions or loops referencing the same source �le;
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� Variations of a sample loop created by applying Warp Markers, clip envelopes and
effects;

� Ideas that may not �t your current project but could be useful in the future.

4.15 The Library

Live comes with a library of sound ideas that can serve as a starting point for your own
creations.

The �rst part of the library is a large preset collection for Live instruments and effects,
accessible through the Live Device Browser.

The second part of the library is accessed via the Library button in the upper right corner of
the File Browser.

Browsing the Library's
Creative Options.

There are three folders:

� Clips is a collection of Live Clips that offer a broad stylistic variety of sound ideas. Live
Clips have a very open format and can serve both as a starting point for your own
creations and as a resource for learning new sound design tricks.

� Sets is the default location for Live Sets.

� Waveforms is a repository of samples such as one-shot drum hits and single-cycle
waveforms to be used for sound design purposes, particularly in conjunction with
Live's built-in Simpler and Impulse instruments.
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The library is built from several Live Packs, which can be separately downloaded, installed
and uninstalled. Live Packs are available from installation CDs or the Ableton website2.

2http://www.ableton.com/downloads

http://www.ableton.com/downloads


Chapter 5

Managing Files and Sets

Various types of �les are used in making music with Live, from those containing MIDI and
audio, to more program-speci�c �les such as Live Clips and Live Sets. This chapter will
explain everything you need to know about working with each of these �le types in Live.
However, we should �rst take a look at Live's File Browsers, through which most �les arrive
in the program.

5.1 Working with the File Browsers

5.1.1 Browsing the Folder Hierarchy

Files are browsed and imported from disk using Live's on-board Browsers, which can be
pointed to any folder location on the computer. The Browsers can also be searched based

46
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on speci�c criteria, a topic that we will cover in the next section.

Each File Browser can have its own root directory, shown at the top of the Browser, the
contents of which are available for browsing below.

�Library� Is this
Browser's Root.

The Browser root can easily be changed: The Folder-Up button moves the Browser root one
step up in the disk hierarchy.

The File Browser's
Folder-Up Button.

You can also set the Browser root to any folder in the Browser by selecting the folder and
clicking the Root button, double-clicking the folder, or pressing Return . Note that there are
three File Browsers that you can set up to point to commonly used folders.

The File Browser's Root
Button.

To set the root of the Browser to Live's library of clips, Sets and presets, use the Library
button just to the right of the Root button, or the Set Root To Library (PC) / Ctrl

(Mac) context menu command.

The Library Button.

Moving through the �les in Live's Browser can be done with either the mouse or the computer
keyboard:

� Scroll up and down in the Browser with and .
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� Close and open folders with and .

� Jump to the parent folder of any closed folder using . (Hint: If executed on a
top-level folder, this is an alternative to pressing the Folder-Up button, and will move
the Browser root up one level.)

To clean up the Browser, use (PC) / Ctrl (Mac) to access the context menu, and
then select the Close All Folders option to show only top-level folders. Double-clicking any
of the three File Browser icons will also close all sub-level folders.

Double-Click These
Icons to Clean up the
Browser.

Note that you may occasionally want to refresh the Browser if you are working on a network.
To do so, (PC) / Ctrl (Mac) to open the context menu, and then select the Refresh
command.

5.1.2 Searching for Files

Live's File Browsers are equipped with a search function for �nding �les. Clicking the
Search button in the upper right corner of the Browser or using the Ctrl F (PC) /

F (Mac) shortcut will open the Browser's Search Mode.

Activating Browser
Search Mode.
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Live will search for the contents typed in the Search �eld throughout the entire Browser
root. Alternatively, you can search within a single folder in the Browser with the (PC) /

Ctrl (Mac) context menu's Search In Folder command.

After entering search criteria, begin the search by pressing Return on your computer key-
board. Live will �nd �les that contain the search criteria in their name or suf�x (e.g., �.wav�).

The search results will also include �les that contain the entered criteria in any part of their �le
path. This means that a search for �bass,� for example, will yield not only �les with names
containing the word �bass� but also those located in folders with names containing the
word �bass.� Compressed sample metadata tags are also included in the search, making it
possible to search for songs from a speci�c album or artist, for example. Searching �le paths
and metadata can be deactivated with the Search In Path and Search In Metadata settings,
available in Live's Options menu or via the context menu. The names of MIDI tracks within
multitrack MIDI �les are also included in searches.

Note that the �rst search of any folder will always take longer than subsequent searches, as
Live creates an index of the folder's contents to facilitate ef�cient searching.

You can abort an in-progress search with the Exit Search button located to the right of the
Search �eld. A second click on this button closes Search Mode, returning the Browser to
Browse Mode. Beginning a new search aborts any current searches by default.

Exiting Search Mode.

A useful feature of Live's Browser search function is the Locate In Browser button, found to
the right of the Search �eld. After �nding a particular �le in Search Mode, you can select
the �le and click this button to open the �le in Browse Mode, where its location in the folder
hierarchy will be displayed.
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The Locate In Browser
Button.

5.1.3 Previewing Files

The Preview Switch.

Live allows you to preview �les in the File Browser before they are imported into the program.
Previewing is activated using the Browser's Preview switch.

Click on the �les (or use and ) to select and listen to them.

You can adjust the previewing volume using the Preview Volume knob in the mixer.

The Preview Volume
Knob.

If your audio hardware offers multiple audio outs, you can privately audition, or cue, �les via
headphones connected to a separate pair of outs � while the music continues to play. To
learn how to set up Live for cueing, please refer to the appropriate manual section.

Hint: You can preview �les even when the Preview switch is not activated by pressing .
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5.1.4 Adding Clips from the Browser

There are several ways to add clips to a Live Set:

� Files can be dragged and dropped from the File Browsers into tracks in the Session or
Arrangement View. Dragging and dropping material from the Browser into the space
to the right of Session View tracks or below Arrangement View tracks will create a new
track and place the new clip(s) there.

Dropping a Clip to
Create a New Track.

� In the Session View, double-clicking or pressing Return on a �le in the Browser will
automatically create a new track to the right of the other tracks and load it with the
clip.

� Files can be dropped directly into Live from the Explorer (Windows) / Finder (Mac).

5.1.5 File Maintenance in the Browser

You can use Live's File Browsers for all of the �le maintenance activities that you are familiar
with on your operating system.

� Move �les and folders by dragging and dropping, or by copying/cutting and pasting.
Copying, cutting and pasting can be done with either Edit menu commands or key-
board shortcuts. A �le can be moved from one File Browser to another by dragging it
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over the target Browser's button.

� Rename �les and folders using the Edit menu's Rename command or the Ctrl R

(PC) / R (Mac) shortcut. Cancel renaming with the Esc key.

� Create folders by opening the context menu with (PC) / Ctrl (Mac), and then
selecting the Create Folder command.

� Delete �les and folders using the Edit menu's Delete command or your computer's
Backspace or Delete key. Deleting items within Live moves them to the system trash; if
necessary, you can recover items from the system trash via your computer's operating
system.

Note that, while you can rename or delete entire MIDI �les via the Browser, this is not
possible with the individual MIDI tracks contained within them. This is also the case with the
individual components of Live Sets.

5.2 Sample Files

A sample is a �le that contains audio data. Live can play both uncompressed �le formats
(WAV, AIF and Sound Designer II for Mac) and compressed �le formats (MP3, Ogg Vorbis,
Ogg FLAC and FLAC).

A note on using Variable Bit Rate (VBR) �les: Please install QuickTime for decoding purposes
if you do not already have it on your system. It can be downloaded from the Apple website1.

As Live plays the samples directly from disk, you can work with a large number of (large)
samples without running into RAM memory limitations.

Live can combine uncompressed mono or stereo samples of any length, sample rate or bit
depth without prior conversion. To play a compressed sample, Live decodes the sample and

1http://www.apple.com/quicktime/download/mac.html

http://www.apple.com/quicktime/download/mac.html
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writes the result to a temporary, uncompressed sample �le. This usually happens quickly
enough that you will be able to play the sample right away, without waiting for the decoding
process to �nish.

Note: When adding a long sample to a project, Live might tell you that it cannot play the
sample before it has been analyzed. Please see the section on analysis for an explanation.

5.2.1 The Decoding Cache

To save computational resources, Live keeps the decoded sample �les of compressed
samples in the decoding cache, a sub-directory of the Audio Record Folder. Maintenance
of the cache is normally not required, as Live automatically deletes older �les to make room
for those that are new. You can, however, impose limits on the cache size using the Misc
Preferences' Decoding Cache section. The cache will not grow larger than the �Maximum
Cache Size� setting, and it will always leave the �Minimum Free Space� on the hard disk.
Pressing the Cleanup button in the Decoding Cache preferences will delete all �les not
being used by the current Live Set.

Preferences for the
Decoding Cache.
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5.2.2 Analysis Files (.asd)

An analysis �le is a little �le that Live creates when a sample �le is brought into the program
for the �rst time. The analysis �le contains data gathered by the program to help optimize
the stretching quality, speed up the waveform display and automatically detect the tempo
of long samples.

When adding a long sample to a project, Live might tell you that it cannot play the sample
before it has been analyzed. This will not happen if the sample has already been analyzed
(i.e., Live �nds an analysis �le for this sample), or if the Default Preferences Auto-Warp
Long Samples preference has been deactivated. To prevent waiting for analysis of longer
samples, you can pre-analyze them via the Browser, as we will see in a moment.

An analysis �le can also store default clip settings for the sample:

Clicking the Clip View's Save button will store the current clip's settings with the sample's
analysis �le. The next time the sample is dragged into Live, it will appear with all its clip
settings intact. This is particularly useful for retaining Warp Marker settings with the sample.
Storing default clip settings with the analysis �le is different from saving the clip as a Live
Clip, as described in the relevant section.

The analysis �le's name is the same as that of the associated sample, with an added �.asd�
extension. Live puts this analysis �le in the same folder as the sample.

Samples that have an .asd �le are displayed like this in the Browser.

Samples without an .asd �le look like this.

The analysis �les themselves do not appear in Live's Browsers.

Note that you can suppress the creation of .asd �les by turning off the Create Analysis Files
option in the Misc Preferences. All data (except for the default clip settings) can be recreated
by Live if the .asd �le is missing, however this will take some time for longer samples.



5.2. SAMPLE FILES 55

5.2.3 File Pre-Analysis

To avoid waiting for longer samples to be analyzed the �rst time they are imported into Live,
you may want to pre-analyze them.

Pre-Analyzing Audio
Files.

To pre-analyze all the �les contained in any folder in the Browser, use the (PC) / Ctrl

(Mac) context menu's Analyze Audio command. This process can also be cancelled via the
context menu.

5.2.4 Exporting Audio

The File menu's Render to Disk command allows exporting Live's Master audio output as a
new sample. The resulting �le can be used to burn an audio CD for listening purposes or
a data CD, which could serve as a backup of your work or be used with other digital audio
applications.
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Which Signal Will Be Rendered?

Render to Disk will always render the signal at Live's Master output. If you are monitoring
the Master output, you can be sure that the rendered �le will contain exactly what you hear.
To export individual tracks, deactivate all tracks other than the ones you want to export by
turning off their Track Activator switches in the mixer.

When Render to Disk is invoked while the Arrangement View is up, Live will render the
selected time range.

If you would like to render the current Arrangement loop, choose the Select Loop command
from the Edit menu prior to choosing Render to Disk. Keep in mind that the selection of
tracks is irrelevant: The signal to be rendered is the Master output.

If you choose Render to Disk while the Session View is up, Live will ask you to specify the
length of the sample to be rendered. The Render to Disk dialog will come up with a bars-
beats-sixteenths �eld where you can type in the desired length. Live will capture audio from
the Master output starting at the current play start position for whichever duration you have
speci�ed.

Rendering Options

The Render to Disk command opens a dialog that offers several rendering options:

� Normalize. If this is activated, the sample resulting from the render process will be
normalized (i.e., the �le will be ampli�ed so that the highest peak attains the maximum
available headroom).

� Render as Loop. If this is activated, Live will create a sample that can be used as a
loop. For example, suppose your Live Set uses a delay effect. If Render as Loop is on,
Live will go through the rendering process twice: The �rst pass will not actually write
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samples to disk, but add the speci�ed delay effect. As the second pass starts writing
audio to disk, it will include the delay �tail� resulting from the �rst pass.

� File Type, Bit Depth, Sample Rate. These options specify the type of sample to be
created.

� Create Analysis File. If this is activated, Live will create an .asd �le that contains analysis
information about the rendered sample. If you intend to use the new sample in Live,
check this option.

� Convert to Mono. If this is activated, Live will create a mono �le instead of a stereo
�le.

5.3 MIDI Files

A MIDI �le contains commands that prompt MIDI-compatible synthesizers or instruments,
such as Live's Simpler, to create speci�c musical output. MIDI �les are exported by hardware
and software MIDI sequencers. Importing MIDI �les into Live works differently than with
samples: MIDI �le data is incorporated into the Live Set, and the resulting MIDI clips lose all
reference to the original �le. MIDI �les appear as folders in the File Browser; opening the
folders gives you access to the �le's individual tracks (also called �voices� or �instruments�).
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A MIDI File and Its
Tracks in the Browser.

5.3.1 Exporting MIDI Files

Live MIDI clips can be exported as Standard MIDI �les. To export a MIDI clip, use the File
menu's Export Selected MIDI Clip command. This command will open a �le-save dialog,
allowing you to choose the location for your new MIDI �le.

Exporting a MIDI �le is different from saving the clip as a Live Clip, as described in the
relevant section.

5.4 Live Clips

Individual Session View clips can be exported to disk in the Live Clip format for easy retrieval
and reuse in any project.
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To save a clip from the open Live Set to disk, simply drag it from the Session View to the File
Browser and drop it into any folder. You can then type in a new name for the clip or con�rm
the one suggested by Live with Return .

A Live Clip in the
Browser.

Live Clips are a great way of storing your ideas for later use or development, as they save
not only the original clip, including all its clip and envelope settings, but also the original
track's devices. In order to recreate a Live Clip's device chain, either import it into a track
containing no clips or devices, or drag it into the space in the Session or Arrangement View
containing no tracks. Note that Live Clips that are imported into tracks already containing
devices or clips will appear with their clip settings but not their devices. You could, for
instance, drop a bass line Live Clip on an existing track that drives a bass instrument rather
than creating a new track.

Clips belonging to any Live Sets already on disk are also Live Clips. Please see the section
on importing and exporting Sets for more on this topic.

Note that storing default clip settings with a sample's analysis �le is different from saving a
Live Clip. The default clip in the .asd �le annotates the sample with sensible default values
(warp, gain and pitch settings) so that it will play in a de�ned way when it is added to a Set.
Live Clips, on the other hand, are stored on disk as separate musical ideas. For example, you
could create a number of variations from the same audio clip by using different warp, pitch,
envelope and effect settings, and store them all as separate Live Clips. In the Browser, you
could then independently sort and preview these clips, even though they are all referring to
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the same source sample.

5.5 Live Sets

The type of document that you create and work on in Live is called a Live Set.

5.5.1 Creating, Opening and Saving Sets

Use the File menu's New command to create new Live Sets, and the Open or Open Recent
command to open existing ones. In the File Browser, you can double-click or press Return

on a Live Set to open it.

The File menu's Save command saves the current Live Set exactly as it is, including all clips
and settings.

You can also use the Save As command to save the current Live Set under a different name
and/or in a different directory location, or the Save a Copy command to create a copy of
the current Live Set with a new name and/or new directory location.

Saving a Live Set leaves the samples referenced by that Live Set's clips in their current
locations. If these �les are later moved, Live will attempt to help you �nd them when next
you open that particular Live Set. The File menu's Save Set Self-Contained command can
help you avoid missing �les altogether.

5.5.2 Importing and Exporting Sets with the Browser

Live Sets can now be opened in the File Browsers, just like standard disk folders, to reveal
their component tracks and clips. Each of the clips belonging to a Live Set is a Live Clip.
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A Live Set in the
Browser.

These tracks and clips can be selectively previewed and dragged into the current Set, or
the entire Live Set can be dragged in to merge the two. Dragging a Set into the space to
the right of Session View tracks or below Arrangement View tracks will create new tracks to
host the new content, whereas dragging a Set into existing tracks will replace any current
clips. Note that, if a Set is dragged into existing tracks containing clips or devices, its tracks'
corresponding device chains will not be loaded.

You can export a selection of Session View clips as a new Live Set by dragging them to the
File Browser. To export a Set, �rst click and drag, or use the or Ctrl (PC) /
(Mac) modi�ers, to select more than one Session View clip. Then, simply drag the clips to
a folder in the File Browser, where you can either con�rm Live's suggested name or type in
one of your own.

5.5.3 Template Sets

Use the Default Preferences' Template Save button to save the current Live Set as a template.
Live will use these settings as the initialized, default state for new Live Sets. You can use this
to pre-con�gure:

� Your multichannel input/output setup.

� Preset devices, like EQs and Compressors, in every track.
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� Computer key mappings.

� MIDI mappings.

The template Live Set �Template.als� is located in Live's Preferences folder and can be
copied or deleted from there. The easiest way to locate this folder is to search your disk for
�Template.als.�

5.6 Of�ine and Lost Files

If you load a Live Set or Live Clip that references samples missing from their referenced
locations, Live will issue a warning message and ask whether you want to locate the missing
�les.

If you do not, the Live Set or Live Clip will open anyway, with the clips that reference missing
�les marked �Of�ine.� Live will play silence in place of the of�ine clips.

You can �nd the missing �les by selecting of�ine clips and clicking the Clip View's Replace
button.

5.7 The Sounds Folder and Self-Containing

The Sounds folder is a Live Set's private location for storing samples. All samples that are
recorded into a Live Set end up in this Live Set's Sounds folder. Live offers a convenient
method for gathering all the �les that are referenced by a Live Set in this folder: When you
choose the File menu's Save Set Self-Contained command, Live copies all externally refer-
enced �les there. After Live has self-contained the �les, there will no longer be references
to samples spread over one or more hard drives. You can back up the Live Set along with



5.8. LIVE PACKS 63

its Sounds folder, or send it to collaborators via the Internet, and all �les used in the project
will be included.

The Sounds folder for �My Live Set� is called �My Live Set Sounds.� It is located next to (in
the same folder as) �My Live Set.�

5.8 Live Packs

Live's library is broken down into several Live Packs that can be separately downloaded,
installed and uninstalled. A Live Pack is a single �le (much like a ZIP �le) that expands into
many �les upon installation.

Live Packs are available from installation CDs or the Ableton website2. To install a down-
loaded Live Pack, drag the �le into Live, double-click the �le, or select Install Live Pack from
the File menu.

A list of all installed Live Packs is kept in the Preferences' Products tab. You can select
individual Live Packs from the list and click the Uninstall button to remove them.

You can, of course, remove, rename, alter and add to the individual �les that come with Live
Packs at will, making someone else's library your own.

2http://www.ableton.com/downloads

http://www.ableton.com/downloads


Chapter 6

Arrangement View

The Arrangement View displays the Arrangement, which contains music laid out along a
song timeline, like a multitrack tape.

A Piece of Music Laid
out in the Arrangement
View.
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The Arrangement View is a powerful editing tool that easily lets you combine and arrange
musical material of all types: MIDI, loops, sound effects and complete pieces of music.

6.1 Navigation

Live offers several fast methods for zooming and scrolling the Arrangement display:

1 3 4 56 2

Navigating the
Arrangement View.

1. To smoothly change the zoom level, click and drag vertically in the beat-time
ruler at the top of the Arrangement View (you can also drag horizontally to scroll
the display).

2. To zoom in and out around the current selection, use the computer keyboard's +
and - keys. To �pan� the display, click and drag while holding the Ctrl Alt

(PC) / Alt (Mac) modi�er.

3. The Arrangement Overview is like a �bird's-eye view� of your music. It always
shows the complete piece, from start to end. The black rectangular outline repre-
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sents the part of the Arrangement that is currently displayed in the Arrangement
display below. To scroll the display, click within the outline and drag left or right;
to zoom out and in, drag up and down.

4. To change the displayed part of the Arrangement, drag the outline's left and
right edges.

5. To see a speci�c part of the Arrangement in more detail, click on it in the Overview
and drag downwards to zoom in around that part. Note that you can also drag
horizontally to scroll the display. Using this method, you can zoom and scroll to
focus around any part of the Arrangement with just one mouse motion.

6. To have the Arrangement display follow the song position and scroll automati-
cally, turn on the Follow switch, or use the Follow command from the Options
menu.

6.2 Transport

There are a number of ways to control Live's transport with the computer keyboard and
mouse:

1. You can start Arrangement playback by clicking the Control Bar's Play button,
and stop playback by clicking the Stop button. Arrangement playback can also
be toggled on and off by pressing the keyboard's space bar.

The Play and Stop
Buttons in the Control
Bar.

2. You can set the Arrangement playback position by clicking anywhere along the
Arrangement to place the �ashing insert marker. Double-clicking the Stop button
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will return the Arrangement play position to 1.1.1.

Arrangement Playback
Begins from the Insert
Marker.

To continue playback from the position where it last stopped, rather than from
the insert marker, hold down the modi�er while pressing the space bar.

3. Clicking in the scrub area above the tracks will make playback jump to that point.
The size of these jumps is quantized according to the Control Bar's Quantization
menu setting. While the mouse is held down over the scrub area, a portion of
the Arrangement the size of the chosen quantization setting will be repeatedly
played. With small quantization settings, or a setting of �None,� this allows you
to scrub through the music.

Scrubbing Arrangement
Playback.

4. The song position can be adjusted numerically using the Control Bar's Arrange-
ment Position �elds.

Setting the Play Position
in the Arrangement
Position Fields.
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The Arrangement Position �elds show the song position in bars-beats-sixteenths.
To change the values:

� Click and drag up or down in any of these �elds.

� Click and type a number, then hit Return .

� Click and decrement or increment the value with and .

5. Arrangement playback can be started at a particular point in one of your clips
using the scrub area in the Clip View.

6. Several Arrangement playback positions can be set using launchable locators.

Note that any computer keyboard key or MIDI message can be mapped to the transport
controls, as described in the respective chapter.

6.3 Launching the Arrangement with Locators

Using Locators to
Launch Play in the
Arrangement.

Locators can be set at any point in the Arrangement. This can be done in real time during
playback or recording with the Set Locator button, and will be quantized according to the
global quantization value set in the Control Bar. Clicking the Set Locator button when the
Arrangement is not playing will create a locator at the insert marker or selection start. You
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can also create a locator using the context menu in the scrub area above the tracks or via the
Insert menu. Note that the position of a new locator is quantized according to the Control
Bar's Quantization menu setting.

The Locator Controls.

You can recall (jump to) locators by clicking on them, or with the Previous and Next Locator
buttons on either side of the Set button. Locators can also be recalled using MIDI/key
mapping. Note that locator recall is subject to quantization. Double-clicking a locator will
select it and start Arrangement playback from that point.

After jumping to the �rst or last locator in the Arrangement, the Previous and Next Locator
buttons will jump to the Arrangement start or end, respectively.

Locators can be moved by clicking and dragging, or with the arrow keys on your computer
keyboard.

To name a locator, select it by clicking its triangular marker, and choose the Rename Edit
menu command (or use the Ctrl R (PC) / R (Mac) shortcut). Locators can be
removed with your computer's backspace or delete key, the Insert menu, or the Delete
Locator button.

Note that the locator context menu offers a quick way of looping playback between two
locators with its Loop To Next Locator command.
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6.4 The Arrangement Loop

The Control Bar's Loop
Switch.

For Live to repeatedly play a section of the Arrangement, activate the Arrangement loop by
clicking on the Control Bar's Loop switch.

The Loop Start Fields
(Left) and the Loop
Length Fields (Right).

You can set loop length numerically using the Control Bar �elds: The left-hand set of �elds
determines the loop start position, while the right-hand set determines loop length.

The Edit menu's Loop Selection command accomplishes all of the above at once: It turns
the Arrangement loop on and sets the Arrangement loop brace to whatever timespan is
selected in the Arrangement.

The Arrangement's Loop
Brace.

The loop brace can be selected with the mouse and manipulated with commands from the
computer keyboard:

� and nudge the loop brace to the left/right by the current grid setting.
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� and shift the loop brace left/right in steps the size of its length.

� The Ctrl (PC) / (Mac) modi�er used with the arrow left and right keys shortens
or lengthens the loop by the current grid setting.

� The Ctrl (PC) / (Mac) modi�er with the arrow up and down keys doubles or
halves the loop length.

You can also drag the Arrangement's loop brace: Dragging the left and right ends sets the
loop start and end points; dragging between the ends moves the loop without changing its
length.

6.5 Moving and Resizing Clips

A piece of audio or MIDI is represented in the Arrangement View by a clip sitting at some
song position in one of Live's tracks.

Moving a Clip.

Dragging a clip moves it to another song position or track.

Changing a Clip's
Length.

Dragging a clip's left or right edge changes the clip's length.
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6.6 Selecting Clips and Time

With the exception of moving and resizing clips, Arrangement editing in Live is selection-
based: You select something using the mouse, then execute a menu command (e.g., Cut,
Copy, Paste, Duplicate) on the selection. This editing method lends itself to an ef�cient
division of labor between the two hands: One hand operates the mouse or trackpad, while
the other hand issues the keyboard shortcuts for the menu commands. The menu eventually
is only used as a reference for looking up the keyboard shortcuts.

Here is how selection works:

� Clicking a clip selects the clip;

� Clicking into the Arrangement background selects a point in time, represented by a
�ashing insert mark;

� Clicking and dragging selects a timespan.

� To access the time within a clip for editing, �unfold� its track by clicking the triangular
button next to the track name.

Adjusting an Unfolded
Track's Height.

Notice that you can adjust the height of the unfolded track by dragging the split line
below the Unfold Track button. Clicking and dragging in the waveform display below
the clip's horizontal strip allows you to select time within the clip. Note that you can
actually unfold all of your tracks at once by holding down the Alt (PC) / Alt

(Mac) modi�er when clicking the Unfold Track button.
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� Clicking on the loop brace is a shortcut for executing the Edit menu's Select Loop
command, which selects all material included within the loop.

� Holding Shift while clicking extends an existing selection in the same track or across
tracks.

Clicking the Loop Brace
to Select the Loop for
Editing.

6.7 Using the Editing Grid

To ease editing, the cursor will snap to grid lines that represent the meter subdivisions of
the song tempo. The grid can be set to be either zoom-adaptive or �xed.

You can set the width of both zoom-adaptive and �xed grid lines using the (PC) /
Ctrl (Mac) context menu available in either the Arrangement View track area or the

Clip View display.

The following shortcuts to Options menu commands allow quickly working with the grid:

� Use Ctrl 1   (PC) / 1   (Mac) to narrow the grid, doubling the density of the
grid lines (e.g., from eighth notes to sixteenth notes).

� Use Ctrl 2   (PC) / 2   (Mac) to widen the grid, halving the density of the grid
lines (e.g., from eighth notes to quarter notes).
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� Use Ctrl 3   (PC) / 3   (Mac) to toggle triplets mode; this would, for instance,
change the grid from eighth notes to eighth note triplets.

� Use Ctrl 4   (PC) / 4   (Mac) to turn grid snapping on or off. When the grid is
off, the cursor does not snap to meter subdivisions.

� Use Ctrl 5   (PC) / 5   (Mac) to toggle �xed and adaptive grid modes.

The current spacing between adjacent grid lines is displayed in the lower right corner of the
Arrangement View or Clip View.

6.8 Using the ...Time Commands

Whereas the standard commands like Cut, Copy and Paste only affect the current selection,
their �... Time� counterparts act upon all tracks by inserting and deleting time.

� Cut Time cuts a selection of time from the Arrangement, thereby moving any audio
or MIDI on either side of the cut area closer together in the timeline. This command
reduces the length of your Arrangement by whatever amount of time you have cut.
Note that the Cut Time command affects all tracks, not only the selected ones.

A Gap Between Clips
Has Been Deleted by
First Selecting it, Then
Executing the Delete
Time Command.

� Paste Time places copied time into the Arrangement, thereby increasing its overall
duration by the length of time you have copied.
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� Duplicate Time places a copy of the selected timespan into the Arrangement, thereby
increasing its overall duration by the length of the selection.

� Delete Time deletes a selection of time from the Arrangement, thereby moving any
audio or MIDI on either side of the deleted area closer together in the timeline. This
command reduces the length of your Arrangement by the amount of time you have
deleted. Note that the Delete Time command affects all tracks, not only the selected
ones.

� Insert Silence inserts as much empty time as is currently selected into the Arrangement,
before the selection.

6.9 Splitting Clips

The Split command can divide a clip or isolate part of it.

To split a clip in two halves,

1. unfold the track;

2. in the waveform or MIDI display, click at the position where you want the clip to
be split;

3. execute the Split command.

To isolate a part of a clip,

1. unfold the track;

2. in the waveform or MIDI display, drag a selection over the part of the clip you
want to isolate;

3. execute the Split command to divide the original clip into three pieces.
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The Result of Splitting a
Clip.

6.10 Consolidating Clips

The Consolidate command replaces the material in the Arrangement View selection with
one new clip per track. This is very useful for creating structure.

Consolidating Several
Clips Into a New Clip.



6.10. CONSOLIDATING CLIPS 77

Suppose you have, by editing or improvising, come up with a layout of clips that sound
good in Arrangement Loop Mode. Selecting that part of the Arrangement, for instance by
using the Edit menu's Select Loop command, and then executing the Consolidate command
creates a new clip that can be treated as a loop. You can now, for instance, drag the clip
edges to create more repetitions. You might also want to drag the new loop via the Session
View selector into a Session View slot for real-time arrangement purposes.

When operating on audio clips, Consolidate actually creates a new sample for every track
in the selection. The new samples are essentially recordings of the time-warping engine's
audio output, prior to processing in the track's effects chain and mixer. Hence, the new
sample incorporates the effects of in-clip attenuation, time-warping and pitch shifting, and
of the respective clip envelopes; however, it does not incorporate the effects. To create a
new sample from the post-effects signal, please use the Render to Disk command.

The new samples can be found in the �Sounds� folder, a disk location speci�c to the Live
Set in which you are working. Please see the relevant section of this manual for more
information.
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Session View

In Live's Arrangement View, as in all traditional sequencing programs, everything happens
along a �xed song timeline. For a number of applications, this is a limiting paradigm:

� When playing live, or when DJing, the order of pieces, the length of each piece and
the order of parts within each piece is generally not known in advance.

� In the theatre, sound has to react to what happens on stage.

� When working along with a piece of music or a �lm score, it can be more ef�cient and
inspirational to start with an improvisation, which is later re�ned into the �nal product.

This is exactly what Live's unique Session View is for.
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7.1 Session View Clips

The Controls for a
Session View Clip.

1. Each clip in the Session View has a triangular button at the left edge. Click the
button with the mouse to �launch� clip playback at any time, or pre-select a
clip by clicking on its name, and launch it using the computer's Return key. You
can then move on to the neighboring clips using the arrow keys. Please refer
the manual section on clip launch settings for details on how to customize this
behavior.

2. Click on a square Clip Stop button to stop a running clip, either in one of the
track's slots, or in the Track Status �eld below the Session grid.

Clips can be controlled remotely with the computer keyboard or a MIDI controller. They can
even be mapped to MIDI note ranges so that they play chromatically.

Clips can be played at any time and in any order. The layout of clips does not predetermine
their temporal succession; the Session grid offers random access to the clips it contains.

Notice that, even if you stop playback for a Session View clip, the Play button in the Control
Bar will remain highlighted, and the Arrangement Position �elds will continue running.
These �elds keep a continuous �ow of musical time going, so that you can always know your
position in song time during a live performance or while recording into the Arrangement,
regardless of what your individual Session clips are doing.
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You can always return the Arrangement Position �elds to 1.1.1 and stop playback for the
entire Live Set by pressing the Control Bar's Stop button twice.

The Arrangement
Position Fields and the
Stop Button.

7.2 Tracks and Scenes

Each vertical column, or track, can play only one clip at a time. It therefore makes sense to
put a set of clips that are supposed to be played alternatively in the same columns: parts of
a song, variations of a drum loop, etc.

Resized Session View
Tracks.

For convenient access to more clips at once, you can resize Session View tracks by clicking
and dragging at the edges of their title bars. Tracks can be narrowed this way so that only
Clip Launch buttons and essential track controls are visibile.
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A Session View Scene.

The horizontal rows are called scenes. The Scene Launch buttons are located in the rightmost
column, which represents the Master track. To launch every clip in a row simultaneously,
click on the associated Scene Launch button. This can be very useful in organizing the live
performance of a song with multiple parts.

The scene below a launched scene will automatically be selected as the next to be launched
unless the Select Next Scene on Launch option in the Misc Preferences is set to �Off.�
This allows you to trigger scenes from top to bottom without having to select them �rst.
Computer keys or a MIDI controller can be used to launch scenes and scroll between them.

Scenes can be renamed using the Edit menu's Rename command. One can quickly rename
several scenes by executing the Rename command and using the computer's Tab key to
move from one scene to the next.

Each scene can actually store a tempo setting as part of its name, so that it changes the
project tempo upon launch; this is accomplished by selecting the scene and renaming it
with a viable tempo (e.g., �96 BPM�). Any tempo can be used, as long as it is within the
range allowed by Live's Tempo control (20�999 BPM).

This Scene Will Change
the Tempo to 96 BPM.
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7.3 The Track Status Fields

You can tell a track's status by looking at the Track Status �eld just above the active track's
mixer controls:

A Track Playing a
Looping Session Clip...

The pie-chart icon represents a looping Session clip. The number to the right of the circle
is the loop length in beats, and the number at the left represents how many times the loop
has been played since its launch.

... A One-shot Session
Clip...

The progress-bar icon represents a one-shot (non-looping) Session clip. The value displays
the remaining play time in minutes:seconds.

... Monitoring the
Input...

A microphone icon appears in an audio track that is set to monitor its input. A keyboard
icon appears in a MIDI track under these same circumstances.

... Playing the
Arrangement.
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If the track is playing clips from the Arrangement, a miniature display representing the
Arrangement clips being played appears.

7.4 Setting Up the Session View Grid

Clips arrive in the Session View by being imported from the File Browsers or through
recording.

Dropping Multiple Clips
Into the Session View.

If you are dragging multiple clips into the Session View, Live defaults to arrange them
vertically, in one track. Hold down Ctrl (PC) / (Mac) prior to dropping them so as
to lay the clips out in one scene.

Clips can be moved around the Session grid by drag-and-drop. To move several clips
at once, select them by using the - or Ctrl (PC) / (Mac)-modi�er before
dragging. You can also click into an empty slot and �rubber-band� select from there. Scenes
can be reordered by drag-and-drop as well.
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7.4.1 Select on Launch

By default, clicking a Session View clip's Launch button also selects the clip, since you will
typically want the Clip View to show the newly launched clip. However, some power-users
don't want the current focus (e.g., a return track's devices) to disappear just because a clip
has been launched, especially when starting a clip in order to try it with the return track
device settings. Turn off the Select on Launch option from the Misc Preferences if you prefer
the view to remain as is when you launch clips or scenes.

7.4.2 Removing Clip Stop Buttons

Slots Without Clip Stop
Buttons.

You can add and remove Clip Stop buttons from the grid using the Edit menu's Add/Remove
Stop Button command. This is useful for pre-con�guring the scene launch behavior: If, for
instance, you don't want scene 3 to affect track 4, remove the scene 3 / track 4 Stop button.

7.4.3 Editing Scenes

There are a number of useful commands in the Edit and Insert menus that apply to scenes:

� Cut Scenes cuts out scenes with selected slots from the Session View, thereby reducing
the total number of scenes. Please note that the Cut Scenes command affects all tracks,
not only those containing selected slots.
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� Paste Scenes works like Paste, but inserts blank scenes before pasting. Live inserts
enough scenes to �t the material from the clipboard. The new scenes will be inserted
behind the current selection.

� Duplicate Scenes works like Duplicate, but inserts blank scenes before pasting. Live
inserts enough scenes to �t the material from the clipboard.

� Delete Scenes deletes all scenes with selected slots from the Session View, thereby
reducing the total number of scenes. Please note that the Delete Scenes command
affects all tracks, not only those containing selected slots.

� Insert Scene inserts an empty scene below the current selection.

� Capture and Insert Scene inserts a new scene below the current selection, places
copies of the clips that are currently running in the new scene and launches the new
scene immediately with no audible interruption. This command is very helpful when
developing materials in the Session View. You can capture an interesting moment as
a new scene and move on, changing clip properties and trying clip combinations.

7.5 Recording Sessions into the Arrangement

Your Session View playing can be recorded into the Arrangement, allowing for an improvi-
sational approach to composing songs and scores.
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The Control Bar's Record
Button.

When the Record button is on, Live logs all of your actions into the Arrangement:

� the clips launched;

� changes of those clips' properties;

� changes of the mixer and the devices' controls, also known as automation.

To �nish recording, press the Record button again, or stop playback.

The Arrangement
Selector.

To view the results of your recording, bring up the Arrangement View. As you can see, Live
has copied the clips you launched during recording into the Arrangement, in the appropriate
tracks and the correct song positions. Notice that your recording has not created new audio
data, only clips.

The Session clips and the Arrangement clips in one track are mutually exclusive: Only one
can play at a time. When a Session clip is launched, Live stops playing back the Arrangement
in favor of the Session clip. Clicking a Clip Stop button causes the Arrangement playback
to stop, which produces silence.
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The Back to
Arrangement Button.

Arrangement playback does not resume until you explicitly tell Live to resume by clicking
the �Back to Arrangement� button, which lights up to remind you that what you hear differs
from the Arrangement.

The Stop All Clips
Button.

To disable all Arrangement clips simultaneously, click on the Stop All Clips button in the
Master Track Status �eld. The clips in the Arrangement and in the Session View exist
independently from one another, which makes it easy to improvise into the Arrangement
over and over again until it's right.

Furthermore, you can move clips not only within the Session grid, but also from the Session
View to the Arrangement and vice versa by using Copy and Paste, or by dragging clips over

the or selectors.

When pasting material from the Arrangement into the Session View, Live attempts to pre-
serve the temporal structure of the clips by laying them out in a matching top-to-bottom
order. Moving through the scenes from the top down, you can reconstruct the original ar-
rangement. This is useful for taking a composed piece of music back to the improvisational
stage.
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Clip View

The Clip View is where clip properties can be set and adjusted.

Clicking the Clip
Overview Opens the
Clip View.

The Clip View is opened by clicking on the Clip Overview or double-clicking a clip in the
Session or Arrangement View.
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Clicking a Session View
Track Status Field Opens
the Clip View.

In the Session View, clicking on a Track Status Field opens the Clip View for editing the clip
that is currently running in the track.

The properties of more than one clip can be edited collectively in the Clip View as a multi-
selection. To create a multi-selection, click and drag to highlight the clips, or select one clip
and use the Ctrl (PC) / (Mac) or modi�ers to add to your selection. The
properties available in the Clip View for a multi-selection depend on the contents of the
clips; generally only properties which the clips have in common are shown.

Creating a Clip
Multi-Selection.

Controls such as sliders and knobs behave slightly differently when they are part of a multi-
selection. If the clips in a multi-selection have differing values for any particular knob or
slider parameter (clip transposition, for example), the range of these values will be displayed
and can be adjusted with the control. Dragging the knob or slider to its absolute maximum
or minimum value will make the clips' settings thereafter identical, adjustable as a single
value.

MIDI clips and audio clips in Live have different sets of properties and, consequently, do
not share the same set of Clip View controls. The two types of clips do have the following
in common:
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� The Clip box contains basic clip settings.

� The Envelopes box and the Envelope Editor manage the clip's envelopes, which are
used to modulate the effects, mixer, and clip or MIDI controls. Clip envelopes and
their associated Clip View components are covered in detail in a separate manual
chapter.

� The Launch box controls clip launch behavior and, as such, only appears for Session
View clips. Setting Session View clip launch properties is covered in detail in a separate
manual chapter.

Audio clips have these additional Clip View controls:

� The Sample Display toggles with the Envelope Editor on the right-hand side of the
Clip View, and controls Live's sample-warping capabilities and clip playback settings.

� The Sample box contains settings pertaining to how the clip plays its sample and
displays it in the Sample Display.

The Clip View for an
Audio Clip.

MIDI clips have these additional Clip View controls:

� The MIDI Editor toggles with the Envelope Editor on the right-hand side of the Clip
View, and allows editing and creating MIDI notes and velocities.
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� The Notes box contains settings pertaining to how Live plays a MIDI clip and what it
displays in the MIDI Editor.

The Clip View for a MIDI
Clip.

To make best use of the screen real estate, you can show or hide the Launch, Envelopes,
and Sample or MIDI boxes using the Clip View Box selector in the Clips box. You can also
toggle between the Sample Display/MIDI Editor and the Envelope Editor by clicking in the
title bars of the Sample/Notes box and the Envelopes box, respectively.

The Clip View Box
Selector Shows and
Hides Various Clip View
Components.



8.1. THE CLIP BOX 92

8.1 The Clip Box

The Clip Box.

8.1.1 Clip Activator Switch

Using this switch, you can deactivate a clip so that it does not play when launched in the
Session View or during Arrangement playback. Clips can also be activated/deactivated
directly from the Session or Arrangement View with their (PC) / Ctrl (Mac) context
menus.

8.1.2 Clip Name and Color

The Clip Name �eld allows naming the clip. By default, a clip's name matches the name of
the �le it references but, in general, the clip name is independent from the �le name.

Renaming an audio clip does not rename the referenced sample �le. To rename a �le, select
it in Live's File Browsers, and then choose the Edit menu's Rename command.

The Clip Color chooser allows choosing a clip color.
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8.1.3 Clip Signature

Using the Clip Signature �elds, you can specify the signature of an audio clip's sample. This
setting is relevant only for display; it does not affect sample playback.

8.1.4 Groove

The Clip Groove chooser selects the type of groove used for the clip. �Swing 8,� for
example, applies an 8th-note groove.

The Control Bar's Global
Groove Control.

The Global Groove control de�nes the amount of the groove for every clip in the Live Set.

So, how does it work? Imagine a simple one-bar MIDI clip that has a time signature of 4/4.
Our MIDI clip is made up of 8th notes � eight of them � that play either on or between each
of the four beats. With a Clip Groove setting of Swing 8, the timing of our one-bar clip
becomes a bit like a rubber-band that is pinned down at each beat but �exible in between.
The 8th notes that fall between beats can shift slightly forward. With a Global Groove setting
of 50, for example, the notes will wait until 2/3 of the way through the beat to play, where
an 8th-note triplet would normally fall.

16th- and 32nd-note swing works similarly, but on a smaller scale: Every other note shifts
forward, toward the nearest 16th- or 32nd-note triplet position.

Returning to our rubber-band analogy, we can see that Swing 8 can actually affect more
than just 8th notes. Actually, any notes that do not lie directly on a beat will be affected
when the rubber-band is stretched � including 16th and 32nd notes. By the same token,
Swing 16 (where our rubber-band is anchored to positions just an 8th note apart) can affect
32nd notes.
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Groove can be applied to both MIDI clips and audio clips. Applying groove to audio
clips does require that the Warp switch be activated and a Warp Mode other than Re-Pitch
selected. If an audio clip is in Beats Mode, the Transients setting must be greater than or
equal to the Clip Groove chooser's swing setting (e.g., with a Transients setting of 1/16,
Swing 8 and Swing 16 can be used, but not Swing 32).

Because of this feature's dependency on note timing, we recommend that you quantize
MIDI clips prior to applying groove � provided you want predictable results. For audio clips,
any swing contained within the original sample can be removed by appropriately setting
Warp Markers prior to applying the �arti�cial� swing of the Groove setting.

8.1.5 Clip Offset and Nudging

To jump within a playing clip in increments the size of the global quantization period, you
can use the Nudge buttons in the Clip box.

Using the Nudge
Buttons to Jump
Through a Clip.

These buttons can also be mapped to keys or MIDI controllers. In MIDI Map mode, a scrub
control will appear between the Nudge buttons and can be assigned to a rotary encoder
wheel for continuous scrubbing.



8.1. THE CLIP BOX 95

The Scrub Control in
MIDI Map Mode.

With quantization set to values less than one bar, it is easy to offset clip playback from Live's
master clock by launching clips, using the Nudge buttons or scrubbing within the clip.

Clip Offset from Global
Time as Shown in the
Clip's Display.

When clip play is offset from global time in this manner, a little dot will illuminate in the
Sample Display or MIDI Editor to display the offset start position.
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Using the Keep and
Revert Buttons to
Manage Meter Offset.

The current offset as indicated by the dot can be made permanent by moving the start
marker to the dot's position - and this is exactly what the Keep button, found just beneath
the Nudge buttons, does. Or, the current offset can be undone using the Revert button.

8.2 The Sample Box

8.2.1 Warp Controls

The Clip Warp Controls.
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When the Warp switch is off, Live plays the sample at its original, �normal� tempo, irrespec-
tive of the current Live Set tempo. This is useful for samples that have no inherent rhythmic
structure: percussion hits, atmospheres, sound effects, spoken word and the like. Turn
the Warp switch on to play rhythmically structured samples (such as sample loops, music
recordings, complete music pieces, etc.) in sync with the current song tempo.

The Control Bar's Tempo
Control.

To verify this, note that a warped sample's speed follows the tempo as you change the
Control Bar's Tempo control.

Live offers a number of controls to adjust the time-warping engine for optimal stretching
quality. For accurate warping, Live needs to know the sample's metrical structure. For
properly prepared loops, tempo and duration are calculated automatically; most of the time
this is accurate enough that the sample is immediately ready for use in Live. For other
samples, you may have to provide some hints.
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8.2.2 Sample Loop/Region and Display

Zooming and Scrolling

The Clip Zoom/Scroll
Area.

Zooming and scrolling in the Sample Display work much like they do in the Arrangement
View. Using the zoom/scroll area in the top half of the waveform, you can click and drag
vertically to smoothly change the zoom level, and horizontally to scroll the display.

The Clip Overview.

The Clip Overview provides additional zoom/scrolling functionality. It always shows the
complete clip, from start to end. The black rectangular outline represents the part of the
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clip that is currently displayed. You can click within the outline and drag horizontally or
vertically to scroll or zoom.

To have the Sample Display follow the play position and scroll automatically, turn on the
Follow switch, or use the Follow command from the Options menu.

The Follow Switch.

Playing and Scrubbing Clips

The section of the sample that plays when a clip is launched is set with the clip's region and
loop controls. An unlooped clip will play from its start marker to its end marker or until it is
stopped.

The Clip Start and End
Markers.

These markers can be clicked and dragged to new positions in the Sample Display, or they
can be moved with the and keys. To move the entire clip region (i.e., both the start
and end markers), select the start marker, hold down , and use the arrow keys.
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Using Clip Start and End
Controls to Change Clip
Length.

You can also adjust the clip start and end numerically using the respective value �elds to
the left of the Sample Display. For warped clips, these �elds display values as bars-beats-
sixteenths; for unwarped clips, the display is in minutes-seconds-milliseconds. Notice that
you can use the �Set� buttons here to place the markers during playback. Setting markers
this way is quantized according to global quantization.

Clicking in the scrub area in the lower half of the waveform or above the beat-time ruler will
make clip playback jump to that point.

The Clip Scrub Area.
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The size of this jump is quantized by the global quantization setting, which can be quickly
changed using the Ctrl 6   (PC) / 6   (Mac), 7   , 8 , 9 and 0   shortcuts. While
the mouse is held down over the scrub area, a portion of the clip the size of the chosen
quantization setting will be repeatedly played. With small quantization settings, or a setting
of �None,� this allows you to scrub through the music.

Looping Clips

To have the clip play as a (potentially in�nite) loop, turn on the Loop switch. Note that
the Warp switch must be activated before the Loop switch is accessible, as unwarped clips
cannot be looped.

You can click and drag to change the position and length of the loop brace in the Sample
Display, or you can type exact values into the Loop Length and Position �elds to the left of
the display.

The Clip Loop Controls.

The loop brace can be selected with the mouse and its position changed with commands
from the computer keyboard:

� and nudge the loop brace to the left/right by the current grid setting.

� and shift the loop brace left/right in steps the size of its length.
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� Ctrl (PC) / (Mac) shortens or lengthens the loop brace by the
current grid setting.

� Ctrl (PC) / (Mac) doubles or halves the loop length.

Regardless of the position of the loop brace, clip play upon launch will begin at the position
marked by the start marker, which means you can set up the clip to run into a loop.

Setting the Clip to Run
Into a Loop.

The Loop Length and Position �elds are equipped with Set buttons, which can be used to
create loops spontaneously during playback:

� Playing the clip and then clicking the Set Loop Position button moves the beginning
of loop to the current playback position (rounded to the global quantization setting)
and engages the loop. Then, clicking the Set Loop Length button moves the end of
the loop to the current playback position. This lets you capture the music in a loop on
the �y.

� While the loop is still off, you can click the Set Loop Length button to set the loop
to end at the current playback position without changing its preset length. This
simultaneously activates looping.

The Set buttons, the Loop switch, the loop brace and the start/end markers can all be
mapped to MIDI controls. You could, for example, use a rotary encoder to move the loop
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through a sample in increments the size of the chosen quantization interval.

8.2.3 Clip Pitch and Gain

The Clip Pitch and Gain
Controls.

The Transpose control shifts the clip pitch in semitones.

The Detune �eld �ne-tunes the clip in cents (100 cents = one semitone).

The Clip Gain slider, calibrated in dB, changes the clip gain.

8.2.4 Destructive Sample Editing

The Launch Sample
Editor Button.

The Launch Sample Editor button opens the sample in a sample editing application, as
speci�ed in the Misc Preferences. To process a sample in an external program, you will have
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to stop Live's playback. Upon returning to Live, the edited version of the sample will be
played back. The current set of Warp Markers is retained only if the sample length remains
the same as before. Remember that changes to one sample may affect other clips playing
the same sample.

8.2.5 Replacing the Clip's Sample

To replace the sample referenced by the clip with a different sample, drop the new sample
directly from the File Browser into the Clip View. Clip settings like pitch and volume will
be retained. The Warp Markers will be retained only if the new sample has the exact same
length as the old sample.

Tip: When bringing multitrack audio from another program into Live for remixing, it is
convenient to set Warp Markers for only one of the composite samples and copy the same
set of Warp Markers to the other tracks. This can be easily done provided the individual
samples have the exact same length (which usually is the case if they all have been exported
from several tracks in one go): Pick the sample with the clearest rhythmical pronunciation
and set the Warp Markers for this sample as described elsewhere. Next, make enough
copies of this clip to hold all the individual samples, and drop the samples from the Browser
into the clips. The Warp Markers will be retained, because the samples all have the same
length.

The Replace Sample
Button.

The Replace Sample button is for replacing a sample throughout the entire Live Set. All
clips that reference the �old� sample will reference the �new� sample, which is selected
using a �le-chooser dialog. Live retains the clip properties; the Warp Markers are kept if the
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new sample has the same or a greater length as the old sample and discarded otherwise.
This function is also useful for locating missing samples that are marked �of�ine�.

8.2.6 Saving Default Clip Settings with the Sample

The Save Default Clip
Button.

The Save Default Clip button saves the current clip's settings with the sample. Once saved,
Live will restore the current clip settings whenever you drop the sample into a Live Set. This
is especially useful with regards to the Warp Markers, which have to be set correctly for
Live to play long �les in sync. Note that you can use the Save button without affecting any
existing clips; Save just saves default settings for future clips using this sample.

The clip data becomes part of the analysis �le that accompanies the sample.

Note that storing default clip settings with the sample is different from saving the clip as a
Live Clip, which also saves devices and device settings.

8.2.7 High Quality Interpolation

The High Quality Switch.
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If the High Quality switch is on, Live uses an advanced sample-rate conversion algorithm
that provides better sound quality at the expense of a higher CPU load. Samples processed
with the Hi-Q algorithm generate less distortion, particularly at high frequencies, when
transposing a sample and/or matching an imported sample's sampling rate to the system's
sampling rate. Note: This feature involves only sample rate conversion, not the time-
stretching quality. There are dedicated controls for adjusting the stretching properties.

8.2.8 Clip Start and End Fades

The Clip Fade Switch.

The Clip Fade switch, when enabled, applies a short fade to the clip start and end to avoid
clicks at the clip edges. The length of the fade is signal-dependent and ranges from 0-4
milliseconds.

8.2.9 Clip RAM Mode

The RAM Mode Switch.

If the RAM Mode switch is on, Live is loading the audio referenced by the clip into the
computer's memory rather than reading it from disk in real time. RAM Mode can help with
these problems:
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� Your computer's hard disk is too slow to deliver audio for as many tracks as desired
in real time. For more information on disk-related problems, please refer to the
respective section.

� You are experiencing audio dropouts when playing clips in Legato Mode.

Use RAM Mode with care, as RAM is usually a scarce resource. Your computer is using the
hard disk for swapping out RAM contents that have not been used in a while. The more
clips you are running in RAM Mode, the higher the likelihood for them to be swapped
out. Live can handle disk overloads more gracefully than swapped-out audio arriving late:
Disk overloads result in unwanted mutes, whereas RAM overload results in both mutes and
rhythmical �hiccups.�

8.2.10 Reversing Samples

The Reverse Button.

This function creates a new sample by reversing the sample referenced by the current clip.
It then reapplies the old clip's settings (according to some rules that we will explain in a
moment), and replaces the original sample with the reversal in the Clip View. The new
sample is stored in your temporary recording folder until you save your Live Set, at which
point it is moved to your Sounds folder. The reversed sample has an �R� appended to the
end of its name so that it is easily distinguishable from the original.

There are a few rules for the reversing process. First, any Warp Markers will remain �xed
to their positions in the sample. This means that a Warp Marker on the downbeat of the
second bar of a clip will end up on the downbeat of the second-to-last bar after reversal.
Clip loop/region settings are similarly �ipped. Second, clip envelopes remain �xed to their
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position in time. Therefore, a mixer volume envelope that lowers the volume of the �rst half
of a clip will continue to do exactly that after reversal.

The reversal process is quite fast (about as fast as copying), but for very long samples it might
take a little time. When this is the case, the Status Bar in the lower portion of the Live screen
will give you a progress display, and further actions in the program will be temporarily locked
(though running clips will continue to play). You can play the reversed clip and perform other
actions in the program as soon as Live begins to draw the new waveform into the Sample
Display. Once a sample is reversed, a link to the reversed sample will be maintained until the
you quit the program, and reversing the same clip again (or a copy) will be instantaneous.

It is not recommended that you reverse clips in a live performance situation, as a slight glitch
can sometimes occur while Live reapplies the warp and loop settings.

8.3 The Notes Box

The Notes Box.
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8.3.1 Tempo Controls

The �Orig. BPM� �eld displays Live's interpretation of the tempo at which the clip's MIDI
was recorded. When dragging up or down in the Original BPM �eld, or clicking the :2 and
*2 buttons, you will see that the notes in the MIDI Editor are correspondingly stretched
or compressed. This is useful for aligning notes that you have recorded without a tempo
reference, like Live's metronome.

8.3.2 Bank and Program Change

Live can send MIDI bank/program change messages to external devices. According to the
settings in these controls, launching a clip also sends its bank/program change message. If
you are using Live to send MIDI to your synth, this means that each MIDI clip in your Live
Set can play a different sound on your synth. Live offers messages for 128 banks with 128
sub-banks, each of which has 128 programs. Please see the documentation that came with
your synthesizer to determine how many of these messages it can use. If you do not want
your clip to send program or bank change messages, simply set the bank/program choosers
to �None.�

8.3.3 MIDI Loop/Region

These controls manage how the contents of a MIDI clip are played and shown in the MIDI
Editor. They work the same way as those for audio clips.

In the MIDI Editor, the zoom/scroll area is located above the beat-time ruler, the scrub area
just below.
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8.4 Clip Defaults and Update Rate

You can change the rate at which Live applies your Clip View settings to a running clip. Clip
View changes will be quantized by the rate selected from the Clip Update Rate chooser in
the Misc Preferences.

Certain clip settings, such as Launch Mode and Warp Mode, can be set up as defaults for
all new clips. This is done in the the Default Preferences.



Chapter 9

Tempo Control and Warping

Unlike music stored on tape or in a traditional digital audio workstation, the music in Live
remains �elastic� at all times. Live is capable of time-warping samples while streaming them
from disk so as to synchronize them to the current project tempo. This happens without
affecting the pitch, which can be changed independently. Mixing and matching audio from
different origins is therefore extremely easy.

9.1 Tempo

9.1.1 Setting the Tempo

The Control Bar's Tempo
Field.

111
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The Control Bar's Tempo �eld allows you to change the playback tempo of your Live Set
at any time, in real time. You can even automate the tempo to create smooth or sudden
tempo changes along the song timeline.

You can have an external sequencer (or drum machine) play along with Live or have Live
play along with the sequencer. The respective settings are made in the MIDI Preferences,
and the EXT switch next to the tempo control is activated to have Live follow an external
MIDI clock source. Please refer to the section on synchronization for details.

9.1.2 Tapping the Tempo

The Tap Button.

You can use Live's Tap Tempo function to set the tempo at any time. As you click the Control
Bar's Tap Tempo button once every beat, the tempo of the Live Set will follow your tapping.

The Key Map Mode
Switch.

It's better to assign the Tap button to a computer key than using the mouse. Click on the
Control Bar's KEY switch to enter Key Map Mode; then select the Tap button; press the key
you would like to use for tapping; click the KEY switch again to leave Key Map Mode. The
assignment will take effect immediately. The Tap button can also be assigned to a MIDI
note or controller, like a foot switch, in a similar fashion. Although Live responds to your
tapping immediately, it does apply some degree of inertia to prevent sluggish behavior in
the software. The more taps Live receives in a row, the more precisely it will be able to
conclude the desired tempo.

You can also use tapping to count in: If you are working in a 4:4 signature, it takes four taps
to start song playback at the tapped tempo.
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9.2 Time-Warping Samples

Live's ability to play any sample in sync with a chosen tempo is a unique and important
feature. In addition, you can �warp� the rhythmic �ow of a piece, changing its �feel,� or
even move notes to other meter positions.

Think of a sample as a rubber-band that you want to pin to a (musical time) ruler. In Live,
the pins are called Warp Markers. A Warp Marker forces the software to arrive at a speci�c
point in the sample at a speci�c musical time. You can use any number of Warp Markers to
create an arbitrary mapping of the piece's inherent rhythm to a musical meter.

Warp Markers are set in the Clip View's Sample Display by double-clicking any of the gray
grid markers. They can then be dragged or moved with the arrow keys to different positions
in the clip. Warp Markers are deleted with the keyboard's Backspace or Delete key.

Double-Clicking a Grid
Marker Creates a Warp
Marker.

When working with your sample, you can have Live scroll the Sample Display to follow
playback. Use the Control Bar's Follow switch to activate this feature. It also might be
helpful to vertically resize the Sample Display by dragging on the split line between the Clip
View and the Session View track area.
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The Follow Switch in the
Control Bar.

In the following sections, we will look at a couple of applications for time-warping sam-
ples. Warping is, of course, an optional feature, and you have several different options for
deactivating warping, as described in the respective section in this chapter.

Note: For a tip on how to apply the same set of Warp Markers to several multitrack samples,
please see here.

Of course, your Warp Markers will be saved with the Live Set. In addition, you probably
want to save them with the sample, so that they are reconstructed the next time you drag
the �le into Live. To do this, click the Clip View's Save button.

9.2.1 Syncing Straight Loops

When you import a sample that represents a well-cut musical loop of 1,2,4 or 8 bars in
length, Live usually makes the correct assumptions to play the loop in sync with the chosen
tempo. It places two Warp Markers, one at the sample's beginning and one at the end.
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A One-Bar Loop as It
Appears in the Clip
View, by Default.

The �Orig. BPM� �eld displays Live's guess of the loop's tempo; if you happen to know the
tempo of the loop, you can type it in here. Sometimes Live's guess of the original tempo
is wrong by half or double. If so, correct this by clicking on the buttons labeled *2 and
:2, respectively. The sample plays at double speed when you press :2 because you are
changing Live's interpretation of the sample's tempo, which serves as a point of reference
for determining the required time-stretch factor.

9.2.2 Syncing Uncut Loops

When importing a loop that has not been edited into a well-cut loop, Live will play it out of
sync. Suppose there is a portion of silence at the sample beginning, prior to the �rst beat.
You can easily correct this by moving the Warp Marker labeled with a �1� to the �rst beat's
onset. Likewise, you can eliminate silence after the actual loop end by moving the Warp
Marker at the sample's right edge.
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Setting the Warp
Markers for a Badly Cut
Loop.

9.2.3 Syncing Odd-Length Loops

If you import a sample that contains a seven-bar loop, Live initially assumes the loop is eight
bars long (or four, depending on its length) and plays it out of sync. For correct playback,
the last marker needs to show a eight, not a nine. To achieve this do the following:

1. Double-click on the last Warp Marker to delete it.

2. Double-click on the eight to create a new Warp Marker.

3. Drag the new Warp Marker to the sample end.

If Live's initial guess had been a four-bar loop, the eight would not have been accessible. In
that case, you could initially drag the Warp Marker at the end toward the left until the eight
became visible.

Theoretically this should have done the job for our seven-bar loop. Practically, though, it is
very likely that moving the markers led to a change of the loop start and end points. This
is because the loop is tied to the meter grid and therefore moves with the Warp Markers,
which de�ne the meter grid. Live makes sure the loop �ts in the sample, and therefore has
to change its length if required by a Warp Marker change.
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9.2.4 Manipulating Grooves

You can now create any number of Warp Markers by double-clicking on one of the gray
grid markers. Drag in a �straight� looped sample, set a few Warp Markers, and move them
around to see what happens. Warp Markers really serve two purposes:

1. to provide a �correct� interpretation of the �ow of musical time in the sample;

2. to mess up the �ow of time in the sample.

If a single event in a percussion loop comes late, just pin it to the Warp Marker, which shows
the beat position at which you actually want to hear that event. You may want to pin the
adjacent beat positions as well, to avoid affecting neighboring regions in the sample.

Using Warp Markers to
Manipulate the Groove.

�Removing� a sample's natural groove by applying Warp Markers is an interesting creative
method, particularly in conjunction with Live's ability to impose an arti�cal groove onto clips
in real time.



9.2. TIME-WARPING SAMPLES 118

9.2.5 Syncing Longer Pieces

Live's Auto-Warp algorithm makes longer samples and entire songs readily available for
integration into your project. You can use the Browser to import long samples or MP3, Ogg
Vorbis, Ogg FLAC and FLAC �les.

When you drag a �le into Live that is too long to justify the assumption that it is a loop or a
one-shot, Live will auto-warp the clip by default (though this can be changed in the Default
Preferences).

Note that, for the auto-warp mechanism to work, �les which are being imported into the
program for the �rst time will need to undergo a �rst-time analysis process and will not be
immediately available for playing or editing. As explained in the section in this manual on
analysis �les, analysis can be batch-processed with the (PC) / Ctrl (Mac) context
menu's Analyze Audio command. Once analysis is �nished, you can view the results of
Auto-Warp's assumptions about the �le.

Auto-Warp's Results in
the Clip View.

As long as Auto-Warp made the correct set of informed guesses, the clip will be ready to
play in perfect sync with Live's project tempo. However, if Auto-Warp does not quite do
what you want, you can control its results. The remainder of this section will focus on various
ways of guiding Live's auto-warping. Remember that the metronome in the Control Bar will
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probably come in handy as you warp longer pieces.

The Metronome Switch.

It might happen that Auto-Warp guesses the tempo correctly but gets the downbeat wrong.
To remedy this, you can do the following:

� Zoom in and drag the 1.1.1 marker to the desired position;

� Use the start marker's (PC) / Ctrl (Mac) context menu to select the Set 1.1.1
Here command.

Using the Context Menu
to Direct Auto-Warp.

Directing Auto-Warp is also relatively simple when you have imported a perfectly cut loop.
You can tell Auto-Warp to work accordingly using the Warp As ...-Bar Loop command. Live
will propose a loop length that makes the most sense given the current project tempo.
Decreasing the project tempo can, for instance, lead Live to assume the loop is 8 bars at 90
BPM instead of 16 bars at 180 BPM.

Sometimes more detailed control of Auto-Warp is necessary. The best way to go about
warping a clip that requires more detailed attention is in sections, working gradually from
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left to right. You can set a Warp Marker by double-clicking one of the gray grid markers to
the right of each correctly warped section, �pinning� it into place. The shortcuts for working
with the clip loop brace and start/end markers can speed up this process considerably. You
might also �nd it helpful to select multiple Warp Markers for moving by appending to your
selected Warp Marker with the or Ctrl (PC) / (Mac) modi�ers held down.

The four �Warp From Here� commands provide various ways of resetting Warp Markers to
the right of the selected grid or Warp Marker, leaving Warp Markers to the left untouched.
These commands are also available from the start marker.

� Warp From Here runs the Auto-Warp algorithm on the material to the right of the
selected marker.

� Warp From Here (Start At ...) directs Auto-Warp to use the project tempo as a starting
point for tempo tracking. The strategy here is as follows:

1. Deactivate the Warp switch for the clip and play it (or the section in question)
unwarped;

2. Use the Control Bar's Tap Tempo button to tap along and set the project
tempo to match that of the clip;

3. Turn warping on again and use the Warp From Here (Start At ...) command
to tell Auto-Warp to use your tapped tempo and warp from there.

� Warp From Here (Straight) tells Auto-Warp that this is a clip with no tempo variations,
i.e., an electronically produced piece. Auto-Warp will therefore set a single Warp
Marker according to its guess about the original �le's tempo.

� Warp ... BPM From Here will also set only a single Warp Marker, but in this case, Auto-
Warp is forced to interpret the piece as exactly matching the project tempo. This is
useful in cases when you happen to know the exact BPM value of an electronically
produced piece and can type it into the Control Bar before warping.

Of course, your Warp Markers will be saved with the Live Set. In addition, you probably
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want to save them with the sample, so that they are reconstructed the next time you drag
the �le into Live. To do this, click the Clip View's Save button.

Note that, if a sample has a saved set of Warp Markers, Auto-Warp will have no effect. When
this is the case, you can use any of the (PC) / Ctrl (Mac) context menu commands
described in this section to initiate auto-warping.

9.3 Adjusting for Good Stretching Quality

Live offers a number of time-stretching methods to accommodate all sorts of audio material.
The time-stretching method, and additional controls for each method, are set up in the Clip
View's �Warp� box.

The Warp Modes are different varieties of granular resynthesis techniques. Granular resyn-
thesis achieves time compression and expansion by repeating and skipping over parts of
the sample (the �grains�). The Warp Modes differ by the selection of grains, as well as by
the details of overlapping and crossfading between grains.

Let's investigate which Warp Modes work best for different types of signals and how to
adjust the warping controls for �clean� stretching. It's also fun to �misuse� these controls
to achieve interesting artifacts instead of correct stretching.

9.3.1 Beats Mode

Beats Mode works best for material where rhythm is predominate (e.g., drum loops as well
as most pieces of electronic dance music). The granulation process is optimized to preserve
transients (attacks, note onsets) in the audio material.

Use the Transients control to guide Live's assumptions about where to �nd transients in
the waveform. If there is no rhythmical activity at odd 16th notes, choose 8th, etc. For
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some interesting rhythmic artifacts, choose large transient values in conjunction with pitch
transposition.

9.3.2 Tones Mode

Tones Mode serves well for stretching material with a more or less clear pitch structure, such
as vocals, monophonic instruments and basslines.

Grain Size provides rough control over the average grain size used. The actual grain size
is determined in a signal-dependent way. For signals with a clear sense of pitch contour, a
small grain size works best. Larger grain sizes help avoid artifacts that can occur when the
pitch contour is unclear, but the tradeoff can be audible repetitions.

9.3.3 Texture Mode

Texture Mode works well for sound textures with an ambiguous pitch contour (e.g., poly-
phonic orchestral music, all sorts of noise, atmospheric pads, etc.). It also offers rich potential
for manipulating all kinds of sounds in a creative way.

The Grain Size control determines the grain size used; unlike in Tones Mode, this is a setting
that Live will use unaltered, without factoring in the signal's characteristics.

Fluctuation introduces randomness into the process. Larger values give more randomness.

9.3.4 Re-Pitch Mode

In Re-Pitch Mode, Live doesn't really time-stretch or compress the music; instead, it adjusts
the playback rate to create the desired amount of stretching. In other words, to speed
up playback by a factor of 2, it's transposed up an octave. This is like the �DJ stretching
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method� of using variable-speed turntables to sync two records, or what happens to samples
in samplers when they're transposed.

The Transpose and Detune controls have no effect in Re-Pitch Mode.

9.3.5 Complex Mode

Complex Mode is a warping method speci�cally designed to accommodate composite
signals that combine the characteristics covered by other Warp Modes; it works well for
warping entire songs, which usually contain beats, tones and textures.

Complex Mode is a rather CPU-intensive function, using approximately ten times the CPU
resources required by the other Warp Modes. As such, you may want to freeze tracks where
Complex Mode is in use or record the results as a new clip to use as a substitute.

9.4 Deactivating Warping

You can direct Live's assumptions about new samples using the Default Preferences. If the
Auto-Warp Long Samples preference is on, Live assumes that long samples contain music
that should be played in sync with the project tempo. If you would rather have Live default
to playing long samples as they are, disengage this preference.

Regardless of how Live interprets new samples by default, you can always override these
decisions on a per-clip basis by toggling the Clip View's Warp switch.



Chapter 10

Editing MIDI Notes and Velocities

A MIDI clip in Live contains notes and controller data for playing a MIDI instrument. This
instrument can be a virtual instrument in a MIDI track's device chain or an external synth
fed via the track's output routing. The MIDI clip provides the device with a musical score
to play, specifying note pitch, length, position and dynamics (referred to as velocity in the
MIDI lexicon). MIDI is composed and edited in Live's MIDI Editor.

10.1 Creating an Empty MIDI Clip

MIDI clips are created

� by means of recording;

� or by double-clicking an empty Session slot in a MIDI track;
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� or by selecting an empty Session slot in a MIDI track and choosing the Insert menu's
Insert MIDI Clip command;

� or, in the Arrangement View, by selecting a timespan in a MIDI track and choosing the
Insert menu's Insert MIDI Clip command.

10.2 The MIDI Editor

To bring up the MIDI Editor, double-click a MIDI clip to open the Clip View. You can use the
Clip View Box selector to make sure the Notes box is showing, then click in the title bar of
the Notes box to bring up the MIDI Editor on the right-hand side of the screen.

The MIDI Editor.

The MIDI Editor is comprised of two editing windows: the upper Note Editor and the lower
Velocity Editor. You can resize the Velocity Editor by dragging on the split line that runs
between it and the Note Editor. You can also show and hide the Velocity Editor using the
triangular button on the left-hand side of the split line.
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The Control Bar's Draw
Mode Switch.

Switch to Draw Mode by activating the Control Bar's Draw Mode switch. You can now draw
MIDI notes into the Note Editor with the mouse. Deactivating Draw Mode allows notes to
be selected and moved around by clicking and dragging, either vertically to change their
transposition, or horizontally to change their position in time.

Previewing MIDI Notes.

Provided your MIDI track's device chain contains an instrument, activating the Preview switch
in the MIDI Editor allows you to hear notes as you select and move them.

Note velocity is adjusted in the Velocity Editor, by clicking and dragging on the associated
markers. You can also use Draw Mode in the Velocity Editor: It will draw identical velocities
for all notes within a grid �tile.�

After drawing a few notes and moving them around, you will probably want to know how to
get around in the Note Editor. So, before we get into detailed editing information, we will
�rst explain MIDI Editor navigation.
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10.3 MIDI Editor Navigation and Transport

Note Scale Position Is
Shown Vertically and
Beat-Time Horizontally.

The MIDI Editor has both vertical and horizontal navigation. Along the horizontal axis lies
a time ruler, which shows note position along a musical timeline. The vertical axis contains
both the note ruler, displaying octaves C0�C10, and a representation of a piano keyboard
(the piano roll). Note that if the Preview switch at the top of the piano roll is activated, you
can listen to the results of your piano roll playing.
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12 3 5 6

MIDI Editor Navigation.

1. To smoothly change the time-zoom level, click and drag vertically in the time
ruler. Drag horizontally in the time ruler to scroll from left to right.

2. Click and drag vertically in the note ruler to change which octaves are shown,
or drag horizontally to change the vertical zoom size of MIDI notes and the
keyboard.

3. Click and drag over one or more notes to de�ne a selection. Then, double-click
on the note ruler to automatically zoom in on your selection. If no notes are
selected, double-clicking the note ruler will zoom in on the area from the lowest
to the highest note in the clip.

4. To zoom in and out around the current selection, use the computer keyboard's
+ and - keys.

5. The Clip Overview just beneath the MIDI Editor can also be used for navigation.
It always shows the complete contents of the selected MIDI clip. The black
rectangular outline represents the part of the clip that is currently displayed in
the Editor above. To scroll, click within the outline and drag left or right; to zoom
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in and out, drag up and down.

6. Change the length of what is shown in the Editor by dragging the left or right
edges of the outline in the Clip Overview.

7. To quickly change what is shown in the Editor, click on a section that you want
to examine in the Clip Overview, then drag downwards to zoom in, or scroll by
dragging left and right.

8. The Page Up and Page Down keys on your computer keyboard scroll the Note
Editor vertically. The Ctrl (PC) / (Mac) modi�er will change this to
horizontal scrolling.

The Control Bar's Follow
Switch.

The area displayed in the Note Editor can be set to scroll with playback using the Follow
switch from the Control Bar.

The MIDI Clip Scrub
Area.

You can click in the scrub area just below the beat-time ruler to start playback from that
point, rounded by the global quantization setting. Learning about the loop/region controls
and associated shortcuts can also be helpful in getting around in the MIDI Editor and playing
selections quickly and easily.

As you work with MIDI, you may �nd yourself needing extra screen space. You can click and
drag vertically on the window split between the Session or Arrangement View and the Clip
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View to enlarge the MIDI Editor.

Enlarge the MIDI Editor
by Dragging the
Window Split Between
Session and Clip Views.

10.4 Editing MIDI

10.4.1 Non-Destructive Editing

You can always return your MIDI clip to its previous state by using the Edit menu's Undo
command. Furthermore, if the MIDI clip being edited originated in a MIDI �le on your hard
drive, none of your editing will alter the original MIDI �le, as Live incorporates its contents
into your Live Set when importing.

10.4.2 Folding and Looping

An important feature of the MIDI Editor is the Fold button, located in the upper left corner.
Activating this button will immediately hide all rows, or key tracks, that do not contain
MIDI notes. This is very useful when working with percussion kits, for example, which are
oftentimes mapped out along a keyboard in sections corresponding to percussion type
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(e.g., snares grouped together two octaves down from hi-hat cymbals, etc.). When working
with a MIDI �le created by such a mapping, sometimes only one or two of each type of
percussion sound is used, and it becomes unnecessary to view the entire keyboard range.

The Fold Button Extracts
Key Tracks Containing
Notes.

When editing MIDI, you might �nd that you want to change which part of the clip you are
listening to, or loop the clip in order to listen to it repeatedly. You can use the loop/region
markers for this.

Use the Loop/Region
Markers to Select a
Speci�c Region of the
Clip to Play.

10.4.3 Grid Snapping

Most functions in the MIDI Editor are subject to grid snapping. You can hold down the
Alt (PC) / (Mac) modi�er while performing an action to bypass grid snapping.
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Note movements will also snap to an �offset,� which is based on the original placement of
the note relative to the grid. This is useful for preserving a groove or loose playing style that
you do not necessarily want to �set straight.�

10.4.4 Arranging and Quantizing Notes

As we have seen, notes in the MIDI Editor can be moved both horizontally (changing their
position in time) and vertically (changing their transposition). They can be moved either by
clicking and dragging, or with the arrow keys on your computer keyboard; in either case,
they are subject to grid and offset snapping. If you are playing the clip while you move
notes, you can listen to them play in their new assignments as you drag them, without
waiting until you have released the mouse button.

Multiple notes can be selected and moved in unison: �Rubber-band� select more than one
note with one mouse motion by clicking in empty space, then dragging diagonally upward
or downward to enclose the notes in the dotted line that appears.

You can use the modi�er to click and add individual notes or additional �rubber-
band� selections to your current selection. You can also remove a single note from your
selection by holding down and clicking on it. Holding and clicking on the
piano roll selects all notes in a single key track.

There are two options for quantizing MIDI notes in Live. As previously mentioned, you can
move notes so that they snap to the visible grid lines. Alternatively, you can select a note
or notes and choose �Quantize� from the Edit menu, or use the Ctrl U (PC) / U

(Mac) hotkey. This brings up a dialog box with several quantization options.
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Quantizing MIDI Notes.

Using the options presented here, you can select a meter value for quantization and set
either the note start or end (or both) to be quantized. Quantizing the note end will stretch
the note so that it ends at the chosen meter subdivision. You can also quantize notes without
giving them that �quantized� feel using the Amount control, which will move notes only by
a percentage of the set quantization value.

10.4.5 Creating and Editing Notes

Selecting a note (or notes) makes it subject to commands from the Edit menu, such as Copy
and Paste. You can use the Ctrl (PC) / Alt (Mac) modi�er to click and drag a copy of
a note to a new location.

The Edit menu's Select Loop command selects all notes that begin within the loop brace.
The Select Loop command can also be executed without the menu by simply clicking the
loop brace. This command can speed up editing when coupled with the loop brace's
shortcuts. Let's say you have arranged a nice 1-bar loop in the Note editor, and you want to
duplicate it a couple of times. You can click the loop brace to select the notes that begin
within the loop, execute the Edit menu's Copy command, shift the loop to the right by one
loop length with , and execute the Edit menu's Paste command.
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Copying (Above) and
Pasting (Below) a Loop.

As we have already seen, creating new MIDI notes is as simple as activating Draw Mode
and drawing them into the Note Editor. MIDI notes can also be added and deleted by
double-clicking when Draw Mode is inactive.

Vertical movements in Draw Mode correspond to velocity changes. This means that, with
one horizontal motion and one vertical motion, you can draw multiple notes and their
velocities without releasing the mouse button. If you change velocity with this vertical
movement, Live will remember the change and use your new velocity on any notes that you
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draw afterward.

You may sometimes, by dragging or by drawing, place a new note on top of one that already
exists. If the new note overlaps with the beginning of the original note, the original note will
vanish. The original note is invisible, but still exists, and will reappear intact if the new note
is moved away again. If the new note overlaps with the �tail� of the original, the original
note's length will change so that it lasts just until the new note's beginning. This, too, is
not an irreversible action, and the old note length will be restored if the new clip is again
moved.

10.4.6 Changing Note Length

Clicking and dragging on a note's left or right edges changes its length. Note length can
only be changed when Draw Mode is inactive, and will be quantized unless the Alt (PC)
/ (Mac) modi�er is held down while dragging.

Changing Note Length.

Tip: To set a group of notes to the same length, select them all, grab the end of the longest
one, drag them all down to zero length and then extend them.

10.4.7 Editing Velocities

To change velocity for a MIDI note, click and drag on the associated marker in the Velocity
Editor. (To help you locate the velocity marker belonging to a MIDI note that may be stacked
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vertically with others, Live highlights the velocity marker for whichever note your mouse is
hovering over.) Velocity changes will be shown numerically in a small display in the time
ruler.

Changing Note Velocity.

As in the Note Editor, you can select multiple velocity markers to change by clicking with
the modi�er held down.

Tip: To set a group of notes so that they all have the same velocity, select their markers in
the Velocity Editor, drag them up to maximum velocity and then decrease velocity to the
desired value.

As we saw earlier, Draw Mode allows drawing identical velocities for all notes within a grid
tile. Velocity drawing can be limited to only those notes that are currently selected if the

modi�er is held. To draw markers individually (as you would want to with a crescendo,
for instance) deactivate grid snapping with the Ctrl 4   (PC) / 4   (Mac) shortcut, or
simply hold down the Alt (PC) / (Mac) modi�er.
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Drawing Identical
Velocities (Above) and a
Crescendo (Below).

Tip: To draw a velocity ramp with notes that are all in the same key track, press and
click on the piano roll to select all notes within the desired key track, make sure Draw Mode
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is activated and draw the ramp into the Velocity Editor while holding the modi�er,
so that you affect only the selected notes.

Notes in the Note Editor display their velocity in their coloring � light notes play softly,
and vice versa. To change the velocity of notes without the Velocity Editor open, click any
selected note and drag vertically while pressing the the Alt (PC) / (Mac) modi�er.

10.4.8 Deactivating Notes

To deactivate, or mute, a note (or notes) in the MIDI Editor, select it and (PC) / Ctrl

(Mac) to access the context menu. The Deactivate Note(s) command will mute the note,
making it appear gray in the display. To reactivate notes, use the context menu's Activate
Note(s) command.



Chapter 11

Launching Clips

The Live Session View is set apart by the fact that it gives you, the musician, an spontaneous
environment that encourages performance and improvisation. An important part of how
you take advantage of the Session View lies within how you con�gure your various Session
View clips. This chapter explains the group of settings used to de�ne how each Session
View clip behaves when triggered, or �launched.�

11.1 The Launch Box

Remember that clips in the Session View are launched by their Clip Launch buttons or remote
control. Clip launch settings are made in the Launch box. The Launch box only applies to
Session View clips, as Arrangement View clips are not launched but played according to
their positions in the Arrangement.
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To view the Launch box, open the Clip View of a Session View clip by double-clicking the
clip, then activating the leftmost Clip View Box selector panel.

Use the Clip View Box
Selector to Bring up the
Launch Box.

Note that you can edit the launch settings of more than one clip at the same time by �rst
selecting the clips and then opening the Clip View.

11.2 Launch Modes

The Clip Launch Mode
Chooser.

The Launch Mode chooser offers a number of options for how clips behave with respect to
mouse clicks, computer keyboard actions or MIDI notes:

� Trigger: down starts the clip; up is ignored.

� Gate: down starts the clip; up stops the clip.

� Toggle: down starts the clip; up is ignored. The clip will stop on the next down.
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� Repeat: As long as the mouse switch/key is held, the clip is triggered repeatedly at
the clip quantization rate.

11.3 Clip-Level Quantization

The Clip Quantization
Chooser.

The Clip Quantization chooser lets you adjust an onset timing correction for clip triggering.
To disable clip quantization, choose �None.�

To use the Control Bar's Global Quantization setting, choose �Global.� Global quantization
can be quickly changed using the Ctrl 6   (PC) / 6   (Mac), 7   , 8 , 9 and 0   

shortcuts.

Note that any setting other than �Global� or �None� will quantize the clip's launch when it
is triggered by Follow Actions.
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11.4 Velocity

The Velocity Amount
Field.

The Velocity Amount control allows you to adjust the effect of MIDI note velocity on the
clip's volume: If set to zero, there is no in�uence; at 100 percent, the softest notes play the
clip silently. For more on playing clips via MIDI, see the respective section.

11.5 Legato Mode

The Legato Mode
Switch.

Suppose you have gathered, in one track, a number of looping clips, and you now want to
toggle among them without losing the sync. For this you could use a large quantization
setting (one bar or greater), however, this might limit your musical expression.

Another option, which works even with quantization turned off, is to engage Legato Mode
for the respective clips. When a clip in Legato Mode is launched, it takes over the play
position from whatever clip was played in that track before. Hence, you can toggle clips at
any moment and rate without ever losing the sync.
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Legato Mode is very useful for creating breaks, as you can momentarily play alternative
loops and jump back to what was playing in the track before.

Unless all the clips involved play the same sample (differing by clip settings only), you
might hear dropouts when launching clips in Legato Mode. This happens because you are
unexpectedly jumping to a point in the sample that Live has had no chance to pre-load from
disk in advance. You can remedy this situation by engaging Clip RAM Mode for the clips in
question.

11.6 Follow Actions

Follow Actions allow creating chains of clips that can trigger each other in an orderly or
random way (or both). A clip's Follow Action de�nes what happens to other clips in the
same group after the clip plays. A group is de�ned by clips arranged in successive slots of
the same track. Tracks can have an unlimited number of groups, separated by empty slots.

3

1

2

The Follow Action
Controls.

1. The Follow Action Time control de�nes when the Follow Action takes place in
bars-beats-sixteenths from the point in the clip where play starts. The default for
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this setting is one bar.

2. The Follow Action choosers allow selecting two different Follow Actions, A and
B.

3. The Chance A and Chance B controls set the likelihood of each of the two
Follow Actions occurring. If a clip has Chance A set to 1 and Chance B set to
0, Follow Action A will occur every time the clip is launched. As we can see
from this example, a Chance setting of 0 means that an action will never happen.
Changing Chance B to 10 in this scenario makes Follow Action A occur much
less often � approximately once out of every ten clip launches.

There are eight Follow Actions available:

�Play Clip Again� restarts the clip.

�Play Next Clip� triggers the next clip down in the group. If a clip with this setting is last
in a group, this Follow Action triggers the �rst clip.

�Play Previous Clip� triggers the previous clip (the one above the current one).

�Play Any Clip� plays any clip in the group.

�Stop� simply stops the clip after it has played for the chosen Follow Action Time. Note
that this overrides clip loop/region settings.

�Play First Clip� launches the �rst (top) clip in a group.

�Play Last Clip� launches the last (bottom) clip in a group.

There is also the possibility to choose no Follow Action by leaving the chooser blank.

Note that a Follow Action happens exactly after the duration that is speci�ed by the Follow
Action Time controls unless clip quantization is set to a value other than �None� or �Global.�
Follow Actions circumvent global quantization but not clip quantization.

So, why do you need these things? Music is repetition and change. Music based on loops
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or short melodic fragments has a tendency to sound static. Follow Actions allow you to
create structures that will repeat but can also be surprising. Remember that you can always
record the results of your experiments, so this can provide a good source for new material.

In the following sections we will look at some practical examples and ideas for Follow
Actions.

11.6.1 Looping Parts of a Clip

Let's say that you want to play a longer clip, but then you want only the last eight bars to
loop. You can set this up using Follow Actions:

1. Drag the clip into the Arrangement View and make sure that the Clip View's
Loop switch is not activated. Use the Edit menu's Split command to split the clip
between the non-looping and looping parts.

2. Click and drag the resulting two clips into the Session View by letting the mouse
cursor hover over the Session View selector. Drop the two clips into a track. They
now form a Follow Action group.

2

3 Creating a Group With
the Two Clips.

3. Set up Follow Actions for the �rst clip. You will want to make Follow Action Time
equal to the clip's length. Set the Follow Action A chooser to �Play Next Clip,�
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with a Chance setting of 1, leaving Follow Action B alone. Now this clip is set
up to advance to the looping clip after it plays.

4. Activate the Loop switch for the second clip.

The �rst clip will now proceed to the second after it has played in its entirety; the second
clip will simply play in a loop until it is stopped.

11.6.2 Creating Cycles

One of the most obvious possibilities that Follow Actions open up is using a group of
samples to form a musical cycle. If we organize several clips as a group and use the �Play
Next Clip� Follow Action with each clip, they will play one after the other ad in�nitum, or
until we tell them to stop.

Cycles can be peppered with occasional rearrangements through the addition of other
Follow Actions, such as �Play Any Clip,� with smaller relative Chance settings.

11.6.3 Temporarily Looping Clips

There are some interesting applications of Follow Actions when it comes to creating tem-
porary musical loops.

The default setting for Follow Action is actually a 1:0 chance that �Nothing� happens after
the Follow Action Time, which means that there is effectively no Follow Action. But now,
imagine a group consisting of one single clip. Follow Action A is set to �Play Clip Again,�
with a Chance of 8. Follow Action B is set to �None,� with a Chance of 1. The clip uses
a long sample, and Follow Time is set to one bar. Clicking on the clip will play the �rst
bar, after which it will be very likely that it will play the �rst bar again. However, after a few
repetitions, it will eventually come to Action B � �Nothing� � and continue playing the rest
of the sample.
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Or, a clip can be played from its start to a speci�c point, when its Follow Action tells it to
�Play Next Clip.� The same �le can be used in the next clip in the group, but this one can
be set to loop. This second clip can have any manner of Follow Action settings, so that it
might then play forever, for a speci�ed time or until random chance leads to the next clip in
the group.

11.6.4 Adding Variations in Sync

Paired with clip envelopes and warping, Follow Actions can be used to create all sorts of
interesting variations within a group of similar clips. You could, for example, use Follow
Actions to randomly trigger clips with different MIDI-controller clip envelopes, so that �ne
variations in pitch bend or modulation of an instrument or synth could occur as the clips in
a group interacted. Audio clips could morph between different effect or clip transposition
settings.

Using Follow Actions and Legato Mode together provides a powerful way of gradually
changing a melody or beat. Imagine that you have several identical clips of a melody that
form a group, and they are set up to play in Legato Mode. Whenever their Follow Actions
tell them to move on to another clip in the group, the melody will not change, as Legato
Mode will sync the new play position with the old one in beat-time. The settings and clip
envelopes of each clip (or even the actual notes contained in a MIDI clip) can then be slowly
adjusted, so that the melody goes through a gradual metamorphosis.

11.6.5 Mixing up Melodies and Beats

You can let Follow Actions perform unpredictable remixes and solos for you: Use a clip
containing a beat or melody, and copy it so that there are several instances of it forming a
group. Alternatively, you can use several different beats or melodies that you want to mix
together. The start and end for each clip can be set differently, as can clip envelopes and
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other clip settings. As long as Follow Action Time in each clip is equal to the length of the
clip that you want to play, you can set up two Follow Actions with different Chance values
in each clip, launch a clip, and surprise yourself.

11.6.6 Creating Nonrepetitive Structures

Follow Actions are great when it comes to sound installations, as they allow you to create
structures that play for weeks or months and never exactly repeat. You can set the Follow
Action Time controls in a series of clips to odd intervals, and the clips will interact with each
other so that they never quite play in the same order or musical position. Remember that
each clip can have two different Follow Actions with corresponding Chance settings... have
fun!



Chapter 12

Routing and I/O

In the context of Live, �routing� is the setup of the tracks' signal sources and destinations
(i.e., their inputs and outputs). Routing happens in the mixer's track In/Out section, which
offers, for every track, choosers to select a signal source and destination. The mixer's In/Out
section is Live's �patchbay.�

You can check the �In/Out� View menu entry to access the In/Out section in the Session or
Arrangement View. Note that, in the Arrangement View, unfolding and resizing the track
makes the complete In/Out section available; in the Session View, the In/Out section can
also be shown or hidden from the mixer with the Mixer Section selector on the far right-hand
side of the screen.
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The Mixer's In/Out
Section and Mixer
Section Selectors.

For every track (except the Master), the In/Out section has the same layout:

� The upper chooser pair (�Audio/MIDI From�) selects the track's input. Audio tracks
have an audio input, and MIDI tracks have a MIDI input. Return tracks receive their
input from the respective sends.

� The �Monitor� radio button selects the monitor mode, or the conditions under which
the track's input is heard through the track.

� The lower chooser pair (�Audio/MIDI To�) selects the track's output. All tracks have
audio outputs, except for MIDI tracks without instruments. Remember that instruments
convert MIDI to audio.

Within a chooser pair, the upper chooser selects the signal category (�Ext.,� for instance,
for external connections via an audio or MIDI interface), and is called the Input/Output Type
chooser. If this signal type offers sub-selections or channels, they are available from the
lower chooser, or the Input/Output Channel chooser. In our �Ext.� example, these would
be the individual audio/MIDI inputs and outputs.
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12.1 Monitoring

�Monitoring,� in the context of Live, means passing a track's input signal on to the track's
output. Suppose you have set up an audio track to receive its input signal from a guitar.
Monitoring then means that the signal from your live guitar playing actually reaches the
track's output, via the track's device chain. If the track's output is set to �Master,� you can
hear the guitar signal, processed by whatever effects are used, and delayed by whatever
latency the audio hardware interface incurs, over your speakers.

The In/Out section offers, for every audio track and MIDI track, a Monitor radio button with
the following three options:

� The default Auto-monitoring setting does the right thing for most straightforward
recording applications: Monitoring is on when the track is armed (record-enabled),
but monitoring is inhibited as long as the track is playing clips.

Audio and MIDI Track
Arm Buttons.

� To permanently monitor the track's input, regardless of whether the track is armed or
clips are playing, choose In. This setting effectively turns the track into what is called
an �Aux� on some systems: The track is not used for recording but for bringing in a
signal from elsewhere (for instance, a ReWire slave program). With this setting, output
from the clips is suppressed. An �In� monitoring setting can be easily recognized even
when the In/Out section is hidden by the orange color of the track's Activator switch.

� Monitoring can be turned off altogether by choosing the Off option. This is useful
when recording acoustic instruments which are monitored �through the air,� when
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using an external mixing console for monitoring or when using an audio hardware
interface with a �direct monitoring� option that bypasses the computer so as to avoid
latency. Generally, it is preferable to work with an audio interface that allows for
negligible latencies (a few milliseconds). If you are recording into Live with monitoring
set to �Off,� you may want to make the Audio Preferences' Overall Latency adjustment,
which is described in the built-in program tutorial on setting up the Audio Preferences.

12.2 External Audio In/Out

An audio interface's inputs are selected by choosing �Ext. In� from the Input Type chooser of
an audio track. The Input Channel chooser then offers the individual input channels. Entries
in this chooser each have meters next to their names to help you identify signal presence
and overload (when the meter �ashes red). Setting up the audio interface's outputs works
the same way via the output chooser pair.

The list of available inputs and outputs depends on the Audio Preferences, which can be
reached via the Input and Output Channel choosers �Con�gure...� option. Note that
the Audio Preferences also provide access to the Channel Con�guration dialogs, which
determine which inputs and outputs are used, and whether they are available to Live as
mono or stereo pairs. Essentially, the Channel Con�guration dialog tells Live what it needs
to know about how the computer is connected to the other audio components in your
studio.

12.2.1 Mono/Stereo Conversions

When a mono signal is chosen as an audio track's input, the track will record mono samples;
otherwise it will record stereo samples. Signals in the track's device chain are always stereo,
even when the track's input is mono or when the track plays mono samples.
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Mono is turned into stereo simply by using the identical signal for left and right channels.
When a track is routed into a mono output, the left and right signals are added together
and attenuated by 6 dB to avoid clipping.

12.3 External MIDI In/Out

MIDI from the outside world is routed into Live just like audio. From the Input Type chooser
of a MIDI track, you can either select a speci�c MIDI input device or �All Ins,� which is the
merged input of all external MIDI devices. The Input Channel chooser offers the individual
input channels of the selected MIDI device and the merged signal of all channels, �All.� As
is the case with audio inputs, the Input Channel chooser also has meters next to every entry
to represent activity on the respective in channel.

12.3.1 The Preferences' Active MIDI Device List

The MIDI Device List in
the Preferences.
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You can con�gure which MIDI devices are made available to Live using the Active Devices
section in the MIDI Preferences. This section lists all available input and output MIDI
devices. For Live's tracks to receive/send MIDI from/to a speci�c MIDI device, make sure
the corresponding switch in the �Track� column is set to On. You can use any number of
MIDI devices for track MIDI input/output; the mixer's In/Out section allows you to individually
address them.

12.3.2 Playing MIDI With the Computer Keyboard

The computer keyboard can be used as a pseudo-device for generating MIDI notes from
computer keyboard strokes. Using this pseudo-device, you can generate MIDI even without
a �real� MIDI input device. To turn the computer MIDI keyboard on, use the Control
Bar's Computer MIDI Keyboard button, or the Ctrl K (PC) / K (Mac)
shortcut to the Options menu entry.

Activating the Computer
MIDI Keyboard.

The center row of letter keys on the keyboard will play notes corresponding to the white keys
on a piano, beginning on the left with the note C5. The black keys on a piano correspond to
the upper row of computer keys. The four leftmost letters on the lower row of the keyboard
are used to transpose the note range and to set velocity. The results of changing these
values are displayed in the Status Bar at the bottom of the Live screen.

As it happens, when the computer keyboard is set to send notes between C3 and C4, the
keys are mapped to MIDI notes such that the center row of the keyboard (ASDF...) addresses
the Impulse percussion sampler's sample slots. This means that you can play and record
drum patterns right off the computer keyboard.

Note that when the computer MIDI keyboard is activated, it will �steal� keys that may have
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otherwise been assigned to remote-control elements of the Live interface. To prevent this,
you can turn the computer MIDI keyboard off when it is not needed.

12.3.3 Connecting External Synthesizers

Routing MIDI to an external synthesizer is straightforward: The Output Type chooser is set
to whatever MIDI port the synthesizer is connected to; the Output Channel chooser is used
to select which MIDI channel to send on.

Important: If you are using a keyboard synthesizer both as a master keyboard to play into
Live and as a sound generator, then please make sure to check the synthesizer's �Local
Off� function. Every synthesizer has this function, which effectively separates the keyboard
from the sound generator, allowing you to treat both components as if they were separate
devices. This allows you to use Live as the hub of your MIDI studio, which receives MIDI
from the keyboard and dispatches the incoming MIDI, as well as the MIDI from the clips, as
appropriate.

12.3.4 MIDI In/Out Indicators

Live's Control Bar contains three pairs of indicator �LEDs� that tell you about incoming and
outgoing MIDI. These indicators tell you not only about the presence of signals, but also
about their use. In every pair, the upper indicator �ashes when a MIDI message is received,
and the lower indicator �ashes when a MIDI message is sent.

The Control Bar's MIDI
Indicators.

The three indicator pairs represent:

1. MIDI Clock and Timecode signals that are used for synchronizing Live with other
sequencers;
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2. MIDI messages that are used for remote-controlling Live's user-interface ele-
ments;

3. MIDI messages coming from and going to Live's MIDI tracks.

MIDI messages that are mapped to remote-control Live's user-interface elements are �eaten
up� by the remote-control assignment and will not be passed on to the MIDI tracks. This is
a common cause of confusion that can be easily resolved by looking at the indicators.

12.4 Master and Cue Outs

The Master track is the default destination for audio signals. The Master track, in turn, is
routed to the external audio outputs.

The Cue/Preview Out can be independently routed to allow, for instance, for previewing
samples and cueing tracks via headphones.

12.5 ReWire Slave Routing

Live can send MIDI to, and receive audio from, any ReWire slave application installed on
the same computer.
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An Audio Track
Receiving Audio From
and a MIDI Track
Sending MIDI to Reason.

The following example shows how to send MIDI from one of Live's MIDI tracks into an
instrument within Propellerhead's Reason, and then route the audio result back into an
audio track:

1. First, start Live.

2. Then, start Reason and set up the Reason rack as desired.

3. Select �Reason� from the MIDI track's Output Type chooser.

4. The Output Channel chooser presents you with a list of the instruments that you
currently have in your Reason rack; select the instrument you want to address.

5. Select �Reason� from the audio track's Input Type chooser.

6. From the audio track's Input Channel chooser, select the audio channel that
corresponds to the instrument to which you are sending MIDI.

7. Set the audio track's Monitor radio button to �In.�
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8. Select �All Ins� from the MIDI track's Input Type chooser.

9. Arm the MIDI track.

Now, any MIDI that you are playing into Live will arrive in Reason, which will generate the
corresponding audio back into the audio track, ready for further processing in Live's mixer
and effects. If you want to continue work on the project without reopening Reason, simply
record Reason's audio by arming the audio track and engaging Record Mode.

12.6 Resampling

Live's Master output can be routed into an individual audio track and recorded, or resampled.
Resampling can be a fun and useful tool, as it lets you create samples from what is currently
happening in a Live Set that can then be immediately integrated. It can be used to record
tracks that include processor-intensive devices, so as to delete the devices, or for quickly
previewing before rendering to disk.

The �Resampling� option in any audio track's Input Type chooser will route the Master
output to that track. You can then decide on what exactly you will be resampling and mute,
solo or otherwise adjust the tracks that are feeding the Master output. You will probably
want to use the Master Volume meter to make sure that your level is as high as possible
without clipping (indicated by red in the meter). Then you can arm the track and record into
any of its empty clip slots. Note that the recording track's own output will be suppressed
while resampling is taking place, and will not be included in the recording.

Samples created by resampling will be stored in the Live Set's Sounds folder.
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12.7 Internal Routings

Live allows for inter-track routings. These routings, albeit potentially confusing, enable many
valuable creative and technical options. Inter-track routing can work two ways:

1. Track A is set up to send its output signal to Track B. This is possible because
every track that can receive an output signal of the appropriate type from Track
A shows up in its Output Type chooser.

2. Track B is set up to receive its input signal from Track A. This works because every
track that delivers a signal of the appropriate type appears in Track B's Input Type
chooser.

Two Ways to Route Track
A into Track B.

Both approaches result in Track A's output being fed into Track B. Approach 1 leaves Track
B's in/out settings alone, and we can, at any time, add more tracks that feed their output
into Track B. This is the method of choice for �many-to-one� routings such as submixes or
several MIDI tracks playing the same instrument.

Approach 2, on the other hand, leaves Track A unaffected except for Track B tapping its
output. We can easily add more tracks like Track B that all tap Track A's output. Instrument
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layering is a good example of such a �one-to-many� routing setup.

The rest of this section presents internal routing examples in more detail.

12.7.1 Post-Effects Recording

Let's say that you are feeding a guitar into Live, building up a song track by track, overlaying
take onto take. It is certainly powerful to have a separate effects chain per track for applying
different effects to different takes � after the fact. You might, however, want to run the guitar
signal through effects (a noise gate or an amp model, for instance) before the recording
stage, and record the post-effects signal.

An Example Setup for
Pre-Effects Recording.

This is easily accomplished by devoting a special audio track for processing and monitoring
the incoming guitar signal. We call this track �Guitar� and drag the desired effects into its
device chain. We do not record directly into the Guitar track; instead we create a couple
more tracks to use for recording. Those tracks are all set up to receive their input from the
Guitar track.

As for monitoring, we set the Guitar track's Monitor radio button to In, because we always
want to listen to our guitar through this track, no matter what else is going on in Live. The
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other tracks' Monitor radio buttons are set to Off.

12.7.2 Recording MIDI as Audio

When working with MIDI and complex software instruments, it is sometimes more useful
to record the resulting audio than the incoming MIDI. A single MIDI note can prompt, for
example, Native Instruments' Absynth to produce something that sounds more like a piece
of music than a single tone. This output lends itself more to representation as an audio
waveform than a single note in a MIDI clip, particularly when comparing the editing options.

Recording the Output of
a Complex Instrument in
Audio Tracks.

A setup similar to the one described above accomplishes the task. We have one MIDI track
hosting the virtual instrument, and we use additional audio tracks to record the audio result
of playing the instrument.
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12.7.3 Creating Submixes

Submixing the Individual
Drums of a Drum Kit.

Suppose we have the individual drums of a drum kit coming in on separate tracks for
multitrack recording. In the mix, we can easily change the volumes of the individual drums,
but adjusting the volume of the entire drum kit against the rest of the music is less convenient.
Therefore, we add a new audio track to submix the individual drums. The drum tracks are
all set to output to the submix track, which outputs to the Master. The submix track gives
us a handy volume control for the entire drum kit.

12.7.4 Several MIDI Tracks Playing the Same Instrument

Consider a MIDI track containing a virtual instrument � a Simpler playing a pad sound, for
example. We have already recorded MIDI clips into this track when we realize that we would
like to add an independent, parallel take for the same instrument. So we add another MIDI
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track. We could now drag another Simpler into the new track, but we would really like to
reuse the Simpler from the pad track, so that changing the pad's sound affects the notes
from both tracks.

Feeding an Additional
MIDI Track Into an
Existing MIDI Track to
Reuse its Instrument.

This is accomplished by setting the new MIDI track's Output Type chooser to �Pad.� Note
that the Output Channel chooser now offers a selection of destinations: We can either feed
the new track's output into the input of the pad track, or we can directly address the Simpler.
The �Track In� option in the Output Channel represents the pad track's input signal (the
signal to be recorded), which is not what we want. We instead select �Simpler Ch. 1� to
send the new track's MIDI directly to the Simpler, bypassing the recording and monitoring
stage. With this setup, we can choose to record new takes on either track and they will all
play the same pad sound.
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The Instrument Has
Been Isolated in a
Dedicated Track.

We might be bothered by the fact that muting the pad track (by turning off its Activator
switch) also mutes the other MIDI track. To be precise, the other track keeps playing, but its
MIDI is played by an instrument that is out of the mix. This can be easily remedied by cutting
the clips from the pad track and pasting them into a third track that can be independently
muted (and that can hold its own MIDI effects). The original pad track now acts as a mere
instrument container. As we are not recording new clips into this track, we can set its Input
Type chooser to �No Input,� which makes its Arm button disappear and helps to avoid
confusion when the mixer's In/Out section is hidden.

12.7.5 Tapping Individual Outs From an Instrument

Some software instruments, like Live's Impulse percussion sampler, offer multiple audio
outputs for the signals they produce. By default, Impulse mixes the output of its eight
sample slots internally and delivers the mix at the instrument's audio out. Any audio effects
following Impulse in the same track process the composite signal. Sometimes it is desirable
to take an individual drum sound out of the mix for individual effects processing and mixing.
This is possible because Impulse offers its sample slots as audio sources to other tracks.
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Using Impulse's
Individual Outs to
Separately Process
Sample Slots.

We simply create an audio track and select from its Input Type chooser the track with the
Impulse. The Input Channel chooser now offers, in addition to �Track Out� (the audio signal
at the end of the track's device chain), Impulse's eight individual outputs, labeled according
to the sample used in each slot. Notice that routing an individual output from Impulse
into another track automatically takes this signal out of Impulse's own internal mix. This
convenience is not standard behavior of most plug-in instruments, however.

12.7.6 Using Multi-Timbral Plug-In Instruments

Many plug-in instruments support multi-timbral operation. A multi-timbral instrument is like
several instruments in one, with each component �part� (or whatever term the manufacturer
uses) receiving MIDI on a separate MIDI channel. Usually, the multi-timbral instrument
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offers individual outputs so that the parts can be separately routed into the mixer. Or, the
instrument might offer a submixer of its own.

Tracks Feeding MIDI to
and Tapping Audio
From the Parts of a
Multi-Timbral
Instrument.

Sending MIDI to a multi-timbral instrument is a variation of a case described above. One
MIDI track hosts the multi-timbral instrument, and additional MIDI tracks are used to feed
its individual parts. Each additional MIDI track has its Output Type chooser pointed to the
track that contains the instrument, and its Output Channel chooser referencing the target
MIDI channel. Additional audio tracks can then be used to tap the instrument's individual
outputs, as described earlier.

12.7.7 Feeding Sidechain Inputs

Some effects have so-called �sidechain inputs.� A vocoder, for instance, imposes spectral
characteristics taken from one signal (say, spoken word) onto another signal, for instance a
string pad. The vocoder is inserted as an audio effect into the string track. It has a sidechain
input for the speech signal, which has to be delivered from another track. So, we create an
additional audio track named �Speech� and set its Output Type chooser to the �Strings�
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track. From the Output Channel chooser, we select the vocoder's sidechain input.

Routing a Speech Signal
Into a Vocoder's
Sidechain Input.

Some vocoder plug-ins include a built-in synthesizer to generate the �carrier� signal. In
this case, the only difference from the above procedure is that the vocoder instrument is
dragged into a MIDI track. Feeding the side-chain audio input works as described above.

12.7.8 Layering Instruments

Suppose that we have a MIDI track containing an instrument playing a string sound, which
we would like to �lubricate� by adding a brass sound playing the same notes. This can be
easily done by adding a MIDI track that contains an instrument playing the brass sound and
setting its Input Type chooser to tap the string track's output signal.
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Using an Auxiliary MIDI
Track to Layer
Instruments.

Perhaps you wonder why this works, given that the string track's output is audio and not
MIDI. When routing MIDI in from another track, we are tapping the MIDI at the latest possible
stage, which is just before the instrument.



Chapter 13

Mixing

13.1 The Live Mixer

Live includes a mixer section that is accessible from two views:

169
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The Arrangement View
Mixer.

In the Arrangement View, the mixer appears as a horizontal strip to the right of the track
area. To display all mixer controls for a track, unfold the track using the triangular button
next to its name, and adjust its height accordingly.

The Session View Mixer.

The Session View is a standard vertical mixer layout. You'll likely �nd the Session View mixer
more intuitive than the Arrangement mixer, which comes in handy when you work with
automation. Note that the Tab key toggles between the Arrangement and Session Views.

The View menu options listed below show or hide mixer components. You can use different
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mixer view setups in the Session View and in the Arrangement View:

� In/Out

� Sends

� Returns

� Mixer

� Track Delays

� Crossfader

The Mixer Section selector on the right-hand side of the screen makes it possible to quickly
show or hide different mixer components.

The Mixer Section
Selector.

Let's look at the mixer controls:

1

2
1

3

6

5

4

4 5 6
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The Mixer Controls.
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1. The Meter shows the track's RMS (average) and peak output level. While moni-
toring, however, it shows the input level.

2. The Volume control adjusts the track's output level.

3. The Pan control positions the track's output in the stereo �eld. To reset the pan
control to center, click on the little triangle.

4. To mute the track's output, turn off the Track Activator switch.

5. The Solo switch solos the track by muting all other tracks, but can also be used
for cueing. Tracks can only be soloed one at a time unless the Exclusive Solo
option in the Misc Preferences is deactivated. Alternatively, you can hold down
the Ctrl (PC) / (Mac) modi�er to solo more than one track.

6. If the Arm Recording button is on, the track is record-enabled. Tracks can only
be armed one at a time unless the Exclusive Arm option in the Misc Preferences
is deactivated. Alternatively, you can hold down the Ctrl (PC) / (Mac)
modi�er to arm more than one track.

13.2 Audio and MIDI Tracks

Audio and MIDI tracks in Live are for hosting and playing clips, as explained earlier.

You can add new audio and MIDI tracks to your Live Set's mixer at any time using the
appropriate Insert menu commands.

Tracks can also be created by double-clicking or pressing Return on �les in the Browser to
load them, or by dragging objects from the Browser into the space to the right of Session
View tracks or below Arrangement View tracks. Devices or �les loaded into Live in this
manner will create tracks of the appropriate type (e.g., a MIDI track will be created if a MIDI
�le or effect is dragged in).
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A track is represented by its track title bar. You can click on a track title bar to select the
track and then execute an Edit menu command, such as �Rename,� on the track. One can
quickly rename a series of tracks by executing this command and then using the Tab key to
move from title bar to title bar.

Tracks are Represented
by Track Title Bars.

You can drag tracks by their title bars to rearrange them, or click and drag on their edges to
change their width (in the Session View) or height (in the Arrangement View).

Tracks are deleted using the Edit menu's Delete command.

13.3 Return Tracks and the Master Track

In addition to tracks that play clips, a Live Set has a Master track and up to twelve return
tracks; these cannot play clips, but allow for more �exible signal processing and routing.

The return tracks and the Master track occupy the right-hand side of the Session mixer view
and the bottom end of the Arrangement View.

Note that you can hide and show the return tracks using the Returns command in the View
menu.

Like the �normal� clip tracks, the returns and the Master can host any number of effects.
However, whereas a clip track's effect processes only the audio within that track, return tracks
can process audio sent to them from numerous tracks.

For example, suppose you want to create rhythmic echoes with a delay effect. If you drag
the effect into a clip track, only clips playing in this track will be echoed. Placing this effect
in a return track lets it receive audio from any number of tracks and add echoes to them.
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The Send Controls and
Pre/Post Toggle.

A clip track's Send control regulates how much of the clip track's output feeds the associated
return track's input. What's more, even the return track's own output can be routed to its
input, allowing you to create feedback. Please use this feature with care, as runaway
feedback can boost the level dramatically and unexpectedly.

Every return track has a Pre/Post toggle that determines if the signal a clip track sends to
it is tapped before or after the mixer stage (i.e., the pan, volume and track-active controls).
The �Pre� setting allows you to create an auxiliary mix that is processed in the return track,
independently of the main mix. As the return track can be routed to a separate output, this
can be used to set up a separate monitor mix for an individual musician in a band.

The Master track is the default destination for the signals from all other tracks. Drag effects
here to process the mixed signal before it goes to the master output. Effects in the Master
track usually provide mastering-related functions, such as compression and/or EQ.

You can create multiple return tracks using the Insert menu's Insert Return Track command,
but by de�nition, there is only one Master track.

13.4 Using Live's Crossfader

Live includes a crossfader that can create smooth transitions between clips playing on
different tracks. Live's crossfader works like a typical DJ-mixer crossfader, except that it
allows crossfading not only two, but any number of tracks � including the returns.
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The crossfader is accessed via the Session View mixer.

The Crossfader.

The crossfader is a horizontal slider that can be mapped to any continuous MIDI controller
(absolute or incremental). In addition to the crossfader's central slider, its absolute left and
right positions are separately available for MIDI or keyboard mapping. There are two special
scenarios for remote control with respect to the crossfader:

� A key mapped to any one of the three assignable crossfader positions (left, center or
right) will toggle the crossfader's absolute left and right positions.

� Mapping to two of the three �elds allows for a �snapping back� behavior when one
of the assigned keys is held down and the other is pressed and released.

A Track's Crossfade
Assign Buttons.

Each track has two Crossfade Assign buttons, A and B. The track can have three states with
respect to the crossfader:

� If neither Assign button is on, the crossfader does not affect the track at all.
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� If A is on, the track will be played unattenuated as long as the crossfader is in the left
half of its value range. As the crossfader moves toward the right across the center
position, the track fades out. At the crossfader's rightmost position, the track is muted.

� Likewise, if B is on, the track's volume will be affected only as the crossfader moves
left across its center position.

It is important to understand that the Crossfade Assign buttons do not affect the signal
routing: The crossfader merely in�uences the signal volume at each track's gain stage. The
track can be routed to an individual output bus regardless of its crossfade assignment. In
studio parlance, you can think of the crossfader as an on-the-�y VCA group.

As with almost everything in Live, your crossfading maneuvers can be recorded into the
Arrangement for later in-depth editing. To edit each track's crossfade assignment, please
choose �Mixer� from the Envelope Device chooser and �X-Fade Assign� from the Control
chooser. The crossfader's automation curve is accessible when �Mixer� is chosen from the
Master track's Device chooser and �Crossfade� is selected from its Control chooser.

13.5 Soloing and Cueing

By default, soloing a track simply mutes all other tracks. The signal from the soloed tracks
is heard through their respective outputs, with the pan setting of each track preserved.
Soloing a clip track leaves the return tracks unaffected (solo in place). Soloing a return track
affects all other tracks.

Live allows you to replace the standard soloing operation with a cueing operation that lets
you preview tracks as though you were cueing a record on a DJ mixer. This allows choosing
clips and adjusting effects without the audience hearing, before bringing tracks into the mix.

In order to set Live up for cueing, you must be using an audio interface with at least four
dedicated outputs (or two dedicated stereo outputs). The respective settings are accessible
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in the Session View mixer. Make sure you have �Mixer� and �In/Out� checked from the
View menu.

124 35

The Cueing-Related
Session Mixer Controls.

1. The Master Out chooser selects the output on your interface to be used as the
main output.

2. The Cue Out chooser selects the output on your hardware interface to be used
for cueing. This has to be set to an output other than that selected for the Master.
If the desired outputs don't show up in these choosers, please check the Audio
Preferences.

3. Activate cueing by setting the Solo/Cue Mode switch to �Cue.�

4. The tracks' Solo switches are now replaced by Cue switches with headphone
icons. When a track's Cue switch is pressed, that track's output signal will be
heard through the output selected in the Cue Out chooser. Note that the Track
Activator switch on the same track still controls whether or not the track is heard
at the Master output.

5. The Cue Volume control adjusts the volume of the cueing output.
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Note that when cueing is set up and activated, the output of audio �les that you are
previewing in the Browser is also heard through the Cue Out.

13.6 Track Delays

A Track Delay control is available for every track in Live. The control allows delaying or pre-
delaying the output of tracks in milliseconds in order to compensate for human, acoustic,
hardware and other real-world delays.

This section of the interface can be shown or hidden using its respective Mixer Section
selector.

The Track Delay Control
and Selector.

We do not recommend changing track delays on stage, as it could result in undesirable
clicks or pops in the audio signal. Micro-offsets in Session View clips can be achieved using
the nudge buttons in the Clip View, however track delays can be used in the Arrangement
View for such offsets.

Note that delay compensation for plug-ins and Live devices is a separate feature, and is
automatic by default. Unusually high Track Delay settings or reported latencies from plug-
ins may cause noticeable sluggishness in the software. If you are having latency-related
dif�culties while recording and playing back instruments, you may want to try turning off
device delay compensation, however this is not normally recommended. You may also �nd
that adjusting the individual track delays is useful in these cases. Note that the Track Delay
controls are unavailable when device delay compensation is deactivated.



Chapter 14

Recording New Clips

This chapter is about recording new clips from audio and MIDI input signals. Note that this
is a different kind of recording than the capturing of Session clips into the Arrangement.

For successful audio recording, please make sure the audio preferences are set up properly.
For more on this, please see the built-in program lesson on setting up Audio Preferences.
Also, keep in mind that devices such as microphones, guitars and turntables do not operate
at line level, meaning that they will need to have their levels boosted before they can be
recorded. For these devices, you must therefore use either an audio interface with a preamp,
or an external preamp.

179
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14.1 Choosing an Input

A track will record whatever input source is shown in its In/Out section, which appears when
the View menu's �In/Out� option is checked. (In the Arrangement View, unfold and resize
the track in order to completely see the In/Out section.)

The Track In/Out Section
in the Arrangement
(Top) and Session View
(Bottom).

Audio tracks default to recording a stereo signal from the external input pair �1/2.� MIDI
tracks default to recording all MIDI that is coming in through the active external input
devices. The computer keyboard is, by default, activated as a pseudo-MIDI input device,
allowing you to record MIDI even if no MIDI-controller hardware is currently available.
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For every track, you can choose an input source other than the default: any mono or stereo
external input, a speci�c MIDI channel from a speci�c MIDI-in device, audio from ReWire
slave programs or a signal coming from another track. The Routing chapter describes these
options in detail.

14.2 Arming (Record-Enabling) Tracks

Track Arm Buttons in the
Session (Left) and
Arrangement (Right)
Mixers.

To select a track for recording, click on its Arm button. It doesn't matter if you click a track's
Arm button in the Session View or in the Arrangement View, since the two share the same
set of tracks.

By default, armed tracks are monitored, meaning that their input is passed through their
device chain and to the output, so that you can listen to what is being recorded. This
behavior is called �auto-monitoring� and you can change it to �t your needs.

Clicking one track's Arm button unarms all other tracks unless the Ctrl (PC) / (Mac)
modi�er is held. Arming a track selects the track so you can readily access its devices in the
Track View.
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14.3 Recording

Recording can be done in both the Session and the Arrangement Views. If you want to
record onto more than one track simultaneously and/or prefer viewing the recording linearly
and in-progress, the Arrangement View may be the better choice. If you want to break your
recording seamlessly into multiple clips or record while you are also launching clips in Live,
use the Session View.

14.3.1 Recording Into the Arrangement

1 23

4 5

6

Recording Into the
Arrangement.

1. Recording commences when the Control Bar's Record button is activated and
the Play button is pressed.

2. Recording creates new clips in all tracks that have their Arm button on.
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3. When the Overdub switch is on, the new clips contain a mix of the signal already
in the track and the new input signal. The Overdub option only applies to MIDI
tracks.

4. To prevent recording prior to a punch-in point, activate the Punch-In switch. This
is useful for protecting the parts of a track that you do not want to record over
and allows you to set up a pre-roll or �warm-up� time. The punch-in point is
identical to the Arrangement Loop's start position.

5. Likewise, to prevent recording after the punch-out point, activate the Punch-Out
switch. The punch-out point is identical to the Arrangement Loop's end position.

6. When you are recording into the Arrangement Loop, Live retains the audio
recorded during each pass.

You can later �unroll� a loop recording, either by repeatedly using the Edit menu's Undo
command or graphically in the Clip View: After loop recording, double-click on the new clip.
In the Clip View's Sample Display, you can see a long sample containing all audio recorded
during the loop-recording process. The Clip View's loop brace de�nes the audio taken in
the last pass; moving the markers left lets you audition the audio from previous passes.

14.3.2 Recording Into Session Slots

You can record new clips, on the �y, into any Session slots.
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34 12

Recording a New Clip
Into the Session View.

1. Set the Global Quantization chooser to any value other than �None� to obtain
correctly cut clips.

2. Activate the Arm button for the tracks onto which you want to record. Clip
Record buttons will appear in the empty slots of the armed tracks.

3. Click on any of the Clip Record buttons to commence recording. A new clip
will appear in the slot with a red Clip Launch button that shows it is currently
recording. To go from recording immediately into loop playback, press the clip's
Launch button.

4. Alternatively, you can click a Clip Stop button or the Stop button in the Control
Bar to stop recording, leaving the new clip silent.

Note that, by default, launching a Session View scene will not activate recording in empty
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record-enabled slots belonging to that scene. However, you can use the Start Recording on
Scene Launch option from the Misc Preferences to tell Live that you do want empty scene
slots to record under these circumstances.

14.3.3 Overdub Recording MIDI Patterns

Live makes pattern-oriented recording of drums and the like quite easy. Using Live's Impulse
instrument and the following technique, you can successively build up drum patterns while
listening to the result. Or, using an instrument such as Simpler, which allows for chromatic
playing, you can build up melodies or harmonies, note by note.

1. Set the Global Quantization chooser to one bar.

2. To automatically quantize the notes you are about to record, choose an appro-
priate value for Record Quantization.

3. Double-click any of the Session View slots in the desired MIDI track (the one
containing the Impulse or other instrument). A new, empty clip will appear in the
slot. The new clip will default to a loop length of one bar, but you can change
that by double-clicking the clip and changing its loop properties.

4. Arm the track.

5. Launch the clip.

6. The notes you play are added into the looping clip, and you can observe your
recording in the Clip View.

7. By default, the Control Bar's Overdub switch is activated, so that you can build
your pattern layer by layer. However, if you would like to pause recording for a
moment to rehearse, you can deactivate the Overdub switch. The contents of
the clip will continue to play, but you can play along without being recorded.
When you are ready to record again, simply turn on the Overdub switch.
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8. Stop recording by pressing a Clip Stop button or the Stop button in the Control
Bar.

Note that holding Alt (PC) / Alt (Mac) while double-clicking the empty slot to create
a new clip will implicitly arm the track and launch the clip.

At any time while overdub recording is going on, you can use the Undo command to remove
the last take, or even draw, move or delete notes in the Clip View's Note Editor.

Note that you can also add notes to existing Session clips while the Overdub switch is on.

14.4 Recording in Sync

Live keeps the audio and MIDI you have recorded in sync, even when you later decide on a
different song tempo. In fact, Live allows you to change the tempo at any time before, after
and even during recording. You could, for instance, cheat a bit by turning down the tempo
to record a technically dif�cult part, and pull it up again afterwards.

It is important to record in sync to make sure everything will later play in sync.

The Metronome Switch.

The easiest way to record in sync is to play along with or to use the built-in metronome,
which is activated via its Control Bar switch and will begin ticking when the Play button is
pressed or a clip is launched.
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The Preview Volume
Knob.

To adjust the metronome volume, use the mixer's Preview Volume knob.

Notice that Live's metrical interpretation of the audio being played can be edited, at any
time, using the Warp Markers. Warp Markers can be used to �x timing errors and to change
the groove or feel of your recordings. Using Warp Markers, you can �x things in your
recordings that would otherwise require complicated editing or could not be done at all.
Likewise, the metrical interpretation of recorded MIDI can be changed after recording, using
the MIDI clip's Original BPM controls.

14.5 Recording Quantized MIDI Notes

If you will be recording MIDI, you have the option of automatically quantizing MIDI notes
while recording. The Record Quantization chooser in the Edit menu allows selecting the
meter subdivisions with which your recorded notes will align. When recording into Session
slots or into the Arrangement, record quantization is an independent step in Live's Undo
history. This means that if, for example, you recorded with Record Quantization set to
�Eighth Note Triplet Quantization� and then changed your mind, using the Edit menu's
Undo command would undo only the quantization and leave your recording otherwise
intact.

For Session and Arrangement recording, the Record Quantization setting cannot be changed
mid-recording.
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When overdub recording with the Clip View Loop activated, changes to the Record Quan-
tization take effect immediately, and they cannot be separately undone with the Edit menu
command.

Recorded MIDI notes can also be quantized post-recording with the Edit menu's Quantize
command, as described in the chapter on editing MIDI.

14.6 Recording with Count-in

A count-in for recording can be set in Live's Misc Preferences. When the Count-In preference
is set to any value other than �None,� Live will not begin recording until the count-in is
complete. The Arrangement Position �elds in the Control Bar display the count-in in orange
as bars-beats-sixteenths.

The Count-In is
Displayed in the Control
Bar.

The count-in runs from negative bars-beats-sixteenths (beginning at -2.1.1., for example,
with a Count-In setting of 2 bars) up to 1.1.1., at which point recording commences.

Note that count-in recording does not apply when Live is synced to external MIDI devices
or being used as a ReWire slave.

14.7 Setting up File Types

The following Misc Preferences are relevant to the sample �les that are created by recording:
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� The sample �le type you would like Live to create can be chosen from the Record File
Type chooser in the Misc Preferences.

� The bit depth of the sample �le you will create by recording can be chosen from the
Record Bit Depth chooser in the Misc Preferences.

� The Audio Record Folder selected in the Misc Preferences is the disk location where
Live will put the samples you record into an unnamed Live Set. When the Live Set is
saved, Live will attempt to move (space permitting) all samples from the temporary
record folder to the saved Live Set's Sounds folder.

You can save time by setting up reasonable defaults for the clips you are recording in the
Defaults Preferences tab. In particular, it is smart to indicate the rough category of sound
to be recorded by choosing the appropriate default Warp Mode. If you decide later on a
different song tempo, the program will automatically maintain good sound quality, usually
without further adjustment.

14.8 Using Remote Control for Recording

Using Key Map Mode and MIDI Map Mode, you can operate Live's recording functions
without using the mouse.

You can map the Control Bar's Record and transport controls as well as the track Arm buttons.
For recording into the Session slots, you can map the individual slots as well as the relative
navigation controls to initiate recording remotely; for instance:

The Scene Up/Down
Buttons.



14.8. USING REMOTE CONTROL FOR RECORDING 190

One key is used to jump to the next scene...

A Track Launch Button.

... and another key to start and end recording in the respective track.



Chapter 15

Working with Instruments and
Effects

Every track in Live can host a number of devices. These devices can be of three different
sorts:

� MIDI effects act upon MIDI signals and can only be placed in MIDI tracks.

� Audio effects act upon audio signals and can be placed in audio tracks. They can also
be placed in MIDI tracks as long as they are �downstream� from an instrument.

� Instruments are devices that reside in MIDI tracks, receive MIDI and output audio.

191
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Devices in the Track
View.

The Track View is where you insert, view and adjust the devices for the selected track. To
select a track and open the Track View to access its devices, double-click the track's name.
The Track View appears in the bottom area of the Live screen.
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15.1 Using the Live Devices

The Live Device Browser
Selector.

Click on the Live Device Browser selector to access the palette of Live's built-in devices. You
will notice that MIDI effects, audio effects and instruments each have their own folders in
the Browser.

To place one instance of a device in a track, click on the desired device and drag it into the
Track View of an appropriate track. You can also select a track by clicking on its title bar,
then double-click or press Return on a device in the Browser to add it to the selected track.

Note: If you are using an external input signal to feed your Live track using the default
settings, you will need to activate the track's Arm button in the mixer in order to hear the
input through the devices in your track's device chain. This is how you would play live
instruments through effects on a track, for example, or use a MIDI keyboard's input to play
a track's instrument. Note that you can easily move from this setup into recording new
clips for further use in Live. If you have alternative monitoring preferences, please see the
appropriate manual section for information on how to make these settings.
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MIDI and Audio Track
Arm Buttons

Play with the device's controls to change the result, or get more �hands-on� by assigning
device controls to MIDI or key remote control. To learn what a device does and how to
operate it, consult the Live Audio Effect Reference chapter, Live MIDI Effect Reference
chapter or the Live Instrument Reference chapter.

To add another device to the track, simply drag it there or double-click its name to append
it to the device chain. Signal processing travels from left to right on the track.

� You can drop audio effects in at any point in an audio track's device chain, keeping
in mind that the order of effects determines the resulting sound, as effects on the left
will pass altered signals on to those on the right.

� The above also applies to a MIDI track's device chain.

� If you drop an instrument into a MIDI track's device chain, signals following (to the
right of) the instrument are now audio signals, available only to audio effects. Signals
preceding (to the left of) the instrument are available only to MIDI effects. This means
that it is possible to have a MIDI track device chain consisting of all three types of
devices: �rst a MIDI effect, then an instrument, and �nally an audio effect.
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A MIDI Track's Device
Chain Can Contain All
Three Device Types.

To remove a device from the chain, click on the name and either press your computer's
Delete or Backspace key, or select Delete from the Edit menu. To change the order of
devices, drag a device by its name and drop it between any of the other devices in the Track
View, or drag it onto another track in the mixer to place the device in that track. Generally,
devices can be placed, reordered and deleted without interrupting the audio stream.

A Device Activator
Switch.

Devices can be turned on and off using their Activator switches. Turning a device off
is like temporarily deleting it: The signal remains unprocessed, and the device does not
consume CPU cycles. Live devices generally do not load down the CPU unless they are
active. For more information, please refer to the CPU load section. Note that the Freeze
Track command mentioned in the CPU load section is especially helpful when working with
CPU-intensive devices.

Devices in Live's tracks have input and output level meters. These meters facilitate �nding
a problematic device in the device chain: Low or absent signals will be apparent in the level
meters between devices, and relevant device settings can then be adjusted, or the device
can be turned off or removed. Note that no clipping can occur between devices because
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there is practically unlimited headroom. Clipping can occur when an overly strong signal is
sent to a physical output or written to a sample.

Further information about track types in Live can be found in the Routing and I/O chapter,
including information on using return tracks to distribute the effect of a single Live device
amongst several tracks. After reading about using devices in Live, it might also be interesting
look into clip envelopes, which can modulate individual device settings on a per-clip basis.

15.1.1 Live Device Presets

Every Live device can store and retrieve particular sets of parameter values as presets.

Browsing and Loading Presets

Presets for Live instruments and effects are managed through the Live Device Browser. Each
device in the Browser appears as a folder that can be opened to reveal its presets.

Presets in the Device
Browser.
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You can browse and load presets quickly with the computer keyboard:

� Scroll up and down using the and keys.

� Close and open device folders using the and keys.

� Use (PC) / Ctrl (Mac) to access the context menu, and then select the Close
All Folders option to show only top-level folders. Double-clicking the Device Browser
icon will also close all sub-level folders.

� Press Return to load a device or preset.

The Browse Presets
Button.

Clicking the Browse Presets button will temporarily link the Browser to a device, bringing
up the relevant presets in the Browser. With the device and Browser linked in this manner,
you can quickly browse, load and audition different presets. You can even load a different
device to replace the current one by selecting one of the new device's presets from the
Browser and pressing Return . To load a device's default factory settings, select the parent
folder of its presets (i.e., the one with the device's name) from the Device Browser.

The link between the Device Browser and the device will be broken when a different Live
view is selected, or when the Browse Presets button is again pressed.

Note that although importing via the Browser is the recommended method, presets can
also be dropped directly into Live from the Explorer (Windows) / Finder (Mac).
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Saving and Organizing Presets

You can create and save any number of your own presets in the Device Browser.

The Preset Save Button.

Click the Preset Save button to save a new preset. You can then con�rm Live's suggested
name or type in one of your own.

Note that a preset with unsaved changes is shown in the Device Browser with an asterisk
next to its name.

Presets can be organized in the Browser in a manner similar to �les:

� They can be put in sub-folders with the aid of the (PC) / Ctrl (Mac) context
menu's Create Folder command.

� Presets can be moved to different folders within their device's folder by dragging and
dropping, or by copying/cutting and pasting.

� Presets can be renamed using the Edit menu's Rename command or the Ctrl R

(PC) / R (Mac) shortcut.

� To delete a preset, select it and press your computer's Delete key, or use the respective
Edit menu command.
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Searching for Presets

Live's search function is available in the Device Browser to help with �nding presets by name.

Opening Search Mode
in the Device Browser.

Clicking the Search button in the upper right corner of the Device Browser or using the
Ctrl F (PC) / F (Mac) shortcut will open the Browser's Search Mode.

Live will search for the contents typed in the Search �eld throughout the Device Browser.
After entering search criteria, begin the search by pressing Return on your computer key-
board.

You can abort an in-progress search with the Exit Search button located to the right of the
Search �eld. A second click on this button closes Search Mode, returning the Browser to
Browse Mode. Beginning a new search aborts any current searches by default.

Exiting Search Mode.

A useful feature of Live's Browser search function is the Locate In Browser button, found to
the right of the Search �eld. After �nding a particular preset in Search Mode, you can select
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it and click this button to open the preset in Browse Mode, where its location in the folder
hierarchy will be displayed.

The Locate In Browser
Button.

15.1.2 Device Groups

Device groups allow you to save powerful multi-device creations, effectively adding all the
capabilities of Live's MIDI and audio effects to Simpler, Impulse and Operator presets.

To create a device group, multi-select any number of devices in the Track View by -
clicking on their title bars. Then, select the Edit menu's Group Devices command, use the

Ctrl G (PC) / G (Mac) shortcut, or select �Group Devices� from the (PC) /
Ctrl (Mac) context menu. The devices will �melt� into one new device.



15.2. USING PLUG-INS 201

A Device Group in the
Track View.

The entire device group, along with its component device settings, can be stored as a preset
by clicking its Preset Save button and typing a new name in the Device Browser. Groups
containing an instrument are stored with the respective instrument in the Device Browser;
groups without an instrument appear in the �MIDI Effect Groups� or �Audio Effect Groups�
folders.

Device groups can be browsed, loaded, organized, searched and used just like single-device
presets.

Devices can be ungrouped via the Ungroup Edit menu command, Ctrl G (PC) / G

(Mac) shortcut or respective (PC) / Ctrl (Mac) context menu command.

15.2 Using Plug-Ins

The collection of devices that you use in Live can be extended with plug-ins. Live supports
Steinberg Media's VST Plug-ins and Apple Computer's Audio Units Plug-ins (Mac OS X only).
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Working with VST and Audio Units Plug-ins is very much like working with Live devices. VST
and Audio Units instruments can only be placed in Live MIDI tracks and, like Live instruments,
they will receive MIDI and output audio signals. Plug-in audio effects can only be placed in
audio tracks or following instruments. Please see the section on working with Live devices
for general information about working with devices in Live.

The Plug-In Device
Browser and Selector.

Audio Units and VST Plug-ins are browsed and imported using the Plug-In Device Browser,
which is accessed via its selector. Plug-in instruments can be differentiated from plug-in
effects in the Browser, as they appear with a keyboard icon.

The Browser's search functionality is only available for Audio Units Plug-ins, as is loading
presets directly from Track View devices via the Browse button. In some instances, factory
presets for Audio Units will only appear in the Browser once the device has been placed in
a track and its Browse button activated.

Note: The �rst time you start Live, no plug-ins will appear in the Plug-In Device Browser,
as you must �rst �activate� your plug-in sources. Activating your plug-in sources tells Live
which plug-ins you want to use and where they are located on your computer. Information
on activating (and deactivating) plug-in sources can be found later in this chapter, by plug-in
type, in the sections on the VST Plug-in folder and Audio Units Plug-ins.
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If you install/de-install a plug-in while the program is running, Live will not detect your
changes or implement them in the Plug-In Device Browser until the next time you start the
program. Use the Re-Scan button in the Plug-In Preferences to re-scan your plug-ins while
Live is running, so that newly installed devices become immediately available in the Plug-In
Device Browser.

Hint: You can also use Re-Scan if you believe that your plug-in database has somehow
become corrupted. Holding down the Alt (PC) / Alt (Mac) modi�er while pressing
Re-Scan will delete your plug-in database altogether and run a clean scan of your plug-ins.

15.2.1 Plug-Ins in the Track View

A VST Plug-In in the
Track View.

Once a plug-in is dragged from the Browser into a track, it will show up in the track's Track
View. The original plug-in panel graphics will be replaced with a Live panel, which will
usually represent all of the plug-in parameters accurately and completely, unless they are
simply too numerous or are not modi�able in real time. When this is the case, the plug-in's
original editor panel can be opened in a separate window.
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The Plug-In Unfold
Button.

You can view or hide the VST Plug-in's parameters by toggling the triangle-shaped button
in the plug-in's title bar.

The X-Y control �eld can be used to control two plug-in parameters at once and is therefore
especially well-suited for live control. To assign any two plug-in parameters to the Live panel
X-Y �eld, use the drop-down menus directly beneath it.

Once a plug-in is placed in a track, you can use it just like a Live device:

� You can edit all of its parameters and drag it to different locations in the device chain
or to other tracks, according to the rules of audio effects and instruments.

� You can map MIDI-controller messages to its parameters.

� You can modulate its continuous parameters with clip envelopes.

� You can also use the multiple I/O features of some plug-ins by assigning them as
sources or targets in the routing setup of tracks. See the chapter on routing for details.

15.2.2 Showing Plug-In Panels in Separate Windows

The Plug-In Edit Button.



15.2. USING PLUG-INS 205

The Plug-In Edit button opens a �oating window that shows the original VST or Audio Units
Plug-in panel. Changing parameters on the �oating window has the same effect as changing
them in the Live panel, and vice versa.

There are a few important Plug-In Preference settings for working with plug-in edit windows:

� If activated, the Auto-Open Plug-In Windows Preference assures that plug-in edit
windows open automatically when plug-ins are loaded into tracks from the Browser.

� If the Multiple Plug-In Windows option in the Plug-In Preferences is activated, you can
open any number of plug-in windows at once. Even with this option off, you can hold
down the Ctrl (PC) / (Mac) modi�er when opening a new plug-in window to
keep the previous window(s) from closing.

� Using the Auto-Hide Plug-In Windows preference, you can choose to have Live display
only those plug-in windows belonging to the track that is currently selected.

You can use the View menu's Show/Hide Plug-In Windows command or the Ctrl P (PC)
/ P (Mac) shortcut to hide and show your open plug-in windows. Notice that the
name of the track to which the plug-in belongs is displayed in the title bar of the plug-in
editor window.

Macintosh only: The �oating VST Plug-in editor windows do not receive computer key
strokes. If it is necessary to type into the plug-in window, for instance for entering a serial
number or unlock code, hold down while clicking the Plug-In Edit button. The editor
window will then appear as a �normal� application window, rather than as a �oating window,
and receive your typing. Note that this functionality is intended only as a workaround for a
plug-in limitation. We recommend closing the window after you have �nished typing, then
reopening it normally before working with the plug-in parameters.
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15.2.3 Plug-In Performance Options

The Plug-In Preferences contain a Performance setting for balancing plug-in latency and
performance. Here, you can set the number of samples processed at any one time by the
plug-in. Higher settings may result in a noticeable performance increase but will also result
in higher latencies.

With the �As Audio Buffer� setting selected, the plug-in will calculate the exact number of
samples per millisecond as the computer's sound card. This setting usually means that very
few dropouts or performance problems will occur, especially with DSP cards.

The size of the computer's sound card buffer (i.e., the number of samples it calculates per
millisecond) can be set using the Audio Preferences Buffer Size setting.

15.3 VST Plug-Ins

15.3.1 The VST Plug-In Folder

When you start Live for the �rst time, you will need to activate your VST Plug-in sources
before working with VST Plug-ins. Depending on your computer platform, you may also
have to tell Live about the location of the VST Plug-in folder containing the devices you
want to use. In order to set up your VST sources, press the �Activate� button in the Plug-In
Device Browser, or go to the Plug-In Preferences via the Options menu (or the Live menu in
Mac OS X). There you will �nd the �Active Sources� section.
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Setting up VST Plug-In
Sources for Windows.

For Windows, proceed as follows:

1. Use the VST Plug-In Custom Folder entry to tell Live about the location of your
VST Plug-ins: Click the Browse button to open a folder-search dialog for locating
and selecting the appropriate folder.

2. Once you have selected a VST Custom Folder and Live has scanned it, the path
will be displayed. Note that, on Windows, Live may have found a path in the
registry without the need for browsing.

3. Make sure that the Use VST Plug-In Custom Folder option is set to �On,� so
that your selected folder is an active source for VST Plug-ins in Live. Note that
you can choose not to use your VST Plug-ins in Live by turning off the Use VST
Plug-In Custom Folder option.
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Setting up VST Plug-In
Sources for Mac OS X.

Set up your VST Plug-ins under Mac OS X by doing the following:

1. Your VST Plug-ins will normally be installed in the following folder in your home
and local directories: /Library/Audio/Plug-Ins/VST. You can turn Live's use of
these plug-ins on or off with the Use VST Plug-ins in System Folders option.

2. You may have an alternative folder in which you store your VST Plug-ins (perhaps
those that you use only with Live). You can use VST Plug-ins in this folder in addi-
tion to, or instead of, those in the System folders. To tell Live about the location
of this folder, click the Browse button next to the VST Plug-In Custom Folder
entry to open a folder-search dialog for locating and selecting the appropriate
folder.

3. Note that you can turn off your VST Plug-ins in this folder using the Use VST
Plug-In Custom folder option.

Once you have con�gured your Plug-In Preferences, the Plug-In Device Browser will display
all plug-ins it �nds in the selected VST Plug-in folder(s) as well as any sub-folders.

It is also possible to use VST Plug-ins stored in different folders on your computer. To do this,
create a Mac OS or Windows alias of the folder where additional VST Plug-ins are stored,
and then place the alias in the VST Plug-In Custom folder (or in the VST Plug-In System
folder on Mac OS X) selected in Live's Plug-In Preferences. The alias can point to a different
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partition or hard drive on your computer. Live will scan the set VST Plug-in folder as well as
any alias folders contained therein.

Some VST Plug-ins contain errors or are incompatible with Live. During the scanning process,
these may cause the program to crash. When you re-launching Live, a dialog will appear
to inform you about which plug-in caused the problem. Depending on what Live detects
about the plug-in, you may be given the choice between performing another scan or
making the problematic plug-in unavailable. If you choose to re-scan and they crash the
program a second time, Live will automatically make them unavailable, meaning that they
will not appear in the Plug-In Device Browser and will not be re-scanned again until they are
reinstalled.

15.3.2 VST Programs and Banks

Every VST Plug-in instance �owns� a bank of programs. A program is meant to contain one
complete set of values for the plug-in's controls.

The VST Plug-In
Program Chooser.

To select a program from the plug-in's bank, use the chooser below the title bar. The number
of programs per bank is �xed. You are always working �in� the currently selected program,
that is, all changes to the plug-in's controls become part of the selected program.

Note that VST programs are different from Live device presets: Whereas the presets for a
Live device are shared among all instances and Live Sets, the VST programs �belong� to
this speci�c instance of the VST Plug-in.
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Renaming a VST Plug-In
Program.

To rename the current program, select the VST program chooser and execute the Edit
menu's Rename Plug-In Preset command. Then type in a new program name and con�rm
by pressing Return.

The VST Program/Bank
Load Button (Left) and
The VST Program/Bank
Save Button (Right).

VST programs and banks can be imported from �les. Clicking the VST Program Load button
brings up a standard �le-open dialog for locating the desired �le.

Windows only: Please select from the File Type menu whether you want to locate VST
Device Program �les or VST Device Bank �les.

To save the currently selected program as a �le, click the VST Program/Bank Save button to
bring up a standard �le-save dialog; select �VST Device Program� from the Format menu
(Macintosh) / from the File Type menu (Windows); select a folder and name. For saving the
entire bank as a �le, proceed likewise but choose �VST Device Bank� as a �le type/format.
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15.4 Audio Units Plug-Ins

Audio Units Plug-ins are only available in Mac OS X. In most respects, they operate just like
VST Plug-ins.

An Audio Units Plug-In.

The �rst time you open Live, Audio Units Plug-ins will not appear in the Plug-In Device
Browser. In order to activate your Audio Units as a plug-in source, please press the �Activate�
button in the Plug-In Device Browser, or go to the Plug-In Preferences via the Live menu.
There you will �nd the �Active Sources� section. Turning on the Use Audio Units option
activates Audio Units Plug-ins so that they appear in Live's Plug-In Device Browser.

Note that you can always turn this option off later if you decide not to use Audio Units.
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Activating Audio Units
Plug-Ins.

Audio Units Plug-ins sometimes have a feature that allows choosing between different
modes for the device. You might be able to choose, for example, between different levels
of quality in the rendering of a reverb. Choosers for these device modes can only be
accessed through the original plug-in panel, which is opened using the Plug-In Edit button.

Opening an Audio Units
Plug-In Window.

Audio Units have presets that function just like those for the Live effects. However, some
AU presets cannot be dragged to different locations in the Browser, as they are read-only.

Audio Units presets have an .aupreset extension and are stored in the following directory
according to their manufacturer's name:

[Home]/Library/Audio/Presets/[Manufacturer Name]/[Plug-in Name]
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15.5 Device Delay Compensation

Live automatically compensates for delays caused by Live and plug-in instruments and
effects, including those on the return tracks. These delays can arise from the time taken by
devices to process an input signal and output a result. The compensation algorithm keeps
all of Live's tracks in sync, regardless of what their devices are doing, while minimizing delay
between the player's actions and the audible result.

Device delay compensation is on by default and does not normally have to be adjusted in
any way. However, Live Sets that were created with older versions of Live will open without
device delay compensation. To manually turn latency compensation on (or off), use the
Delay Compensation option in the Options menu.

Unusually high individual track delays or reported latencies from plug-ins may cause no-
ticeable sluggishness in the software. If you are having latency-related dif�culties while
recording and playing back instruments, you may want to try turning off device delay com-
pensation, however this is not normally recommended. You may also �nd that adjusting the
individual track delays is useful in these cases.

Note that device delay compensation can, depending on the number of tracks and devices
in use, increase the CPU load.



Chapter 16

Automation and Editing Envelopes

Often, when working with Live's mixer and devices, you will want the controls' movements
to become part of the music. The movement of a control across the song timeline is called
automation; a control whose value changes in the course of this timeline is automated.
Practically all mixer and device controls in Live can be automated, including the song
tempo.

16.1 Recording Automation

Creating automation is straightforward: All changes of a control that occur while the Control
Bar's Record switch is on become automation. Try recording automation for a control, for
instance a mixer volume slider. After recording, play back what you have just recorded
to see and hear the effect of the control movement. You will notice that a little LED has
appeared in the slider thumb to indicate that the control is now automated. Try recording
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automation for track panning and the Track Activator switch as well; their automation LEDs
appear in their upper left corners.

Volume, Pan and the
Track Activator Switch
Have Been Automated.

16.2 Deleting Automation

To delete automation data, simply select an automated control by clicking on it, and choose
the Edit menu's Delete Automation command. The automation LED disappears, and the
control's value stays constant across the entire song. Note that this will not work with controls
that are switches, like the Track Activator switch, because they cannot be selected by clicking.
You can only delete automation for switches by editing their breakpoint envelopes.

16.3 Overriding Automation

In practice, you will often want to try out new control moves without overwriting existing
automation data. Well, nothing is forever in the world of in�nite Undo, but it's easy to
disable a control's automation temporarily to avoid overwriting existing data: If you change
an automated control's value while not in Record Mode, the automation LED goes off to
indicate the control's automation is inactive. Any automation is therefore overridden by the
current manual setting.
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The Back to
Arrangement Button.

When one or more of the automated controls in your Live Set are not active, the Control
Bar's Back to Arrangement button lights up. This button serves two purposes:

1. It reminds you that the current state of the controls differs from the state captured
in the Arrangement.

2. You can click on it to reactivate all automation and thereby return to the automa-
tion state as it is written �on tape.�

16.4 Drawing and Editing Automation

In the Arrangement View, automation curves can be viewed and edited as breakpoint
envelopes.

15 4 23

An Automation
Envelope in the
Arrangement View.
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1. To access a track's envelope, �unfold� the track by clicking the triangular button
next to the track name.

2. Clicking on one of the track's mixer or device controls will display this control's
envelope.

3. The envelope appears �on top of� the audio waveform or MIDI display. Its
vertical axis represents the control value and the horizontal axis represents time.
For switches and radio buttons, the value axis is discontinuous.

4. The Automation Device chooser either selects the track mixer, one of the track's
devices or �None� to hide the envelope. It also provides you with an overview
of what devices actually have automation by showing an LED next to their labels.

5. The Automation Control chooser selects a control from the device chosen in the
Automation Device chooser. The labels of automated controls have an LED.

16.4.1 Drawing Envelopes

With Draw Mode enabled, you can click and drag to �draw� an envelope curve.

The Draw Mode Switch.

To toggle Draw Mode, select �Draw Mode� from the Options menu, click on the Control
Bar's Draw Mode switch, or press Ctrl B (PC) / B (Mac).



16.4. DRAWING AND EDITING AUTOMATION 218

Drawing an Envelope.

Drawing creates steps as wide as the visible grid, which you can modify using a number
of handy shortcuts. For freehand drawing, you can hide the grid using the Snap to Grid
Options menu entry or the Ctrl 4   (PC) / 4   (Mac) shortcut.

16.4.2 Editing Breakpoints

With Draw Mode off, the envelope display looks and works differently. The line segments
and the breakpoints connecting them become draggable objects. Clicking and dragging in
the envelope's background de�nes a selection. Here is what you can do:

� Double-click at a position on a line segment to create a new breakpoint there.

� Double-click on a breakpoint to delete it.

� Click and drag a breakpoint to move it to the desired location. If the breakpoint you
are dragging is in the current selection, all other breakpoints in the selection will follow
the movement.
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To Move all Breakpoints
Within the Selection,
Drag Any One of Them.

Your movement is constrained by the neighboring breakpoints unless you hold down
the modi�er while dragging, which will eliminate breakpoints as you wipe over
them. Holding down the Ctrl (PC) / (Mac) modi�er while dragging switches
to a �ner resolution.

� Click and drag a line segment between two breakpoints to move it vertically, without
affecting the breakpoint's horizontal position. If the line segment is in the current
selection, the envelope is moved vertically across the selected timespan. Live inserts
breakpoints at the selection's edges to make sure the move only affects the selected
part of the envelope.

Dragging an Envelope
Line Segment Moves the
Segment Vertically.

16.4.3 Locking Envelopes

When moving clips, Live normally moves all automation with the clip. Sometimes, you
might want to lock the envelopes to the song position rather than to the clips, and the
Arrangement View's Lock Envelopes switch does just that.
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You can also choose to lock envelopes from the Options menu.

The Lock Envelopes
Switch.

16.4.4 Edit Menu Commands

There are a number of useful Edit menu commands for editing envelopes.

To cut or copy automation from a track, independent of the associated clip, use the Edit
menu's Cut Envelope and Copy Envelope commands, respectively.

To simultaneously copy and paste a selection of envelope into a track's �future,� use the
Duplicate Envelope command.

Note that Live allows you to copy and paste envelope movements not only from one point
in time to another, but also from one parameter to another. However, there is obviously no
meaningful conversion from a pan movement to, say, an equalizer frequency, and all Live
can do is somehow preserve the gesture.

16.4.5 Editing the Tempo Automation

The ability to dynamically stretch and compress audio to track any tempo or tempo variation
is one of Live's specialties. In Live, the song tempo is just another automated control.

To edit the song tempo envelope, unfold the Master track, choose �Mixer� from the top
envelope chooser and �Song Tempo� from the bottom one.
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The Tempo Envelope.

When adjusting the tempo envelope, you might want to scale the value axis display, which
is the function of the two value boxes below the envelope choosers: The left box sets the
minimum, and the right box sets the maximum tempo displayed, in BPM.

Note that these two controls also determine the value range of a MIDI controller assigned
to the tempo.



Chapter 17

Clip Envelopes

Every clip in Live can have its own clip envelopes. The aspects of a clip that are in�uenced by
clip envelopes change depending upon clip type and setup; clip envelopes can do anything
from representing MIDI-controller data to modulating device parameters. In this chapter,
we will �rst look at how all clip envelopes are drawn and edited, and then get into the details
of their various applications.
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17.1 The Clip Envelope Editor

Use the Clip View Box
Selector to Bring up the
Envelopes Box.

To work with clip envelopes, bring up the Clip View's �Envelopes� box by activating the
rightmost Clip View Box selector panel. The Envelopes box contains two choosers for
selecting an envelope to view and edit.

The Clip View's
Envelopes Box.

The top menu is the Device chooser, which selects a general category of controls with which
to work. Device chooser entries are different for different kinds of clips:
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� Audio clips have entries for �Clip� (the clip's sample controls), every effect in the track's
device chain and the mixer.

� MIDI clips have entries for �MIDI Ctrl� (MIDI-controller data) and every device in the
track's device chain.

The bottom menu, the Control chooser, selects among the controls of the item chosen in
the top menu. In both the Device and the Control chooser, you can easily identify the items
that have a non-neutral clip envelope by a little LED appearing next to their names.

The �quick-chooser� buttons below the menus select commonly edited controls.

Clicking the menus or the quick-chooser buttons brings up the Envelope Editor showing
the selected envelope, instead of the Sample Display or MIDI Editor. You can toggle the
display by clicking on the title bars of the �Sample�/ �Notes� and �Envelopes� boxes.

The techniques for drawing and editing clip envelopes are the same as those for automation
envelopes in the Arrangement View.

If you create a nice section of envelope that you want to have repeat several times, try the
following:

1. Enclose the desired selection in the loop brace, and click the brace so that it is
selected. This will execute the Edit menu's Select Loop command, which selects
all material in the loop.

2. Copy the envelope with Ctrl C (PC) / C (Mac).

3. Shift the loop brace to the right by one loop length with .

4. Paste the envelope with Ctrl V (PC) / V (Mac).

Note that you can use the arrow keys to quickly manipulate the loop brace and start/end
markers in other useful ways to expedite clip envelope editing tasks.

To delete a clip envelope (i.e., to set it back to its default value), �rst go to Edit / Select All,
then to Edit / Delete.
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Let us now look at some uses of clip envelopes.

17.2 Audio Clip Envelopes

Clip envelopes extend Live's �elastic� approach to audio and, in conjunction with Live's
audio effects, turn Live into a mighty sound-design tool. Using clip envelopes with audio
clips, you can create an abundance of interesting variations from the same clip in real time
� anything from subtle corrections to entirely new and unrelated sounds.

17.2.1 Clip Envelopes are Non-Destructive

Using clip envelopes, you can create new sounds from a sample without actually affecting
the sample on disk. Because Live calculates the envelope modulations in real time, you can
have hundreds of clips in a Live Set that all sound different, but use the same sample.

You can, of course, export a newly created sound by rendering, or by resampling. In the
Arrangement View, you can use the Consolidate command to create new samples.

17.2.2 Changing Pitch and Tuning per Note

Drop a sample loop from the Browser into Live and play it. Click on the �Transpose�
envelope quick-chooser button. You can now alter the pitch transposition of individual
notes in the sample as you listen to it.

The fast way to do this is by enabling Draw Mode and drawing steps along the grid.
Deactivate Draw Mode to edit breakpoints and line segments. This is useful for smoothing
the coarse steps by horizontally displacing breakpoints.
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The Transposition
Envelope with Steps
(Top) and Ramps
(Bottom).

Note that the warp settings determine how accurately Live's time-warping engine tracks
the envelope shape. To obtain a more immediate response, reduce the Grain Size value in
Tones and Texture Mode or choose a smaller value for the Transients control in Beats Mode.

To correct the tuning of individual notes in the sample, hold down the Ctrl (PC) /
(Mac) modi�er while drawing or moving breakpoints to obtain a �ner resolution.

To scroll the display, hold down the Ctrl Alt (PC) / Alt (Mac) modi�er while
dragging.

Pitch is modulated in an additive way. The output of the transposition envelope is simply



17.2. AUDIO CLIP ENVELOPES 227

added to the �Transpose� control's value. The result of the modulation is clipped to stay in
the available range (-48..48 semitones in this case).

17.2.3 Muting or Attenuating Notes in a Sample

Click on the �Volume� envelope quick-chooser to access an audio clip's volume envelope.
By drawing steps in Draw Mode or creating shapes with breakpoints, you can impose an
arbitrary volume shape onto the sample.

Imposing a Volume
Envelope on a Sample.

The volume envelope's output is interpreted as a relative percentage of the clip volume
slider's current value. The result of the clip envelope's modulation can therefore never
exceed the absolute volume setting, but the clip envelope can drag the audible volume
down to silence.

17.2.4 Scrambling Beats

One very creative use of clip envelopes is to modulate the sample offset. Sample offset
modulation makes the most sense for rhythmical samples, and is only available for clips that
are set up to run in the �Beats� Warp Mode.
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Try sample offset modulation with a one-bar drum loop: Make sure �Beats� Mode is chosen;
in the Envelopes box, choose �Clip� from the Device chooser and �Sample Offset� from
the Control chooser. The Envelope Editor appears with a vertical grid overlay. In envelope
Draw Mode, set steps to non-zero values to hear the loop scrambled. What is going on?

Imagine the audio is read out by a tape head, the position of which is modulated by the
envelope. The higher a value the envelope delivers, the farther away the tape head is from
its center position. Positive envelope values move the head towards the �future,� negative
values move it towards the �past.� Fortunately, Live performs the modulation in beats rather
than centimeters: A vertical grid line is worth a sixteenth note of offset and the modulation
can reach from plus eight sixteenths to minus eight sixteenths.

Sample offset modulation is the tool of choice for quickly creating interesting variations of
beat loops. We discourage using this technique for �analytical� cut-and-splice tasks; they
are much easier to perform using Live's Arrangement View, and the results can easily be
consolidated into new clips.

Repeating Steps and
Slowing Time with the
Sample Offset Envelope.

Some sample offset envelope gestures have a characteristic effect: a downward �escalator�
shape, for instance, effectively repeats the step at the envelope's beginning. Similarly, a
smooth ramp with a downwards slope is slowing time and can create nice slurring effects
when the slope is not quite exactly 45 degrees; try this with a 1/32 Transients setting.
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17.2.5 Using Clips as Templates

As you are making creative use of clip envelopes, the clips containing them develop a life
of their own, independent of the original sample. You might wonder at a point: What does
this clip sound like with a different sample? This is easy to �nd out by selecting the clip
so that it is displayed in the Clip View and dragging the desired sample from one of the
File Browsers, or the Session or Arrangement View, onto the Clip View. All clip settings,
including the envelopes, will remain unaltered; only the sample will be replaced.

Notice this procedure affects only the selected clip, whereas replacing a sample with the
Clip View's Replace button will affect all clips using that sample.

17.3 Mixer and Device Clip Envelopes

Clip envelopes can be used to modulate mixer and device controls. Since mixer and
device controls can also be controlled by the Arrangement's automation envelopes, this is
a potential source of confusion. However, clip envelopes differ from automation envelopes
in one important way: Whereas automation envelopes de�ne the value of a control at any
given point in time, clip envelopes can only in�uence this de�ned value. This difference
allows the two types of envelopes to work together in harmony when controlling the same
parameter.

Imagine that you have recorded volume automation for an audio clip so that it gradually
fades out over four bars. What happens to your fade-out when you create a clip envelope
that gradually increases the mixer volume over four bars? At �rst, your fade-out will become
a crescendo, as the clip envelope gradually increases the volume within the range allowed
by the automation envelope. But, once the decreasing automated value meets with the
increasing clip envelope value, the fade-out will begin, as automation forces the absolute
control value (and the operable range of the clip envelope) down.
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17.3.1 Modulating Mixer Volumes and Sends

Notice that there are actually two volume modulations: Clip Volume and Mixer Volume.
The latter is a modulation for the mixer's gain stage and therefore affects the post-effect
signal. To prevent confusion, a small dot below the mixer's volume slider thumb indicates
the actual, modulated volume setting.

Modulating the Mixer
Volume. The Little Dot
Below the Volume Slider
Thumb Represents the
Modulated Volume
Setting.

As you raise and lower the Volume slider, you can observe the dot following your movement
in a relative fashion.

Modulating the track's Send controls is just as easy. Again, the modulation is a relative
percentage: The clip envelope cannot open the send further than the Send knob, but it can
reduce the actual send value to minus in�nite dB.

Modulating a Send. The
Send Knob's Position
Ring Indicates the
Modulated Value.

17.3.2 Modulating Pan

The Pan envelope affects the mixer pan stage in a relative way: The pan knob's position
determines the intensity of the modulation. With the pan knob set to the center position,
modulation by the clip envelope can reach from hard left to hard right; the modulation
amount is automatically reduced as you move the pan knob towards the left or right. When
the pan knob is turned all the way to the left, for instance, the pan clip envelope has no
effect at all.
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17.3.3 Modulating Device Controls

All devices in a clip's track are listed in the upper clip envelope Device chooser. Modulating
the devices' controls works just as you would expect. When modulating device controls, it
is important to keep the interaction of clip envelopes and device settings in mind: Unlike
a device preset, the clip envelope cannot de�ne the values for the devices' controls, it can
only change them relative to their current setting.

17.4 MIDI-Controller Clip Envelopes

Whether you are working with a new MIDI clip that was recorded directly into Live, or one
from your �les, Live allows you to edit and create MIDI-controller data for the clip in the
form of clip envelopes.

Choose �MIDI Ctrl� from a MIDI clip's Device chooser and use the Control chooser below
it to select a speci�c MIDI controller. You can create new clip envelopes for any of the
listed controllers by drawing steps or using breakpoints. You can also edit clip envelope
representations of controller data that is imported as part of your MIDI �les or is created
while recording new clips: Names of controllers that already have clip envelopes appear
with a little LED in the Control chooser.

Live supports most MIDI-controller numbers up to 119, accessible via the scroll bar on the
right-hand side of the menu. Note that devices to which you send your MIDI-controller
messages may not follow the conventions of MIDI-control channel assignments, so that
�Pitch Bend� or �Pan,� for example, will not always achieve the results that their names
imply.
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A MIDI-Controller Clip
Envelope.

Many of the techniques described in the following section on unlinking a clip envelope from
its associated clip can be adapted for use with MIDI-controller clip envelopes.

17.5 Unlinking Clip Envelopes From Clips

A clip envelope can have its own local loop/region settings. The ability to unlink the
envelope from its clip creates an abundance of exciting creative options, some of which we
will present in the rest of this chapter.

17.5.1 Programming a Fade-Out for a Live Set

Let us start with a straightforward example. Suppose you are setting up a Live Set and wish
to program a fade-out over eight bars to occur when a speci�c clip is launched � but all you
have is a one-bar loop.
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1 3

42

Using a Clip Envelope to
Create a Fade-Out Over
Several Repetitions of a
Loop.

1. Choose the Clip Volume envelope, and unlink it from the sample.

The clip envelope's loop braces now appear colored to indicate this envelope
now has its own local loop/region settings. The loop/region controls in the
Envelopes box �come to life.�

2. Make sure the clip envelope's Loop switch is off. Notice the Sample box's Loop
switch is not affected. The sample will keep looping although the envelope is
now playing as a �one-shot.�

3. Type �8� into the leftmost envelope loop-length value box.

4. Zoom the envelope display out all the way by clicking on the Envelope's time
ruler and dragging upwards.

5. Insert a breakpoint at the region end and drag it to the bottom (zero percent).

Now, as you play the clip, you can hear the one-bar loop fading out over eight bars.

Please note: toggling Linked Mode changes the envelope data. Toggling back and forth
effectively deletes the envelope data. To return to the previous state, please use the Edit
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menu's Undo command.

17.5.2 Creating Long Loops from Short Loops

Let us take this a step further. For a different part of your set, you would like to use the
same one-bar loop � because it sounds great � but its repetition bores you. You would like
to somehow turn it into a longer loop.

We depart from the clip we just set up to fade out over eight bars. Activate the clip volume
envelope's Loop switch. Now, as you play the clip, you can hear the eight-bar fade-out
repeating. You can draw or edit any envelope to superimpose onto the sample loop. This,
of course, not only works for volume but for any other control as well; how about a �lter
sweep every four bars?

Note that you can create as much time as needed in the Envelope Editor, either by dragging
the loop braces beyond the view limit, or by entering values into the numeric region/loop
controls.

You can choose an arbitrary loop length for each envelope, including odd lengths like 3.2.1.
It is not hard to imagine great complexity (and confusion!) arising from several odd-length
envelopes in one clip.

The Sample (Left) and
Envelope (Right) Start
Marker.
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To keep this complexity under control, it is important to have a common point of reference.
The start marker identi�es the point where sample or envelope playback depart from when
the clip starts.

Note that the start/end markers and loop brace are subject to quantization by the zoom-
adaptive grid, as is envelope drawing.

17.5.3 Imposing Rhythm Patterns onto Samples

So far, we have been talking about imposing long envelopes onto small loops. You can
also think of interesting applications that work the other way around. Consider a sample
of a song that is several minutes long. This sample could be played by a clip with a one-
bar volume envelope loop. The volume envelope loop now works as a pattern that is
repeatedly �punching� holes into the music so as to, perhaps, remove every third beat. You
can certainly think of other parameters that such a pattern could modulate in interesting
ways.

17.5.4 Clip Envelopes as LFOs

If you are into sound synthesis, you may want to think of a clip envelope with a local loop as
an LFO. This LFO is running in sync with the project tempo, but it is also possible to set up
a loop period odd enough to render the envelope unsynchronized. By hiding the grid, you
can adjust the clip envelope loop start and end points completely independent of meter
grid.



Chapter 18

Live Audio Effect Reference

Live comes with a selection of custom-designed, built-in audio effects. The �Working with
Instruments and Effects� chapter explains the basics of using effects in Live.
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18.1 Auto Filter

The Auto Filter Effect.

The Auto Filter effect provides classic analog �lter emulation. It can be modulated by an
envelope follower and/or an LFO to create moving �lter effects.

There are four different �lter types: low-pass, high-pass, band-pass and notch. For each
type, the X-Y controller adjusts frequency (to adjust, click and drag on the X-axis) and Q
(also called resonance; to adjust, click and drag on the Y-axis). You can also click on the Freq
and Q numeric displays and type in exact values.

Low Q values create a broad �lter curve, while higher values introduce a narrow, resonant
peak to the sound. With band-pass �ltering, Q sets the bandwidth of the passed signal.

The Quantize Beat control applies quantized modulation to the �lter frequency. With Quan-
tize Beat off, frequency modulation follows the control source. Turning this feature on
updates the �lter modulation rhythmically with �stepped� changes that track the master
tempo. The numbered buttons represent 16th notes, so, for example, selecting �4� as a
beat value produces a modulation change once per beat.

The Envelope section controls how the envelope modulation affects the �lter frequency.
The Amount control de�nes the extent to which the envelope affects the �lter frequency,
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while the Attack control sets how the envelope responds to rising input signals. Low Attack
values cause a fast response to input levels; high values integrate any changes gradually,
creating a looser, slower response. Think of it as adding inertia to the response.

Lower Release values cause the envelope to respond more quickly to falling input signals.
Higher values extend the envelope's decay.

The Auto Filter also contains a Low Frequency Oscillator to modulate �lter frequency in a
periodic fashion. The respective Amount control sets how much the LFO affects the �lter.

The Rate control speci�es the LFO speed. It can be set in terms of hertz, or synced to the
project tempo and set in terms of meter subdivisions. The second option allows for creating
controlled rhythmic �ltering.

Available LFO waveform shapes are sine (creates smooth modulations with rounded peaks
and valleys), square, triangle, sawtooth up, sawtooth down, and sample and hold (generates
random positive and negative modulation values) in mono and stereo.

There are two LFOs, one for each stereo channel. The Phase and Offset controls de�ne the
relationship between these two LFOs.

Phase keeps both LFOs at the same frequency, but can set the two LFO waveforms �out of
phase� with each other, creating stereo movement. Set to �180�, the LFO outputs are 180
degrees apart, so that when one LFO reaches its peak, the other is at its minimum.

Spin detunes the two LFO speeds relative to each other. Each stereo channel is modulated
at a different frequency, as determined by the Spin amount.

For sample and hold, the Phase and Spin controls are not relevant and do not affect the
sound. Instead, the Auto Filter offers two kinds of sample and hold: The upper sample and
hold type available in the chooser provides independent random modulation generators for
the left and right channels (stereo), while the lower one modulates both channels with the
same signal (mono).
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18.2 Auto Pan

The Auto Pan Effect.

Auto Pan offers LFO-driven manipulation of amplitude and panning for creating automatic
panning, tremolo and amplitude modulation, and beat-synchronized chopping effects.

Auto Pan's LFOs modulate the amplitude of the left and right stereo channels with sine,
triangle, sawtooth down or random waveforms.

The Shape control pushes the waveform to its upper and lower limits, �hardening� its shape.
The waveform can be set to �Normal� or �Invert� (use �Invert� to, for example, create the
saw up waveform from the saw down waveform).

Auto Pan's LFO speed is controlled with the Rate control, which can be set in terms of hertz.
Rate can also be synced with the project tempo and set in meter subdivisions (e.g., sixteenth
notes).

Though both LFOs run at the same frequency, the Phase control lends the sound stereo
movement by offsetting their waveforms relative to each other. Set this to �180�, and the
LFOs will be perfectly out of phase (180 degrees apart), so that when one reaches its peak,
the other is at its minimum. Phase is particularly effective for creating vibrato effects.

The Offset control shifts the start point of each LFO along its waveform.
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The device's in�uence on incoming signals is set with the Amount control.

18.3 Beat Repeat

The Beat Repeat Effect.

Beat Repeat allows for the creation of controlled or randomized repetitions of an incoming
signal.

The Interval control de�nes how often Beat Repeat captures new material and begins re-
peating it. Interval is synced with and set in terms of the project tempo, with values ranging
from �1/32� to �4 Bars.� The Offset control shifts the point de�ned by Interval forward in
time. If Interval is set to �1 Bar,� for example, and Offset to �8/16�, material will be captured
for repetition once per bar on the third beat (i.e., halfway, or eight-sixteenths of the way,
through the bar).

You can add randomness to the process using the Chance control, which de�nes the likeli-
hood of repetitions actually taking place when Interval and Offset �ask� for them. If Chance
is set to �100%�, repetitions will always take place at the given Interval/Offset time; if set to
�0%�, there will be no repetitions.
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Gate de�nes the total length of all repetitions in sixteenth notes. If Gate is set to �4/16�,
the repetitions will occur over the period of one beat, starting at the position de�ned by
Interval and Offset.

Activating the Repeat button bypasses all of the above controls, immediately capturing
material and repeating it until deactivated.

The Grid control de�nes the grid size � the size of each repeated slice. If set to �1/16�, a
slice the size of one sixteenth note will be captured and repeated for the given Gate length
(or until Repeat is deactivated). Large grid values create ryhthmic loops, while small values
create sonic artifacts. The No Triplets button sets grid division as binary.

Grid size can be changed randomly using the Variation control. If Variation is set to �0�,
grid size is �xed. But when Variation is set to higher values, the grid �uctuates considerably
around the set Grid value. Variation has several different modes, available in the chooser
below: Trigger creates variations of the grid when repetitions are triggered; 1/4, 1/8 and
1/16 trigger variations in regular intervals; and Auto forces Beat Repeat to apply a new
random variation after each repetition � the most complex form of grid variation in Beat
Repeat (especially if triplets are also allowed).

Beat Repeat's repetitions can be pitched down for special sonic effects. Pitch is adjusted
through resampling in Beat Repeat, lengthening segments to pitch them down without again
compressing them to adjust for the length change. This means that the rythmical structure
can become quite ambiguous with higher Pitch values. The Pitch Decay control tapers the
pitch curve, making each repeated slice play lower than the previous one. Warning: This is
the most obscure parameter of Beat Repeat.

Beat Repeat includes a combined low-pass and high-pass �lter for de�ning the passed
frequency range of the device. You can turn the �lter on and off, and set the center
frequency and width of the passed frequency band, using the respective controls.

The original signal (which was received at Beat Repeat's input) is mixed with Beat Repeat's
repetitions according to one of three mix modes: Mix allows the origial signal to pass
through the device and have repetitions added to it; Insert mutes the original signal when
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repetitions are playing but passes it otherwise; and Gate passes only the repetitions, never
passing the original signal. Gate mode is especially useful when the effect is housed in a
return track.

You can set the output level of the device using the Volume control, and apply Decay to
create gradually fading repetitions.

18.4 Chorus

The Chorus Effect.

The Chorus effect uses two parallel time-modulated delays to create chorus (thickening) and
�anging effects.

Each delay has its own delay time control, calibrated in milliseconds. Delay 1 has a high-pass
�lter that can remove low frequencies from the delayed signal. Greater high-pass values let
only very high frequencies pass through to Delay 1.

Delay 2 can switch among three different modes. When off, only Delay 1 is audible. In Fix
Mode, only Delay 1's delay time will be modulated. When Mod is activated, Delay 2 will
receive the same modulation as Delay 1.
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To set both delay lines to Delay 1's delay time, turn on the link button (�= �). This is especially
useful if you want to change both delays with a single gesture.

The Modulation X-Y controller can impart �motion� to the sounds. To change the modula-
tion rate for the delay times, click and drag along the horizontal axis. To change the amount
of modulation, click and drag along the vertical axis.

You can also make changes by entering parameter values in the Amount and Rate �elds be-
low the X-Y controller. The Amount value is in milliseconds, while the modulation frequency
rate is in Hertz.

Clicking the *20 switch multiplies the modulation frequency by 20 to achieve more extreme
sounds.

The Feedback control determines how much of the output signal feeds back into the input,
while the Polarity switch sets (surprise!) the polarity. Polarity changes have the most effect
with high amounts of feedback and short delay times.

The Dry/Wet control adjusts the balance between the processed and dry signals. Set it to
wet only if using the Chorus in a return channel.
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18.5 Compressor I

The Compressor I Effect.

A Compressor reduces gain for signals above a user-settable threshold. Compression re-
duces the levels of peaks, opening up more headroom and allowing the overall signal level
to be turned up. This gives the signal a higher average level, resulting in a sound that is
subjectively louder and �punchier� than an uncompressed signal.

The two most important parameters are the Threshold and the compression Ratio:

The Threshold slider sets where compression begins. Signals below the threshold are not
processed. Signals above the threshold are attenuated by an amount speci�ed by the Ratio
parameter, which sets the ratio between the input and output signal. For example, with a
compression ratio of 3:1, if a signal above the threshold increases by 3 dB, the compressor
output will increase by only 1 dB. If a signal above the threshold increases by 6 dB, then the
output will increase by only 2 dB.

The red gain-reduction meter shows how much the gain is being reduced at any given
moment. The more reduction, the more audible the effect; a gain reduction above 6 dB
or so might produce the desired loudness, but signi�cantly alters the sound and is easily
capable of destroying its dynamic structure. This is something that cannot be undone in
later production steps. Keep this in mind especially when using a compressor, limiter or
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sound loudness-maximizing tool in the master channel. Less is often more here.

Because compression reduces the volume of loud signals and opens up headroom, you can
use the Out(put) slider so that the peaks once again hit the maximum available headroom.
The Output meter shows the output signal's level.

A second set of two essential parameters de�nes how fast a compressor reacts to input-level
changes: Attack time and Release time.

Attack de�nes how long it takes to reach maximum compression once a signal exceeds
the threshold, while Release sets how long it takes for the compressor to return to normal
operation after the signal falls below the threshold.

A slight amount of attack time (5�10 ms) allows peaks to come through unprocessed,
which helps preserve dynamics. If these peaks cause overloads, you can try shortening the
attack time, but extremely short times take the �life� out of the signal, and may lead to a
slight �buzziness� caused by distortion. Short release times can cause �pumping� as the
compressor tries to �gure out whether to compress or not; while generally considered an
undesirable effect, some engineers use it on full drum kits to give unusual �sucking� effects.
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18.6 Compressor II

The Compressor II
Effect.

Compressor II is a state of the art compression unit � the tool of choice for a wide range of
dynamic processing applications including limiting and loudness maximization. Compressor
II's design is a lot more sophisticated and capable than Compressor I's. It includes frequency-
selective compression using a sidechain EQ, variable look-ahead times and two response
modes, Peak and RMS. Compressor I is still a valuable sound design tool in spite of, or rather
because of, its simplicity and roughness, which can add interesting �avors to your sounds.

A compressor can only react to an input signal once it occurs. Since it also needs to apply
an attack/release envelope, the compression is always a bit too late. A digital compressor
can solve this problem by simply delaying the input signal a little bit. Compressor II offers
three different predelay times: zero ms, one ms and ten ms. The results may sound pretty
different depending on this setting. Keep in mind that using ten ms of predelay makes the
output appear signi�cantly later. You may have to delay other tracks with a Simple Delay in
order to stay in sync.

Compressor II can either react to short peaks within a signal or to something that is more
related to how people perceive loudness. The parameter for this is the �Peak/RMS� switch.
If you intend to use Compressor II as a limiter in the master section, �Peak� is probably
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better since it reacts more to the actual signal level, while �RMS� is usually more musical.
But as always if it comes to compression, trust your ears and not the meter!

The most exotic feature of Compressor II is the sidechain EQ. The �sidechain� is the part of
the signal that is used to control the compressor. Normally the sidechain signal is the same
as the input signal. However, it can make sense to apply some �ltering here. Imagine a bass
drum, a snare and some chords in the background. The bass drum has a pretty high level
and it will normally determine how the compressor reacts. If you now turn the side chain EQ
on and set its Frequency to 100 Hz and the Gain to -15 dB, the bass drum will not in�uence
the compression anymore and the behavior of the compressor will be very different. You
could also set the Frequency to around 1 kHz and turn up the gain to make the compressor
more responsive to the snare. Since the EQ is only in the sidechain and not part of the
normal signal path, it will not change the sound of the input signal. It only changes how the
compressor reacts to different frequencies of the input.

Unlike Compressor I, Compressor II has a built-in compensation stage that counteracts the
gain loss due to the compression and makes it much easier to adjust the other parameters.

Careful adjustment of attack and release times is essential when it comes to compression of
rhythmical sources. If you are not used to working with compressors, play a drum loop and
spend some time adjusting Attack, Release, Threshold and Gain. It can be very exciting!
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18.7 EQ Three

The EQ Three Effect.

If you have ever used a good DJ mixer you will know what this is: An EQ that allows you to
adjust the level of low, mid and high frequencies independently.

Each band can be adjusted from -in�nite dB to +6 dB using the gain controls. This means
that you can completely remove, for example, the bass drum or bassline of a track, while
leaving the other frequencies untouched.

You can also turn on or off each band using the On/Off buttons located under the gain
controls. These buttons are especially handy if assigned to computer keys...

EQ Three gives you visual con�rmation of the presence of a signal in each frequency band
using three green LEDs. Even if a band is turned off, you can see if there is something going
on in it. The internal threshold for the LEDs is set to -24 dB.

The frequency range of each band is de�ned via two crossover controls: FreqLo and FreqHi.
If FreqLo is set to 500 Hz and FreqHi to 2000 Hz, then the low band goes from 0 hz to 500
Hz, the mid band from 500 Hz to 2000 Hz and the high band from 2000 Hz up to what ever
your soundcard or sample rate supports.

A very important control is the 24 dB / 48 dB switch. It de�nes how sharp the �lters are
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cutting the signal at the crossover frequency. The higher setting results in more drastic
�ltering, but needs more CPU.

Note: The �lters in this device are optimized to sound more like a good, powerful analog
�lter cascade than a clean digital �lter. The 48 dB Mode especially does not provide a
perfect linear transfer quality, resulting in a slight coloration of the input signal even if all
controls are set to 0.00 dB. This is typical behavior for this kind of �lter, and is part of EQ
Three's unique sound. If you need a more linear behavior choose 24 dB Mode or use the
EQ Four.

18.8 EQ Four

The EQ Four Effect.

The EQ Four effect is an equalizer composed of four parametric �lters. Equalizers are useful
for changing a sound's timbre.

Filter One can switch among three responses: bell-curve (boosts or cuts over a range
of frequencies), low-shelf (boosts or cuts frequencies lower than the speci�ed frequency)
or low-cut (cuts frequencies below the speci�ed frequency). Filters Two and Three are
always bell-curves. Filter Four can switch among bell-curve, high-shelf (boosts or cuts
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frequencies higher than the speci�ed frequency) or high-cut (cuts frequencies above the
speci�ed frequency) modes. Each �lter band can be turned on or off independently. Turn
off bands that aren't in use to save CPU power.

To edit the �lter curve, click and drag on one of the �lter dots in the XY View. Horizontal
movement changes the �lter frequency, while vertical movement adjusts the �lter band's
gain. To adjust the �lter Q (also called resonance or bandwidth), hold down the Alt (PC)
/ Alt (Mac) modi�er while dragging the mouse.

You can also use the numbered �lter selector buttons to select a band for editing, then edit
parameter values with the Freq, Gain and Q dials (and/or type values into the number �elds
below each dial).

To achieve really drastic �ltering effects, assign the same parameters to two or more �lters,
or use more than one EQ Four.

As boosting will increase levels and cutting will decrease levels, use the Gain slider to
optimize the output level for maximum level consistent with minimum distortion.

18.9 Erosion

The Erosion Effect.
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The Erosion effect degrades the input signal by modulating a short delay with �ltered noise
or a sine wave. This adds noisy artifacts or aliasing/downsampling-like distortions that sound
very �digital.�

To change the sine wave frequency or noise band center frequency, click and drag along
the X-axis in the XY �eld. The Y-axis controls the modulation amount. If you hold down the
Alt (PC) / Alt (Mac) modi�er key while clicking in the XY �eld, the Y-axis controls the

noise bandwidth.

The Frequency control determines the color, or quality, of the distortion. If the Mode control
is set to Noise, this works in conjunction with the Width control, which de�nes the noise
bandwidth. Lower values lead to more selective distortion frequencies, while higher values
affect the entire input signal. Width has no effect in Sine Mode.

Noise and Sine use a single modulation generator. However, Wide Noise has independent
noise generators for the left and right channels, which creates a subtle stereo enhancement.

18.10 Filter Delay

The Filter Delay Effect.
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The Filter Delay provides three independent delay lines, each preceded by linked low-pass
and high-pass �lters. This allows applying delay to only certain input signal frequencies, as
determined by the �lter settings. The feedback from each of the three delays is also routed
back through the �lters.

Each of the three delays can be switched on and off independently. The Filter Delay plug-in
assigns delay 1 to the input signal's left channel, delay 2 to the left and right channels and
delay 3 to the right channel. The Pan controls at the right can override the delay channels'
outputs; otherwise each delay outputs on the channel from which it derives its input.

Each delay channel's �lter has an associated On switch, located to the left of each XY
controller. The XY controllers adjust the low- and high-pass �lters simultaneously for each
delay. To edit �lter bandwidth, click and drag on the vertical axis; click and drag on the
horizontal axis to set the �lter band's frequency.

To refer delay time to the master tempo, activate the Sync switch, which allows using the
Delay time beat division chooser. The numbered switches represent time delay in 16th
notes. For example, selecting �4� delays the signal by four 16th notes, which equals one
beat (a quarter note) of delay. With Sync Mode active, changing the Delay Time �eld
percentage value shortens and extends delay times by fractional amounts, thus producing
the �swing� type of timing effect found in drum machines.

If the Sync switch is off, the delay time reverts to milliseconds. In this case, to edit the delay
time, click and drag up or down in the Delay Time �eld, or click in the �eld and type in a
value.

Feedback controls how much of the output signal returns to the delay line input. Very high
values can lead to runaway feedback and produce a loud oscillation � watch your ears and
speakers if you decide to check out extreme feedback settings!

Each delay channel has its own volume control, which can be turned up to +12 dB to
compensate for drastic �ltering at the input.

The Dry control adjusts the unprocessed signal level. Set it to minimum if using the Delay
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in a return channel.

18.11 Flanger

The Flanger Effect.

Flanger uses two parallel time-modulated delays to create �anging effects.

Flanger's delays can be adjusted with the Delay Time control. The Feedback control sends
part of the output signal back through the device input, while the Polarity switch (�+� or
�-�) sets the polarity. Delay Time and Feedback can be changed simultaneously using the
effect's X-Y controller.

Periodic control of delay time is possible using the envelope section. You can increase or
decrease the envelope amount (or invert its shape with negative values), and then use the
Attack and Release controls to de�ne envelope shape.

Flanger contains two LFOs to modulate delay time for the left and right stereo channels.
LFOs can have six possible waveform shapes: sine, square, triangle, sawtooth up, sawtooth
down and random. The extent of LFO in�uence on the delays is set with the Amount control.

Flanger's LFO speed is controlled with the Rate control, which can be set in terms of hertz.
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Rate can also be synced with the project tempo and set in meter subdivisions (e.g., sixteenth
notes).

The Phase control lends the sound stereo movement by setting the LFOs to run at the same
frequency, but offsetting their waveforms relative to each other. Set this to �180�, and the
LFOs will be perfectly out of phase (180 degrees apart), so that when one reaches its peak,
the other is at its minimum.

Spin detunes the two LFO speeds relative to each other. Each delay is modulated at a
different frequency, as determined by the Spin amount.

Adjusting the HiPass control will cut low frequencies from the delayed signal.

The Dry/Wet control adjusts the balance between the processed and dry signals. Set it to
�100%� if using Flanger in a return track.

18.12 Gate

The Gate Effect.

The Gate effect passes only signals whose level exceeds a user-speci�ed Threshold. A gate
can eliminate low-level noise that occurs between sounds (e.g., hiss or hum), or shape a
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sound by turning up the threshold to where it cuts off reverb or delay tails or truncates an
instrument's natural decay.

The Threshold slider sets the gate's sensitivity. If the gate is open and passing signal (i.e.,
the signal exceeds the gate threshold), the green LED lights.

The Floor parameter located above the threshold fader can allow attenuating signals below
the threshold rather than just cutting them off. If set to -inf dB, a closed gate will mute the
input signal. A setting of 0.00 dB means that even if the gate is closed, there is no effect
on the signal. Settings in between these two extremes attenuate the input to a greater or
lesser degree when the gate is closed.

The Attack time determines how long it takes for the gate to switch from closed to open
when a signal goes from below to above the threshold. Very short attack times can produce
sharp clicking sounds, while long times soften the sound's attack.

When the signal goes from above to below the threshold, the Hold time kicks in. (Note
to tech heads: the gate has hysteresis, so the release occurs about 3 dB lower than the
threshold.) After the hold time expires, the gate closes over a period of time set by the
Release parameter.
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18.13 Grain Delay

The Grain Delay Effect.

The Grain Delay effect slices the input signal into tiny particles (called �grains�) that are then
individually delayed and can also have different pitches compared to the original signal
source. Randomizing pitch and delay time can create complex masses of sound and rhythm
that seem to bear little relationship to the source. This can be very useful in creating new
sounds and textures, as well as getting rid of unwelcome house guests, or terrifying small
pets (just kidding!).

To refer delay time to the master tempo, activate the Sync switch, which allows using the
Delay Time beat division chooser. The numbered switches represent time delay in 16th
notes. For example, selecting �4� delays the signal by four 16th notes, which equals one
beat (a quarter note) of delay. With Sync Mode active, changing the Delay Time �eld
percentage value shortens and extends delay times by fractional amounts, thus producing
the �swing� type of timing effect.

If the Sync switch is off, the delay time reverts to milliseconds. In this case, to edit the delay
time, click and drag up or down in the Delay Time �eld, or click in the �eld and type in a
value.

You can route each parameter to the XY controller's horizontal or vertical axis. To assign a
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parameter to the X-axis, choose it from the parameter row below the controller. To assign a
parameter to the Y-axis, use the parameter row on the left side.

The Feedback parameter sets how much of the output signal returns to the delay line input.
Very high values can lead to runaway feedback and produce a loud oscillation � watch your
ears and speakers if you decide to check out extreme feedback settings!

You can transpose the grain pitch with the Pitch parameter, which acts much like a crude
pitch shifter.

The Spray control adds random delay time changes. Low values smear the signal across
time, which adds �noisiness� to the sound. High Spray values completely break down the
structure of the source signal, introducing varying degrees of rhythmical chaos. This is the
recommended setting for anarchists.

The Random Pitch control adds random variations to each grain's pitch. Low values create
a sort of mutant chorusing effect, while high values can make the original source pitch
completely unintelligible. This parameter can interact with the main Pitch control, thus
allowing degrees of stability and instability in a sound's pitch structure.

The size and duration of each grain is a function of the Frequency parameter. The sound of
Pitch and Spray depends very much on this parameter.

Grain Delay now also has a dry/wet control; it can be routed to the vertical axis of the XY
controller.
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18.14 Phaser

The Phaser Effect.

Phaser uses a series of all-pass �lters to create a phase shift in the frequency spectrum of a
sound.

The Poles control creates notches in the frequency spectrum. The Feedback control can
then be used to invert the waveform and convert these notches into peaks (or poles). Filter
cutoff frequency is changed with the Frequency control, which can be adjusted in tandem
with Feedback using the effect's X-Y controller.

The device has two modes, Space and Earth, for changing the spacing of notches along the
spectrum, and hence the �color� of the sound. This effect can be further adjusted with the
Color control.

Periodic control of the �lter frequency is possible using the envelope section. You can
increase or decrease the envelope amount (or invert its shape with negative values), and
then use the Attack and Release controls to de�ne envelope shape.

Phaser contains two LFOs to modulate �lter frequency for the left and right stereo channels.
LFOs can have six possible waveform shapes: sine, square, triangle, sawtooth up, sawtooth
down and random. The extent of LFO in�uence on the �lter frequency is set with the
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Amount control.

LFO speed is controlled with the Rate control, which can be set in terms of hertz. Rate can
also be synced with the project tempo and set in meter subdivisions (e.g., sixteenth notes).

The Phase control lends the sound stereo movement by setting the LFOs to run at the same
frequency, but offsetting their waveforms relative to each other. Set this to �180�, and the
LFOs will be perfectly out of phase (180 degrees apart), so that when one reaches its peak,
the other is at its minimum.

Spin detunes the two LFO speeds relative to each other. Each �lter frequency is then
modulated using a different LFO frequency, as determined by the Spin amount.

The Dry/Wet control adjusts the balance between the processed and dry signals. Set it to
�100%� if using Phaser in a return track.

18.15 Ping Pong Delay

The Ping Pong Delay
Effect.

The Ping Pong Delay effect uses a single tapped delay line to create a delay that jumps
from the left to the right output.
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The delay is preceded by a low- and high-pass �lter that can be controlled with an XY
controller. To de�ne the �lter bandwidth, click and drag on the vertical axis. To set the
position of the frequency band, click and drag on the horizontal axis.

To refer delay time to the master tempo, activate the Sync switch, which allows using the
Delay Time beat division chooser. The numbered switches represent time delay in 16th
notes. For example, selecting �4� delays the signal by four 16th notes, which equals one
beat (a quarter note) of delay. This delay time represents the time it takes for the input
signal to appear at the left channel. The delay time between the input and the right channel
is twice as long.

If the Sync switch is off, the delay time reverts to milliseconds. In this case, to edit the delay
time, click and drag up or down in the time �eld, or click in the �eld and type in a value.

The Feedback parameter controls how much of the right channel output signal returns to
the delay line input. The feedback loop also includes a �lter that can color the feedback
sound, thus producing different timbres with successive echoes.

The Dry/Wet control adjusts the balance between the processed and dry signals. Set it to
full wet if using the Ping Pong Delay in a return channel.
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18.16 Saturator

The Saturator Effect.

Saturator is a distortion effect that can add that missing dirt, punch or warmth to your sound.

Incoming signals are clipped to the Drive control's setting in dB. Signal clipping has several
modes: Clip, Soft, Medium, Hard and Sine. In Clip mode, the signal is clipped completely
and immediately. Soft, Medium and Hard modes soften signal clipping to varying degrees.
Sine mode can be used for special effects.

The meter in the display will show how much Saturator is in�uencing a signal.

Activating the Color button enables two �lters. The �rst of these, controlled with the Base
control, dictates how much the effect will be reduced or increased for very low frequencies.
The second �lter, essentially an equalizer, is used for controlling higher frequencies. It is
shaped with the Freq (cutoff frequency), Width and Depth controls.

The Output control reduces or increases the level at the device output. The signal at the
device input can be ampli�ed using the Drive control.

The Dry/Wet control adjusts the balance between the processed and dry signals. Set it to
full wet if using the Saturator in a return channel.
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18.17 Simple Delay

The Simple Delay Effect.

The Simple Delay provides two independent delay lines, one for each channel (left and
right).

To refer delay time to the master tempo, activate the Sync switch, which allows using the
Delay Time beat division chooser. The numbered switches represent time delay in 16th
notes. For example, selecting �4� delays the signal by four 16th notes, which equals one
beat (a quarter note) of delay. If the Sync switch is off, the delay time reverts to milliseconds.
In this case, to edit the delay time, click and drag up or down in the Delay Time �eld, or
click in the �eld and type in a value.

The Feedback parameter de�nes how much of each channel's output signal feeds back into
the delay lines' inputs. Internally there are two independent feedback loops, so a signal on
the left channel does not feed back into the right channel and vice versa.

The Dry/Wet control adjusts the balance between the processed and dry signals. Set it to
full wet if using the Simple Delay in a return channel.
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18.18 Vinyl Distortion

The Vinyl Distortion
Effect.

The Vinyl Distortion effect emulates some of the typical distortions that occur on vinyl records
during playback. These distortions are caused by the geometric relationships between the
needle and the recorded groove. The effect also features a crackle generator for adding
noisy artifacts.

The Tracing Model section adds even harmonic distortion to the input signal. Adjust the
amount of distortion with the Drive knob, or click and drag vertically in the Tracing Model XY
window. To adjust the distortion's frequency or �color,� drag horizontally in the XY window
or double-click on the Freq �eld and type in a value. Holding the Alt (PC) / Alt

(Mac) modi�er while dragging vertically in the XY window changes the frequency band's Q
(bandwidth).

The Pinch Effect section adds odd harmonics to the input signal. These distortions typically
occur 180 degrees out of phase, creating a richer stereo image. The Pinch Effect has the
same controls as the Tracing Model, but generates a rather different sound.

The Drive control increases or decreases the overall distortion amount created by both the
Tracing Model and Pinch.
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There are two distortion modes: soft and hard. The soft mode simulates the sound of a dub
plate, while hard mode is more like that of a standard vinyl record.

The stereo/mono switch determines whether the Pinch distortion occurs in stereo or mono.
Set it to stereo for realistic simulation of vinyl distortions.

The Crackle section adds noise to the signal, with noise density set by the Density control.
The Volume control adjusts the amount of gain applied to the noise.

18.19 Redux

The Redux Effect.

Nostalgic for the famed low-resolution sound quality of the Ensoniq Mirage, Fairlight CMI
or Commodore-64 computer? Redux returns us to the Dark Ages of digital by reducing a
signal's sample rate and bit resolution.

The Downsample section has two parameters: �Downsample� and a downsample Mode
switch.

If the downsample dial is set to �1�, every input sample passes to the output and the signal
does not change. If set to �2�, only every second sample will be processed, so the result
sounds a bit more �digital.� The higher the number, the lower the resulting sample rate,
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and the more �deconstructed� the sound. Downsampling is like applying a mosaic effect
to an image: There's a loss of information and sharp edges occur between the blocks.

The Downsample Mode switch de�nes if the downsampling either interpolates over a smaller
range (�soft,� down to 20.0 samples) or does not interpolate over a larger range (�hard,�
down to 200 samples).

Bit Reduction is similar, but while downsampling superimposes a grid in time, bit reduction
does the same for amplitude.

If the Bit Reduction amplitude dial is set to 8, amplitude levels are quantized to 256 steps
(8 bit resolution). If set to 1, the result is pretty brutal: Each sample contains either a full
positive or full negative signal, with nothing in between.

Bit Reduction de�nes an input signal of 0dB as 16 bit. Signals above 0dB are clipped, and
the red overload LED will light up.

Turning off Bit Reduction results in modest CPU savings.

18.20 Resonators

The Resonators Effect.
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This device consists of �ve parallel resonators that superimpose a tonal character on the
input source. It can produce sounds resembling anything from plucked strings to vocoder-
like effects. The resonators are tuned in semitones, providing a musical way of adjusting
them. The �rst resonator de�nes the root pitch and the four others are tuned relative to this
pitch in musical intervals.

The input signal passes �rst through a �lter, and then into the resonators. There are four
input �lter types to select from: low-pass, band-pass, high-pass and notch. The input �lter
frequency can be adjusted with the Frequency parameter.

The �rst resonator is fed with both the left and right input channels, while the second and
fourth resonators are dedicated to the left channel, and the third and �fth to the right
channel.

The Note parameter de�nes the root pitch of all the resonators ranging from C1 to C5.
It can also be detuned in cents using the Fine parameter. The Decay parameter lets you
adjust the amount of time it takes for the resonators to be silent after getting an input signal.
The longer the decay time, the more tonal the result will be, similar to the behavior of an
undamped piano string. As with a real string, the decay time depends on the pitch, so low
notes will last longer than higher ones. The Const switch holds the decay time constant
regardless of the actual pitch.

Resonators provides two different resonation modes. Mode A provides a more realistic
sounding resonation, while Mode B offers an effect that is especially interesting when
Resonator I's Note parameter is set to lower pitches.

The brightness of the resulting sound can be adjusted using the Color control.

All of the resonators have an On/Off switch and a Gain control. A resonator that is turned
off does not need CPU. Turning off the �rst resonator does not affect the other ones.

Resonators II through V follow the Note parameter de�ned in Resonator I, but they can each
be individually transposed +/- 24 semitones using the Pitch controls and detuned in cents
using the Detune controls.
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The output section features the obligatory Dry/Wet control and a Width parameter that
affects only the wet signal and blends the left and right outputs of Resonators II-V into a
mono signal if set to zero.

18.21 Reverb

The Reverb Effect.

18.21.1 Input Processing

The input signal passes �rst through high and low cut �lters, whose X-Y controller allows
changing the band's center frequency (X-axis) and bandwidth (Y-axis). Either �lter may be
switched off when not needed to save CPU power.

Predelay controls the delay time, in milliseconds, before the onset of the �rst early re�ection.
This delays the reverberation relative to the input signal. One's impression of the size of a
real room depends partly on this delay. Typical values for �natural� sounds range from 1ms
to 25ms.
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18.21.2 Early Re�ections

These are the earliest echoes that you hear after they bounce off a room's walls, before
the onset of the diffused reverberation �tail.� Their amplitude and distribution give an
impression of the room's character.

The Shape control �sculpts� the prominence of the early re�ections, as well as their overlap
with the diffused sound. With small values, the re�ections decay more gradually and the
diffused sound occurs sooner, leading to a larger overlap between these components. With
large values, the re�ections decay more rapidly and the diffused onset occurs later. A
higher value can sometimes improve the source's intelligibility, while a lower value may give
a smoother decay.

Spin applies modulation to the early re�ections. The 2-D control accesses the depth and
frequency of these modulations. A larger depth tends to provide a less-colored (more
spectrally neutral) late diffusion response. If the modulation frequency is too high, doppler
frequency shifting of the source sound will occur, along with surreal panning effects. Spin
may be turned off, using the associated switch, with modest CPU savings.

18.21.3 Global Settings

The Quality chooser controls the tradeoff between reverb quality and performance. Econ-
omy mode uses minimal CPU resources, while First Class delivers the richest reverberation.

The Size parameter controls the �room's� volume. At one extreme, a very large size will
lend a shifting, diffused delay effect to the reverb. The other extreme, a very small value,
will give it a highly colored, metallic feel.

The Stereo Image control determines the width of the output's stereo image. At the highest
setting of 120 degrees, each ear receives a reverberant channel that is independent of the
other (this is also a property of the diffusion in real rooms). The lowest setting mixes the
output signal to mono.
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18.21.4 Diffusion Network

The Diffusion network creates the reverberant tail that follows the early re�ections. The
decay time control adjusts the time required for this tail to drop to 1/1000th (-60 dB) of its
initial amplitude.

High and low shelving �lters provide frequency-dependent reverberation decay. The high-
frequency decay models the absorption of sound energy due to air, walls and other materials
in the room (people, carpeting and so forth). The low shelf provides a thinner decay. Each
�lter may be turned off to save CPU consumption.

The Freeze control freezes the diffuse response of the input sound. When on, the reverber-
ation will sustain almost endlessly. Cut modi�es Freeze by preventing the input signal from
adding to the frozen reverberation; when off, the input signal will contribute to the diffused
amplitude. Flat bypasses the high and low shelf �lters when freeze is on. If Flat is off, the
frozen reverberation will lose energy in the attenuated frequency bands, depending on the
state of the high and low shelving �lters.

The Echo Density and Scale parameters provide additional control over the diffusion's den-
sity and coarseness, and, when the room size is extremely small, have a large impact on the
coloration contributed by the diffusion.

The Chorus section adds a little modulation and motion to the diffusion. Like the Spin
section, you can control the modulation frequency and amplitude, or turn it off.

18.21.5 Output

At the reverb output, you can adjust the effect's overall Dry/Wet mix, and vary the amplitude
of re�ections and diffusion with the Re�ect Level and Diffuse Level controls.
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18.22 Utility

The Utility Effect.

Utility can perform some very useful tasks, especially in combination with other effects.

Most obvious is the Gain control, which allows adjusting the level of the input signal from
-36 to +36 dB. The Gain control is located below the Mute button, which simply turns the
signal off if pressed.

Note: The active/mute controls of a track are always placed at the very end of the signal
chain. However, since you can place Utility anywhere in a signal chain, you can use its mute
function to cut the input of a delay line or reverb without turning off the output of these
devices.

The Left/Right buttons allow further processing of only the left or right channel of a sample.
If, for example, Left is turned on, the right channel is ignored and the left channel appears
on both outputs. This is especially useful if you have a stereo �le that contains different
information on both channels and you want to use only one.

The Width control acts as a continuous mono to stereo controller when set from 0 to 100
percent. However, beyond 100 percent the output starts to �fold in� on itself. In the full
right position the output contains only the difference between the left and right channels. If
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either the Left or Right button is activated, the Width control has no function and is therefore
bypassed.

At the bottom of the device you will �nd two Phase (ø) controls, one for each channel. As
the name implies they invert the phase of each channel.



Chapter 19

Live MIDI Effect Reference

Live comes with a selection of custom-designed, built-in MIDI effects. The �Working with
Instruments and Effects� chapter explains the basics of using effects in Live.
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19.1 Arpeggiator

The Arpeggiator Effect.

Live's Arpeggiator effect takes the individual notes in a played MIDI chord, or notes played
singly, and plays them as a rhythmical pattern. The sequence and speed of the pattern
can be controlled by the device, which also provides a full complement of both classic and
original arpeggiator features.

Arpeggiators are a classic element in Eighties synth music. The name originates with the
musical concept of the �arpeggio,� in which the notes comprising a chord are played as
a series rather than in unison. �Arpeggio� is derived from the Italian word �arpeggiare,�
which refers to playing notes on a harp.

19.1.1 Style and Rate Sections

Arpeggiator's Style chooser determines the sequence of notes in the rhythmical pattern.

�Up� and �Down�.
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�UpDown� and
�DownUp�.

�Down & Up� and �Up
& Down�.

�Converge� and
�Diverge�.

�Con & Diverge�.

�Pinky Up� and �Pinky
UpDown�.

�Thumb Up� and
�Thumb UpDown�.

Play Order places notes in the pattern according to the order in which they are played. This
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is therefore only recognizable when more than one chord or note has been played.

In addition to the Arpeggiator styles above, there are a number of random styles. Random
randomly selects incoming MIDI notes for playback. Random Other creates a random
pattern from incoming MIDI notes, and then plays the randomly generated chord repeatedly.
Random Once creates a random pattern from incoming MIDI notes and repeats the pattern
until it has been transposed or retriggered, at which point a new pattern is created.

Arpeggiator will play the pattern of notes at the speed set by the Rate control, which can
be calibrated in either milliseconds or beat-time using the neighboring Sync/Free button.
With Sync chosen, Arpeggiator will be synced to song time.

A Gate control to the right of Rate determines the length of notes played by Arpeggiator
as a percentage of the current Rate setting. Any setting larger that 100% will therefore play
notes that overlap (i.e., are legato).

The rhythmic pattern generated by Arpeggiator does not necessarily have to be straight;
patterns can be given groove with the respective control just beneath the Mode chooser.
Groove in Arpeggiator works just like it does for clips, so that the intensity of the groove is
set in the Control Bar.

With the Hold parameter active, Arpeggiator will continue to play the pattern even after the
keyboard keys have been released. The pattern will be repeated until any other keyboard
key is pressed. When Hold is active and any of the original keys also remain physically held,
notes can be added to the pattern simply by playing them. Notes can also be removed from
the pattern in this scenario by playing them a second time, allowing the gradual buildup
and rearrangement of the pattern over time.

Tip: If you want the pattern to stop playing, momentarily deactivate Hold.

The Offset parameter shifts the sequence of notes in the pattern by the number of places
selected with the control. This is best illustrated with an example: A setting of �1� makes
the second note in the pattern play �rst, and the �rst note last. If you imagine the pattern
as a circle of notes that is played in a clockwise direction from a set start point, the Offset
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parameter effectively rotates this circle counter-clockwise one note at a time, changing
where in the pattern play begins.

With the Repeats parameter, the pattern can be set to repeat a speci�ed number of times
until it is retriggered. A setting of �inf� will repeat the pattern inde�nitely. Hint: This
feature provides an excellent way of emulating the strum of a guitar or playing a chord as
an arpeggio once or twice. Another interesting effect can be achieved by combining this
feature with the Retrigger parameter, which we will explain in a moment. This can be used
to create rhythmically generated arpeggios separated by pauses.

The Retrigger parameter resets the pattern so that it starts again from the beginning.
Retriggering can be deactivated (Off), set to occur when new notes are pressed (Note) or
set to occur at a speci�ed song position or beat-time (Beat). Beat retriggering can be
speci�ed in terms of notes or bars and is aligned with song position. An LED in the upper
right corner of the section indicates when the pattern has been retriggered.

19.1.2 Transposition and Velocity Sections

The pattern generated by Arpeggiator can be transposed; the device's transposition controls
allow forcing this transposition into a speci�c major or minor key or (using the Transpose
chooser's Shift option) doing it in semitones. The distance between transposition steps is
set in scale intervals (for Major and Minor transposition) or semitones (for Shift transposition)
with the Distance control. Using the Steps parameter, you can choose the number of times
the sequence is transposed: A setting of 8 will transpose the sequence a total of eight times,
playing it in higher notes each time.

The dynamics of Arpeggiator are controlled using the velocity section. With Velocity set
to On and Target set to 0, for example, the sequence will gradually fade out, eventually
reaching 0 velocity. The Decay control sets the amount of time Arpeggiator takes to reach
the Target velocity. With Retrigger activated, retriggering of the sequence will also retrigger
the velocity slope.
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Tip: The velocity section's Retrigger option can be used in conjunction with Beat retriggering
to add rhythm to the dynamic slope.

19.2 Chord

The Chord Effect.

This effect assembles a chord, as the name implies, from each incoming note and up to six
others of user-de�ned pitch. The Shift 1-6 knobs allow selecting the pitch of the notes that
contribute to the chord from a range of +/- 36 semitones relative to the original. Setting
Shift 1 to +4 semitones and Shift 2 to +7 semitones, for example, yields a major chord in
which the incoming note is the root.

The Velocity control beneath each Shift knob makes further harmonic sculpting possible,
given that the instrument allows for changes in volume or timbre as function of velocity. It
is a relative control, with a range of 1 to 200 percent (100 percent de�ned as playing at a
velocity equal to that of the incoming MIDI note). Use the Velocity controls to do anything
from adding slight overtones to washing out most of the other chord elements.

The order in which pitches are added to the chord is inconsequential: The effect of a
+12 semitone shift added with the Shift 1 control, for example, is equal in effect to a +12
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semitone shift added with the Shift 6 control.

Note that no two notes of the same pitch can contribute to the chord, and that selecting the
same shift value twice (e.g., +8 semitones on both Shift 2 and Shift 3) will result in the latter
control becoming gray, indicating that it is a duplicate and therefore not in use. Actually,
there is no such thing as two notes with the same pitch playing at the same time within the
entire Live universe.

19.3 Pitch

The Pitch Effect.

Pitch is a transposition tool that changes incoming note pitch by +/- 48 semitones.

The Range and Lower Limit controls act together to set a pitch range through which notes
are allowed to pass. Notes outside of the de�ned pitch range will be blocked, and the
effect's LED light will �ash when this happens.

Notes outside of the pitch range are limited based on their untransposed pitch, prior to the
transposition stage of the effect.
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19.4 Random

The Random Effect.

Random adds an element of the unknown to the otherwise commonplace pitch parameter.
The Chance control de�nes the likelihood that an incoming note's pitch will be changed by a
random value. You can think of it as being something like a dry/wet control for randomness.

The random value that determines the pitch change is created by two variables: The Choices
control de�nes the number of different random notes possible, from a range of 1 to 24; the
Scale control value is multiplied by the Choices control value, and the result dictates the
pitches that random notes are allowed to have relative to that of the incoming note.

For example, with Chance set to 50 percent, Choices set to 1 and Scale set to 12, half of the
resulting notes will play at the original pitch and half will play 12 semitones higher. But, with
Chance set to 50 percent, Choices set to 12 and Scale set to 1, half of the resulting notes
will play at the original pitch and half will play at one of any that are 12 semitones higher.

These examples assume Sign buttons that are set to �Add.� The Sign controls decide
whether the random alteration adds to the original note's pitch, subtracts from it, or does a
little of both. The LEDs below the Sign controls give you a visual idea of how output pitch
compares with that of the original.

Hint: Try using the Scale effect after Random to obtain random values within a speci�c
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harmonic range.

19.5 Scale

The Scale Effect.

Scale alters incoming note pitch based on a scale mapping. Each incoming note is given
an outgoing equivalent on the X-Y scale map of the effect: All incoming Cs, for example,
might be converted to outgoing Ds.

The X-Y scale map is 12 squares in length and width, corresponding to the 12 notes in a full
octave. Darker squares represent the black keys on a keyboard. The base of the diagonal
scale (the lower left square) shown on the map can be changed using the Base control. The
X-axis of the map shows incoming note values, and the Y-axis their outgoing equivalents.
Use mouse-clicks to move or delete the yellow squares, which de�ne where an incoming
note will be sent on the scale. (Deleting a note on the scale map means that it will no longer
play.)

The Range and Lower Limit controls de�ne the note range within which scale mapping
will take effect. Outside of the range de�ned by these controls, the Scale effect will be
inapplicable, and the LED light will �ash to indicate that some notes are not being processed
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by the effect, but are playing at their unaltered pitch.

19.6 Velocity

The Velocity Effect.

Velocity re-maps the 127 MIDI note velocity values. The Out Low and Out Hi knobs control
the outgoing velocity (from 1 to 127), which is represented by the Y-axis of the X-Y display.
Incoming velocities that are shown in the display are within the range chosen by the In
Low and In Hi choosers, and are represented on the X-axis. The resulting curve shows how
velocity is being altered by the effect.

If In Low and Out Low are both set to 1, and Out Hi and In Hi are set to 127, the display will
show a straight diagonal line that indicates the equivalent of an effect bypass: Softly played
notes are being output quietly and vice versa. If instead, Out Hi is set to 1 and out Low to
127, the slope of the line will be reversed, and softly played notes will actually produce the
loudest output.

What happens to incoming notes that are outside of the range set with the In Low and In
High controls? This depends on which Mode is selected. Clip Mode does just what it says:
It clips incoming note velocities so that they stay within the range. Gate Mode removes
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incoming notes altogether if their velocities are outside of the range. You will see the little
LED in the effect �ash when a note is blocked by gating. In Fixed Mode, the Out Hi velocity
de�nes all outgoing note velocities, regardless of incoming note velocity.

The Random function adds or subtracts a random value to the all velocities, and is repre-
sented by a gray area on the display curve.

The Drive and Compand controls can be combined to create more complex curves. Com-
pand is a simultaneous expanding and compressing tool. When set to values greater than
0, it forces incoming notes to the outer boundaries of the curve, making them play either
loudly or softly. Compand values of less than 0, on the other hand, force outgoing velocity
toward the mid-range. Drive pushes all values in the curve to the outer extremes. Use these
two controls together to sculpt or even rede�ne the dynamic structure of a piece.



Chapter 20

Live Instrument Reference

Live comes with a selection of custom-designed, built-in instruments. The �Working with
Instruments and Effects� chapter explains the basics of using instruments in Live.
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20.1 Impulse

The Impulse Instrument.

Impulse is a drum sampler with complex modulative capabilities. The eight drum samples
loaded into Impulse's sample slots can be time-stretched, �ltered and processed by enve-
lope, saturation, pan and volume components, nearly all of which are subject to random
and velocity-based modulation.

20.1.1 Sample Slots

Samples are dragged and dropped into Impulse's eight sample slots from the Browser or the
Session and Arrangement Views. Samples can be deleted with your computer keyboard's
Backspace/Delete key.

Imported samples are automatically mapped onto your MIDI keyboard, providing that it is
plugged in and acknowledged by Live. C3 on the keyboard will trigger the leftmost sample,
and the other samples will follow suit in the octave from C3 to C4. Impulse's eight slots
will appear labeled in the MIDI Editor's key tracks when the �Fold� button is active, even if
the given key track is void of MIDI notes. Mapping can be transposed from the default by
applying a Pitch device, or it can be rearranged by applying a Scale device.
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Each of the eight samples has a proprietary set of parameters, located in the area below the
sample slots and visible when the sample is clicked. Adjustments to sample settings are only
captured once you hit a new note � they do not affect currently playing notes. Note that
this behavior also de�nes how Impulse reacts to parameter changes from clip envelopes or
automation, which are applied once a new note starts. If you want to achieve continuous
changes as a note plays, you may want to use the Simpler.

Slot 8's parameters also include a �Link� button, located in the lower left corner, which links
slot 8 with slot 7. Linking the two slots allows slot 7's activation to stop slot 8's playback, and
vice versa. This was designed with a speci�c situation in mind (but can, of course, be used
for other purposes): Naturalistic closed hi-hat cymbals will shut down open hi-hat cymbals.

Each slot can be played, soloed or muted using controls that appear when the mouse hovers
over it.

20.1.2 Start, Tune and Stretch

The Start control de�nes where Impulse begins playing a sample, and can be set to up
to 100 ms later than the actual sample beginning. The Transposition control adjusts the
transposition of the sample by +/- 48 semitones, and can be modulated by incoming note
velocity or a random value, as set in the appropriate �elds.

The Stretch control has values from -100 to 100 percent. Negative values will shorten the
sample, and positive values will stretch it. Two different stretching algorithms are available:
Mode A is ideal for low sounds, such as toms or bass, while Mode B is better for high sounds,
such as cymbals. The Stretch value can also be modulated by MIDI note velocity.
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20.1.3 Filter

The Filter section offers a broad range of �lter types, each of which can impart different
sonic characteristics onto the sample by removing certain frequencies. The Frequency
control de�nes where in the harmonic spectrum the �lter is applied; the Resonance control
boosts frequencies near the points in the spectrum where frequencies are excluded by
�ltering. Filter Frequency can be modulated by either a random value or by MIDI note
velocity.

20.1.4 Saturator and Envelope

The Saturator gives the sample a fatter, rounder, more analog sound, and can be switched
on and off using the appropriate switch. The Drive control boosts the signal and adds
distortion. Note: Turning Drive up makes almost every signal get much louder, and so will
usually require that volume be lowered manually. Extreme Drive settings on low-pitched
sounds will produce the typical, overdriven analog synth drum sounds.

The envelope can be adjusted using the Decay control, which can be set to a maximum of
60.0 seconds. Impulse has two decay modes: Trigger Mode allows the sample to decay with
the note; Gate Mode forces the envelope to wait for a note off message before beginning
the decay. This mode is useful in situations where you need variable decay lengths, as is the
case with hi-hat cymbal sounds.

20.1.5 Pan and Volume

Each sample has Volume and Pan controls that adjust amplitude and stereo positioning,
respectively. Both controls can be modulated, Pan by velocity and a random value, and
Volume by velocity only.
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20.1.6 Global Parameters

The parameters located to the right of the sample slots are global controls that apply to all
samples within Impulse's domain. Volume adjusts the overall level of the instrument, and
Pitch adjusts the transposition of all notes. The Time control governs the time-stretching
and decay of all samples, allowing you to morph between short and stretched drum sounds.

20.1.7 Individual Outputs

When a new instance of Impulse is dragged into a track, its signal will be mixed with those
of the other instruments and effects feeding the audio chain of the track. It can oftentimes
make more sense to isolate the instrument or one of its individual drum samples, and send
this signal to a separate track. Please see the Routing chapter to learn how to accomplish
this for Impulse's overall signal or for Impulse's individual sample slots.

20.2 Simpler

The Simpler Instrument.
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Simpler is an instrument that integrates the basic elements of a sampler with a set of classic
synthesizer parameters. A Simpler voice plays a user-de�ned sample section, which is in
turn processed by envelope, �lter, LFO, volume and pitch components.

20.2.1 Sample View

The Sample View displays the sample waveform. Samples can be dragged into Simpler
either directly from the Browser, or from the Session or Arrangement View in the form of
clips. In the latter case, Simpler will utilize only the section of the sample demarcated by
the clip's start/end or loop markers. Samples can be replaced by dragging in a new sample.

20.2.2 Sample Controls

Simpler plays a speci�c region or loop of the sample, as determined by a group of sample
controls.

The Start and Length controls work together to specify where Simpler begins and ends its
sweep of the sample. As the name implies, Start de�nes where sample playback starts.
The sample will play for the length de�ned by the Length parameter. Both parameters are
de�ned as a percentage of the whole region, so setting start to 25 percent and length to
50 percent, for example, will start playback 1/4 of the way through the sample and stop
playback at the 3/4 mark (using 50 percent of the sample).

Samples are played by Simpler as one-shots or as loops, depending on whether or not the
Loop switch is active. When looping is active, the Loop control dictates the length of the
loop, starting from the end of the playing sample. Simpler will play the �rst instance of a
looped sample beginning with the Start point, then continue playing only the length of the
loop.

It is possible for glitches or pops to occur between a looped sample's start and end points
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due to the discontinuity in waveform amplitude (i.e., the sample's loudness). The Snap
switch will help mitigate these by forcing Simpler's loop markers to snap to zero-crossing
points in the sample (points where the amplitude is zero). Note: Snapping is based on the
left channel of stereo samples. It is therefore still possible, even with Snap activated, to
encounter glitches in the right channel of a stereo sample.

You can also smooth the transition from loop end to loop start by using the Fade control,
which crossfades the two points. This method is especially useful when working with long,
textural samples.

20.2.3 Zoom

Quite often, one starts with a longer region of a sample and ends up using only a small part
of it. Simpler's two Zoom buttons (�+� and �-�) allow you to zoom in around the selected
length, or zoom out to access a larger area. When zooming in on small portions of long
samples, it will probably be necessary to repeatedly shrink the highlighted sample region,
as Simpler will zoom no further than the length of this region. Note: After zooming in, the
Start, Loop and Length parameters will be resized so that there is no audible difference.
This means that the Start and Length values are altered by zooming, and automation or clip
envelopes utilizing these parameters will behave differently after the operation.

20.2.4 Envelope

Simpler contains the classic ADSR Envelope section, as seen in most synthesizers, for shaping
the dynamic structure of the sample. It also has two additional envelopes, one for the �lter
and one for pitch, which are available by toggling the respective buttons in the envelope
section. Attack controls the time in milliseconds that it takes for the envelope to reach
its peak value after a note is played. Decay controls the amount of time it takes for the
envelope to drop down to the Sustain level, which is held until the note is released. Release
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time is the amount of time after the end of the note that it takes for the envelope to drop
from the Sustain level back down to zero.

The in�uence of envelopes on pitch and �lter cutoff can be decided using the envelope
amount controls in each of these sections.

20.2.5 Filter

The Filter section offers classic 12 dB or 24 dB low-pass, band-pass and high-pass �lters, as
well as a notch �lter, each of which can impart different sonic characteristics onto the sample
by removing certain frequencies from the waveform. The most important parameters are
the typical synth controls Frequency and Resonance. Frequency determines where in the
harmonic spectrum the �lter is applied; Resonance boosts frequencies near the points in
the spectrum where frequencies are excluded by �ltering.

The best way to understand the effects of these controls is to play with them...

The Frequency parameter can be modulated by an LFO, note velocity and an envelope �
each of which have an amount control in the Filter section. The Key (tracking) control allows
for shifting the �lter's frequency according to note pitch.

20.2.6 LFO

The LFO (low-frequency oscillator) section offers square, sine, triangle, sawtooth up, saw-
tooth down and random waveforms. The main control in this section is the Rate control,
which changes the LFO frequency within a range of 0.05 to 30 Hz. LFOs are applied individ-
ually to each voice, or played note, in Simpler. Square, triangle and sawtooth LFOs restart
each time a new voice is played, while sine and random do not. The Key parameter changes
the de�nition of each LFO's Rate as a function of the pitch of incoming notes. A high Key
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setting assigns higher notes a higher LFO rate. If Key is set to zero, all voices' LFOs have
the same rate and may just differ in their phase.

The LFO will modulate the �lter, pitch, panorama and volume according to the setting of
the LFO amount controls in each of these sections.

The time taken for the LFO to reach normal level can be set with the Attack control.

20.2.7 Pitch, Pan, Volume and Voices

Simpler plays back a sample at its original pitch if the incoming MIDI note is C3, however the
Transpose control allows transposing this by +/- 48 semitones. Pitch can also be modulated
by an LFO or pitch envelope using the amount controls in this section. The pitch envelope is
especially helpful in creating percussive sounds. Simpler reacts to pitch bend MIDI messages
with a sensitivity of +/- 5 semitones. You can also modulate the Transpose parameter with
clip envelopes and external controllers.

The Voices parameter sets the maximum number of voices that Simpler can play simultane-
ously. If more voices are trying to play than what you have allocated with the Voice control,
�voice stealing� will take place, in which the oldest voice(s) will be dropped in favor of those
that are new. For example, if your Voices parameter is set to 8, and ten voices are all vying to
be played, the two oldest voices will be dropped. (Simpler does try to make voice stealing
as subtle as possible.) A small LED near the Voices control �ashes when a voice has been
stolen.

Panorama can be set with the Pan control, and this control can be further affected by a
random factor or modulated by the LFO.

Finally, the output volume of Simpler is controlled by the Volume control, and can also be
dependent upon note velocity, as adjusted by the Velocity control. Tremolo effects can be
achieved by increasing the in�uence of the LFO over volume with the respective control.
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20.2.8 Glide and Spread

Simpler includes a polyphonic glide function. When this function is activated, new notes
will start with the pitch of the last note played and then slide gradually to their own played
pitch. Glide can be turned on or off and adjusted with the Glide Time control.

Simpler also offers a special Spread parameter that creates a rich stereo chorus by using
two voices per note and panning one to the left and one to the right. The two voices are
detuned, and the amount of detuning can be adjusted with the Spread control.

Tip: Whether or not spread is applied to a particular note depends upon the setting of
the Spread parameter during the note-on event. To achieve special effects, you could, for
instance, create a sequence where Spread is 0 most of the time and turned on only for some
notes. These notes will then play in stereo, while the others will play mono.

20.2.9 Strategies for Saving CPU Power

Real-time synthesis needs lots of computing power. However, there are strategies for
reducing CPU load. Save the CPU spent on Simpler by doing some of the following:

� Turn off the Filter if it is not needed.

� Use �lter types that are less expensive when possible. A �lter's cost correlates with the
steepness of its slope � a �LP 24� is more expensive than a �LP 12.�

� Turn off the LFO for a slightly positive in�uence on CPU.

� Stereo samples need signi�cantly more CPU than mono samples, as they require twice
the processing.

� Decrease the number of simultaneously allowed voices with the Voice control.
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20.3 Operator

The Operator
Instrument.

Operator is an advanced and �exible synthesizer that combines the concept of �frequency
modulation� (FM) with classic subtractive synthesis. It utilizes four multi-waveform oscillators
that can modulate each other's frequencies, creating very complex timbres from a limited
number of objects. Operator includes a �lter section, an LFO and global controls, as well
as individual envelopes for the oscillators, �lter, LFO and pitch.

The full version of Operator is not included with the standard version of Live, but is a special
feature available for purchase separately. For details, please visit the Ableton webshop1,
where you will be offered the opportunity to buy Operator online. Once you have purchased
Operator, you will need to unlock it before using it, as described in the chapter on unlocking.

20.3.1 General Overview

The interface of Operator consists of two parts: the display surrounded on either side by
the shell. The shell offers the most important parameters in a single view and is divided into

1http://www.ableton.com/shop

http://www.ableton.com/shop
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eight sections. On the left side, you will �nd four oscillator sections, and on the right side
from top to bottom, the LFO, the �lter section, the pitch section and the global parameters.
If you change one of the shell parameters, the display in the center will automatically show
the details of the relevant section. When creating your own sounds, for example, you can
conveniently access the level and frequency of all oscillators at once via the shell, and then
adjust each individual oscillator's envelope, waveform and other parameters in its display.

Operator can be folded with the triangular button at its upper left. This is convenient if you
do not need to access the display details.

Operator Folded.

Each of Operator's oscillators can either output its signal directly or use its signal to modulate
another oscillator. Operator offers nine prede�ned algorithms that determine how the
oscillators are connected. An algorithm is chosen by clicking on one of the structure icons
in the global display, which will appear if the bottom right (global) section of the shell is
selected. Signals will �ow from top to bottom between the oscillators shown in an algorithm
icon.



20.3. OPERATOR 295

Operator's Global
Display.

Typically, FM synthesis makes use of pure sine waves, creating more complex waveforms
via modulation. However, in order to simplify sound design and to create a wider range of
possible sounds, we designed Operator to produce a variety of other waveforms, including
noise. The instrument is made complete with an LFO, a pitch envelope and a �lter section.
Note that lots of �classic� FM synthesizers create fantastic sounds without using �lters at
all, so we suggest exploring the possibilities of FM without the �lter at �rst, adding it later
if necessary.

Operator will keep you busy if you want to dive deep into sound design! If you want to break
the universe apart completely and reassemble it, you should also try modulating Operator's
controls with clip envelopes or track automation.
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20.3.2 Oscillator Section and Aliasing

Oscillator D's Display
and Shell Parameters.

The oscillators can basically play back �ve waveform types � sine, square, sawtooth, triangle
and noise � as chosen from the Wave chooser in the individual oscillator displays. The �rst of
these waveforms is a pure, mathematical sine wave, which is usually the �rst choice for many
FM timbres. Since FM synthesis has a long tradition in hardware synthesizers, we added
some variations of the pure sine wave that allow for more realistic modeling of vintage digital
synthesizers. The differences between these sine waves are very subtle, and whether or not
they are audible is highly dependant upon the individual sound. We also added �Sine 4 Bit�
and �Sine 8 Bit� to provide the retro sound adored by C64 fans, and �Saw D� and �Square
D� digital waveforms, which are especially good for digital bass sounds. Another special
case is the noise waveform. This is not real noise, generated by a random generator, but a
looping noise sample. For more �statistical� noise, one could modulate the noise oscillator
with another oscillator, or with real noise from the LFO. The square, triangle and sawtooth
waveforms are resynthesized approximations of the ideal shape. The numbers included in
the displayed name (e.g., �Sq6�) de�ne how many harmonics are used for the resynthesis.
Lower numbers sound mellower and are less likely to create aliasing when used on high
pitches.

Hint: Oscillator waveforms can be copied and pasted from one oscillator to another using
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the (PC) / Ctrl (Mac) context menu.

Aliasing distortion is a common side effect of all digital synthesis and is the result of the
�nite sample rate and precision of digital systems. It mostly occurs at high frequencies. FM
synthesis is especially likely to produce this kind of effect, since one can easily create sounds
with lots of high harmonics. This also means that more complex oscillator waveforms, such
as �Saw32,� tend to be more sensitive to aliasing than pure sine waves. Aliasing is a two-
fold beast: A bit of it can be exactly what is needed to create a cool sound, and a bit too
much can make the timbre unplayable, as the perception of pitch is lost when high notes
suddenly fold back into arbitrary pitches. The Tone parameter in the global section allows
for controlling aliasing. Its effect is sometimes similar to a low-pass �lter, but this depends
on the nature of the sound itself and cannot generally be predicted. If you want to familiarize
yourself with the sound of aliasing, turn Tone up fully and play a few very high notes. You
will most likely notice that some notes sound completely different from other notes. Now,
turn Tone down and the effect will be reduced, but the sound will be less bright.

The frequency of an oscillator can be adjusted in the shell with its Coarse and Fine controls.
An oscillator's frequency usually follows that of played notes, but for some sounds it might
be useful to set one or more oscillators to �xed frequencies. This can be done for each
individual oscillator by activating the Fixed option. This allows the creation of sounds in
which only the timbre will vary when different notes are played, but the tuning will stay the
same. Fixed Mode would be useful, for example, in creating live drum sounds. Fixed Mode
also allows producing very low frequencies down to 0.1 Hz. Note that when Fixed Mode is
active, the frequency of the oscillator is controlled in the shell with the Frequency (Freq) and
Multiplier (Multi) controls.

Operator includes a special Osc<Vel control for each oscillator that allows altering frequency
as a function of velocity. This feature can be very useful when working with sequenced
sounds in which the velocity of each note can be adjusted carefully. Part of this functionality
is the adjacent quantize control. If this control is activated, the frequency will only move in
whole numbers, just as if the Coarse control were being manually adjusted. If quantize is
not activated, the frequency will be shifted in an unquantized manner, leading to detuned
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or inharmonic sounds (which very well could be exactly what you want...).

The amplitude of an oscillator depends on the Level setting of the oscillator in the shell and
on its envelope, which is shown in its display and can be adjusted from there. It can also
be modi�ed by note velocity and note pitch with the Level<Vel and Level<Key parameters
available in the lower portion of each oscillator's display.

The phase of each oscillator can be adjusted using the Phase control in its display.

As explained earlier oscillators can modulate each other when set up to do so with the
global display's algorithms. When an oscillator is modulating another oscillator, two main
properties de�ne the result: the amplitude of the modulating oscillator and the frequency
ratio between both oscillators. Note that Oscillator D can modulate itself via the Feedback
parameter available in its display.

20.3.3 LFO Section

Operator's LFO
Parameters.

The LFO in Operator can practically be thought of as a �fth oscillator. It runs at an audio rate,
and it modulates the frequency of the other oscillators. It is possible to switch modulation by
the LFO on or off for each individual oscillator (and the �lter) using the Destination buttons
in the LFO's display. The LFO can also be turned off if it is unused.
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The LFO offers a choice of classic LFO waveforms, sample and hold (S&H), and noise.
Sample and hold uses random numbers chosen at the rate of the LFO, creating the random
steps useful for typical retro-futuristic sci-� sounds. The noise waveform is simply band-
pass-�ltered noise.

Tip: FM synthesis can be used to create fantastic percussion sounds, and using the LFO
with the noise waveform is the key to great hi-hats and snares.

The frequency of the LFO is determined by the LFO Rate control in the shell, as well as the
low/high setting of the adjacent LFO Range switch. The frequency of the LFO can follow
note pitch, be �xed or be set to something in between. This is de�ned by the Rate<Key
parameter in the LFO's display.

The intensity of the LFO is set by the LFO Mod control in the shell. This parameter can be
modulated by note velocity via the display's Amt<Vel control. The LFO's intensity is also
affected by its envelope.

20.3.4 Envelopes

Operator has seven envelopes: one for each oscillator, a �lter envelope, a pitch envelope
and an envelope for the LFO. All envelopes are constructed similarly and feature some
special looping modes.

An envelope's shape is de�ned by six parameters: three rates and three levels. A rate is the
time it takes to go from one level to the next. For instance, a typical pad sound starts with
the initial level �-inf dB� (which is silence), moves with an attack rate to its peak level, moves
from there to the sustain level with a decay rate, and then �nally, after note-off occurs,
back to �-inf dB� at the release rate. Operator's display provides a good overview of the
actual shape of any particular envelope and lets you directly adjust the curve by clicking and
dragging.

Hint: Envelope shapes can be copied and pasted from one place to another in Operator
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using the (PC) / Ctrl (Mac) context menu.

With FM synthesis, it is possible to create spectacular, endless, permuting sounds; the key
to doing this is looping envelopes. Loop Mode can be activated in the lower left corner of
the display. If an envelope in Operator is in Loop Mode and reaches sustain level while the
note is still being held, it will be retriggered. The rate for this movement is de�ned by the
Loop Time parameter. (Note that envelopes in Loop Mode can loop very quickly and can
therefore be used to achieve effects that one would not normally expect from an envelope
generator.)

While Loop Mode is good for textures and experimental sounds, Operator also includes Beat
and Sync Modes, which provide a simple way of creating rhythmical sounds. If set to Beat
Mode, an envelope will restart after the beat time selected from the Repeat chooser. In Beat
Mode, the repeat time is de�ned in fractions of song time, but notes are not quantized.
If you play a note a bit out of sync, it will repeat perfectly but stay out of sync. In Sync
Mode however, the �rst repetition is quantized to the nearest 16th note and, as a result, all
following repetitions are synced to the song tempo. Note that Sync Mode only works if the
song is playing, and otherwise it will behave like Beat Mode.

Note: To avoid the audible clicks caused by restarting from its initial level, a looped envelope
will restart from its actual level and move with the set attack rate to peak level.

The rates of all the envelopes in Operator can be scaled in unison by the Time control in
the global section of the shell. Note that beat-time values in Beat and Sync Modes are not
in�uenced by the global Time parameter. Envelope rates can be further modi�ed by note
pitch, as dictated by the Time<Key parameter in the global section's display. The rate of an
individual envelope can also be modi�ed by velocity using the Time<Vel parameter. These
modulations in conjunction with the loop feature can be used to create very, very complex
things...

The pitch envelope can be turned on or off for each individual oscillator and for the LFO
using the Destination A-D and LFO buttons in its display. It can also be turned off altogether
via the pitch section of the shell. The pitch envelope amount is adjusted with the adjacent
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Pitch Env control.

Tip: If the pitch envelope is only applied to the LFO and is looping, it can serve as another
LFO, modulating the rate of the �rst. And, since the envelope of the LFO itself can loop, it
can serve as a third LFO modulating the intensity of the �rst!

20.3.5 Filter Section

Operator's Filter Section.

As mentioned earlier, the �lters are not the main focus of this instrument. However, they
can be very useful for modifying the sonically rich timbres created by the oscillators. And,
since the oscillators also provide you with the classic waveforms of analog synthesizers, you
can very easily build a subtractive synthesizer with them.

The �lter section offers 12 dB low-pass, band-pass, high-pass and notch �lters. Note that
the notch �lter is not of true notch �lter design but a bell-shaped curve with very low gain,
which removes more of the frequencies around the center.

Filter cutoff frequency and resonance can be adjusted in the shell. Filter frequency can also
be modulated by note velocity, note pitch, the LFO and the �lter envelope. The Freq<Vel,
Freq<Key and Envelope controls in the �lter's display set these three functions, respectively.
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20.3.6 Global Controls

The maximum number of Operator voices (notes) playing simultaneously can be adjusted
with the Voices parameter in the global display. Ideally, one would want to leave this setting
high enough so that no voices would be turned off while playing, however a setting between
6 and 12 is usually more realistic when considering CPU power.

Tip: Some sounds should play monophonically by nature, which means that they should
only use a single voice. (A �ute is a good example.) In these cases, you can set Voices to 1.
If Voices is set to 1, another effect occurs: Overlapping voices will be played legato, which
means that the envelopes will not be retriggered from voice to voice, and only pitch will
change.

A high quality setting (HiQ) can be switched on and off in the global display, controlling the
interpolation algorithm of the oscillators and LFO. This setting will affect the sound of some
waveforms more than others (especially the noise waveform) and also affects CPU resources.

Global Volume and Transpose controls for the instrument can be found in the global section
of the shell, and a Pan control is located in the global section's display. Pan can be modulated
by a random factor or by note pitch, using the adjacent Rnd and Key controls, respectively.

MIDI pitch bend messages will affect Operator as de�ned by the PB Range control in the
pitch section of the display.
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20.3.7 Glide and Spread

Operator's Pitch Section.

Operator includes a polyphonic glide function. When this function is activated, new notes
will start with the pitch of the last note played and then slide gradually to their own played
pitch. Glide can be turned on or off and adjusted with the Glide Time control in the pitch
display.

Operator also offers a special Spread parameter that creates a rich stereo chorus by using
two voices per note and panning one to the left and one to the right. The two voices are
detuned, and the amount of detuning can be adjusted with the Spread control in the pitch
section of the shell.

Tip: Whether or not spread is applied to a particular note depends upon the setting of
the Spread parameter during the note-on event. To achieve special effects, you could, for
instance, create a sequence where Spread is 0 most of the time and turned on only for some
notes. These notes will then play in stereo, while the others will play mono.



20.3. OPERATOR 304

20.3.8 Strategies for Saving CPU Power

If you want to save CPU power, turn off features that you do not need or reduce the number
of voices. Speci�cally, turning off the �lter or the LFO if they do not contribute to the sound
will save CPU power.

For the sake of saving CPU resources, you will also usually want to reduce the number of
voices to something between 6 and 12, and carefully use the Spread feature. The high
quality setting can also be turned off to conserve CPU resources.

Note that turning off the oscillators will not save CPU power.

20.3.9 Finally...

Operator is the result of an intense preoccupation with FM synthesis and a love and dedi-
cation to the old hardware FM synthesizers, such as the Yamaha SY77, the Yamaha TX81Z
and the NED Synclavier II. FM synthesis was �rst explored musically by the composer and
computer music pioneer John Chowning in the mid-1960s. In 1973, he and Stanford Uni-
versity began a relationship with Yamaha that lead to one of the most successful commercial
musical instruments ever, the DX7.

John Chowning realized some very amazing and beautiful musical pieces based on a syn-
thesis concept that you can now explore yourself simply by playing with Operator in Live.

We wish you loads of fun with it!

20.3.10 The Complete Parameter List

The function of each Operator parameter is explained in the forthcoming sections. Remem-
ber that you can also access explanations of controls in Live (including those belonging to
Operator) directly from the software by placing the mouse over the control and reading the
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text that appears in the Info View. Parameters in this list are grouped into sections based
on where they appear in Operator.

Global Shell and Display

Time- This is a global control for all envelope rates.

Tone- Operator is capable of producing timbres with very high frequencies, which can
sometimes lead to aliasing artifacts. The Tone setting controls the high frequency content
of sounds. Higher settings are typically brighter but also more likely to produce aliasing.

Volume- This sets the overall volume of the instrument.

Algorithm- An oscillator can modulate other oscillators, be modulated by other oscillators,
or both. The algorithm de�nes the connections between the oscillators and therefore has a
signi�cant impact on the sound that is created.

Voices- This sets the maximum number of notes that can sound simultaneously. If more
notes than available voices are requested, the oldest notes will be cut off.

High Quality (HiQ)- This changes the interpolation algorithm of the oscillators and the LFO.
If turned off, some timbres will sound more rough, especially the noise waveform. Turning
this off will also save some CPU power.

Time<Key- The rates of all envelopes can be controlled by note pitch. If the global Time<Key
parameter is set to higher values, the envelopes run faster when higher notes are played.

Pan- Use this to adjust the panorama of each note. This is especially useful when modulated
with clip envelopes.

Pan<Key (Key)- If Pan<Key is set to higher values, low notes will pan relatively more to the
left channel, and higher notes to the right. Typically this is used for piano-like sounds.

Pan<Random (Rnd)- This de�nes the extent to which notes are randomly distributed between
the left and right channels.
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Pitch Shell and Display

Pitch Envelope On- This turns the pitch envelope on and off. Turning it off if it is unused
saves some CPU power.

Pitch Envelope Amount (Pitch Env)- This sets the intensity of the pitch envelope. A value of
100% means that the pitch change is exactly de�ned by the pitch envelope's levels. A value
of -100% inverts the sign of the pitch envelope levels.

Spread- If Spread is turned up, the synthesizer uses two detuned voices per note, one
each on the left and right stereo channels, to create chorusing sounds. Spread is a very
CPU-intensive effect.

Transpose- This is the global transposition setting for the instrument. Changing this param-
eter will affect notes that are already playing.

Pitch Bend Range (PB Range)- This de�nes the effect of MIDI pitch bend messages.

Pitch Envelope Rates<Velocity (Time<Vel)- This parameter exists for �lter, pitch, LFO and
volume envelopes. It is therefore listed in the section on envelopes.

Glide (G)- With Glide on, notes will slide from the pitch of the last played note to their
played pitch. Note that all envelopes are not retriggered in this case if notes are being
played legato.

Glide Time (Time)- This is the time it takes for a note to slide from the pitch of the last
played note to its �nal pitch when Glide is activated. This setting has no effect if Glide is
not activated.

Pitch Envelope to Osc (Destination A-D)- The pitch envelope affects the frequency of the
respective oscillator if this is turned on.

Pitch Envelope to LFO (Destination LFO)- The pitch envelope affects the frequency of the
LFO if this is turned on.
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Filter Shell and Display

Filter On- This turns the �lter on and off. Turning it off when it is unused saves CPU power.

Filter Type- Low-pass, band-pass and high-pass are second order �lters with resonance.
Their names imply the part of the spectrum they affect. The notch �lter passes everything
apart from its center frequency and is more audible with low resonance settings.

Filter Frequency (Freq)- This de�nes the center or cutoff frequency of the �lter. Note that
the resulting frequency may also be modulated by note velocity and by the �lter envelope.

Filter Resonance (Res)- This de�nes the resonance around the �lter frequency of the low-pass
and high-pass �lters, and the width of the band-pass and notch �lters.

Filter Frequency<Velocity (Freq<Vel)- Filter frequency is modulated by note velocity accord-
ing to this setting.

Filter Frequency<Key (Freq<Key)- Filter frequency is modulated by note pitch according to
this setting. A value of 100% means that the frequency doubles per octave. The center
point for this function is C3.

Filter Envelope Rates<Velocity (Time<Vel)- This parameter exists for �lter, pitch, LFO and
volume envelopes. It is therefore listed in the section on envelopes.

Filter Frequency<Envelope (Envelope)- Filter frequency is modulated by the �lter envelope
according to this setting. A value of 100% means that the envelope can create a maximum
frequency shift of approximately 9 octaves.

LFO Shell and Display

LFO On- This turns the LFO (low-frequency oscillator) on and off. Turning it off when it is
unused saves some CPU power.
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LFO Waveform- Select from among several typical LFO waveforms. Sample and Hold creates
random steps, and Noise supplies band-pass-�ltered noise. All waveforms are band-limited
to avoid unwanted clicks. Cyclic waveforms restart with each note-on message.

LFO Range- The LFO covers an extreme frequency range. Choose Low for a range from 50
seconds to 30 Hz, or Hi for 8 Hz to 12 kHz. Due to the possible high frequencies, the LFO
can also function as a �fth oscillator.

LFO Rate (Rate)- This sets the rate of the LFO. The actual frequency also depends on the
setting of the LFO Range and the LFO Rate<Key controls.

LFO Amount (Mod)- This sets the intensity of the LFO. Note that the actual effect also
depends on the LFO envelope.

LFO to Osc (Destination A-D)- The LFO modulates the frequency of the respective oscillator
if this is turned on.

LFO Envelope Rates<Velocity (Time<Vel)- This parameter exists for �lter, pitch, LFO and
volume envelopes. It is therefore listed in the section on envelopes.

LFO Rate<Key (Rate<Key)- The LFO's frequency can be a function of note pitch. If this is set
to 100%, the LFO will double its frequency per octave, functioning like a normal oscillator.

LFO Amount<Velocity (Amt<Vel)- This setting adjusts modulation of the LFO intensity by
note velocity.

Oscillators A-D Shell and Display

Osc On- This turns the oscillator on and off.

Osc Coarse Frequency (Coarse)- The relationship between oscillator frequency and note
pitch is de�ned by the Coarse and Fine parameters. Coarse sets the ratio in whole numbers,
creating a harmonic relationship.
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Osc Fine Frequency (Fine)- The relationship between oscillator frequency and note pitch
is de�ned by the Coarse and Fine parameters. Fine sets the ratio in fractions of whole
numbers, creating an inharmonic relationship.

Osc Fixed Frequency On (Fixed)- In Fixed Mode, oscillators do not respond to note pitch
but instead play a �xed frequency.

Osc Fixed Frequency (Freq)- This is the frequency of the oscillator in Hertz. This frequency
is constant, regardless of note pitch.

Osc Fixed Multiplier (Multi)- This is used to adjust the range of the �xed frequency. Multiply
this value with the value of the oscillator's Freq knob to get actual frequency in Hz.

Osc Output Level (Level)- This sets the output level of the oscillator. If this oscillator is
modulating another, its level has signi�cant in�uence on the resulting timbre. Higher levels
usually create bright and/or noisy sounds.

Osc Waveform (Wave)- Choose from a collection of carefully selected waveforms, including
slight derivations of sine waves that are especially useful for creating emulations of vintage
digital hardware synthesizers.

Osc Phase (Phase)- This sets the initial phase of the oscillator. The range represents one
whole cycle.

Osc Frequency<Velocity (Osc<Vel)- The frequency of an oscillator can be modulated by
note velocity. Positive values raise the oscillator's pitch with greater velocities, and negative
values lower it.

Osc Freq<Vel Quantized (Q)- This allows quantizing the effect of the Frequency<Velocity
parameter. If activated, the sonic result is the same as manually changing the Coarse
parameter for each note.

Volume Envelope Rates<Velocity (Time<Vel)- This parameter exists for �lter, pitch, LFO and
volume envelopes. It is therefore listed in the section on envelopes.
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Osc Output Level<Velocity (Vel)- This de�nes how much the oscillator's level depends upon
note velocity. Applying this to modulating oscillators creates velocity-dependent timbres.

Osc Output Level<Key (Key)- This de�nes how much the oscillator's level depends upon
note pitch. The center point for this function is C3.

Osc D Feedback (Feedback)- Osc D can modulate itself. The modulation is dependent not
only on the setting of the feedback control but also on the oscillator level and the envelope.
Higher feedback creates a more complex resulting waveform.

Envelope Display

Envelope Attack Time (Attack)- This sets the time it takes for a note to reach the peak level,
starting from the initial level. The shape of this segment of the envelope is linear.

Envelope Decay Time (Decay)- This sets the time it takes for a note to reach the sustain level
from the peak level. The shape of this segment of the envelope is exponential.

Envelope Release Time (Release)- This is the time it takes for a complete fade-out of a note
after a note-off message is received. The shape of this segment is exponential. The note
will fade out from the value of the envelope at the moment the note-off message occurs,
regardless of which segment is currently active.

Envelope Initial Level (Initial)- This sets the initial value of the envelope.

Envelope Peak Level (Peak)- This is the peak level at the end of the note attack.

Envelope Sustain Level (Sustain)- This is the sustain level at the end of the note decay. The
envelope will stay at this level until note release unless it is in Loop, Sync or Beat Mode.

Envelope Mode (Mode)- If this is set to Loop, the envelope will start again after the end of
the decay segment. If set to Beat or Sync, it will start again after a given beat-time. In Sync
Mode, this behavior will be quantized to song time.
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Envelope Beat/Sync Rate (Repeat)- The envelope will be retriggered after this amount of
beat-time, as long as it is still on. When retriggered, the envelope will move at the given
attack rate from the current level to the peak level.

Envelope Loop Time (Time)- If a note is still on after the end of the decay/sustain segment,
the envelope will start again from its initial value. The time it takes to move from the sustain
level to the initial value is de�ned by this parameter.

Envelope Rates<Velocity (Time<Vel)- Envelope segments will be modulated by note velocity
as de�ned by this setting. This is especially interesting if the envelopes are looping. Note
that this modulation does not in�uence the beat-time in Beat or Sync Modes, but the
envelope segments themselves.



Chapter 21

MIDI and Key Remote Control

To liberate the musician from the mouse, most of Live's controls can be remote-controlled
with an external MIDI controller and the computer keyboard. This chapter describes the
details of mapping to the following speci�c types of controls in Live's user interface:

1. Session View slots. Note that MIDI and computer key assignments are bound to
the slots, not to the clips they contain.

2. Switches and buttons, among them the Track and Device Activator switches, the
Control Bar's tap tempo, metronome and transport controls.

3. Radio buttons. A radio button selects from among a number of options. One
instance of a radio button is the crossfader assignment section in each track,
which offers three options: The track is assigned to the crossfader's A position,
the track is unaffected by the crossfader, or the track is affected by the crossfader's
B position.
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4. Continuous controls, like the mixer's volume, pan and sends.

5. The crossfader, the behavior of which is described in detail in the respective
section of this manual.

21.1 Keyboard Remote Control

The Key Map Mode
Switch.

Creating remote-control assignments for your computer keyboard is straightforward:

1. Enter Key Map Mode by pressing the KEY switch in the upper right-hand corner
of the Live screen. Notice that assignable elements of the interface become
highlighted when you enter Key Map Mode.

2. Click on the Live control you wish to assign to a key.

3. Press the key to which you wish to assign the control.

4. Leave Key Map Mode by again pressing the Key Map Mode switch.

Keyboard assignments can be deleted using your computer's Backspace or Delete key while
Key Map Mode is active.

Keyboard assignments will be implemented by Live in the following ways:

� Clips in Session View slots will be affected by mapped keys according to their Launch
Mode settings.

� Keys assigned to switches will toggle switch states.

� Keys assigned to radio buttons will toggle through the available options.
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Please be sure not to confuse keyboard remote-control functionality with Live's ability to
use the keyboard as a pseudo-MIDI device that can generate MIDI notes from computer
keystrokes for use with instruments.

21.2 MIDI Remote Control

Live can be controlled remotely with an external MIDI device such as a keyboard or controller
box. Live also supports Mackie Control, a topic that is covered in a separate chapter in this
manual, for completely mouse-free program operation.

Before we explain how remote-control assignments are made and implemented, let us �rst
make the distinction between MIDI remote control and a separate use of MIDI in Live:
input for MIDI tracks. Let's say that you are, for instance, using a MIDI keyboard to play an
instrument in one of Live's MIDI tracks. If you assign F2 on your MIDI keyboard to a Session
View Clip Launch button, that key will cease play F2 on your MIDI track's instrument, as it
now �belongs� solely to the Clip Launch button.

MIDI keys that become part of remote-control assignments can no longer be used as input
for MIDI tracks.

This is a common cause of confusion that can be easily resolved by looking at the Control
Bar's MIDI indicators.

21.2.1 MIDI Remote Input and Output

Before making any MIDI assignments, you must �rst set up Live to recognize whichever MIDI
device(s) you are using for remote control. This is done in the MIDI/Sync tab of the Live
Preferences, where you can select devices for remote-control input and output.
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The �Active Devices� table lists all available input and output MIDI devices. To use a device
for remote mapping, make sure the corresponding switch in the �Remote� column is set to
On. You can use any number of MIDI devices for remote mapping; Live will merge their
incoming MIDI.

When Live recognizes a MIDI message, the Control Bar's MIDI In indicator will �ash.

Selecting a MIDI Device
for Remote Control.

Turn external devices on for remote control in the Output section when working with con-
troller boxes that use endless knobs or motorized faders. These devices need to be updated
when a control's value changes in Live, because the position of the motorized faders or LED
chains has to match the new value.

21.2.2 Assigning MIDI Remote Control

The MIDI Map Mode
Switch.

Once your remote-control setup has been �nished in the Preferences, giving MIDI controllers
and notes remote-control assignments is simple:

1. Enter MIDI Map Mode by pressing the MIDI switch in the upper right-hand
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corner of the Live screen. Notice that assignable elements of the interface
become highlighted.

2. Click on the Live control you wish to assign to MIDI.

3. Send a MIDI message by pressing a keyboard key, turning a knob, etc., on your
MIDI controller. To assign a Session slot to a MIDI note range for chromatic
playing, �rst play the root key (this is the key that will play the clip at the default
transposition), then, while holding down the root key, press keys below or above
the root to de�ne the limits of the range.

4. Leave MIDI Map Mode by again pressing the MIDI Map Mode switch.

MIDI assignments can be deleted using your computer's Backspace or Delete key while
MIDI Map Mode is active.

21.2.3 Mapping to MIDI Notes

MIDI notes send simple on/off messages to Live's interface elements. MIDI note-on and
note-off messages have the following effects on controls in Live:

� Session View Slots- Note-on and note-off messages affect clips in the slot according
to their Launch Mode settings.

� Switches- A note-on message toggles the switch state.

� Radio Buttons- Note-on messages toggle through the available options.

21.2.4 Mapping to Absolute MIDI Controllers

Absolute MIDI controllers send messages to Live in the form of absolute values ranging
from 0 to 127. These values lead to different results depending on the type of Live control
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to which they are assigned. A value message of 127, for example, might turn the Volume
control on a Live track all the way up or play a Session View clip. Speci�cally, MIDI-controller
messages from 0 to 127 have the following effects on controls in Live:

� Session View Slots- Controller values above 63 are treated like note-on messages.
Controller values below 64 are treated like note-off messages.

� Switches- Controller values 64 and above turn the switch on. Controller values below
64 turn it off.

� Radio Buttons- The controller's 0...127 value range is mapped onto the range of
available options.

� Continuous Controls- The controller's 0...127 value range is mapped onto the param-
eter's range of values.

Live also supports pitch bend messages and high-precision controller messages with a
0...16383 value range. The above speci�cations apply to pitch bend and high-precision
controllers as well, except that the value range's center is at 8191/8192.

21.2.5 Mapping to Relative MIDI Controllers

Some MIDI controllers can send �value increment� and �value decrement� messages instead
of absolute MIDI messages. These controls prevent parameter jumps when the state of a
control in Live and the corresponding control on the hardware MIDI controller differ. For
example, imagine that you have assigned the pan knob on your controller box to the pan
control in a Live track. If the hardware control is panned hard right, and the Live control is
panned hard left, a slight movement in a hardware pan knob that sends absolute messages
would tell Live to pan right, causing an abrupt jump in the track's panning. A pan knob
sending relative messages would prevent this, since its incremental message to Live would
simply say, �Pan slightly left.�



21.2. MIDI REMOTE CONTROL 318

There are several types of relative controllers: Signed Bit, Signed Bit 2, Bin Offset and Twos
Complement. Live can recognize the type of relative controller you are working with as you
make remote-control assignments, and you can help this by moving the relative controller
knob slowly to the left when you make the assignment. If you know the relative controller
type, you can manually select it in the chooser that appears in the Status Bar at the bottom
of the Live screen while mapping a Live control.

Live will do the following with relative MIDI-controller messages:

� Session View Slots- Value increment messages are treated like note-on messages.
Value decrement messages are treated like note-off messages.

� Switches- Increment messages turn the switch on. Decrement messages turn it off.

� Radio Buttons- Increment messages make the radio button jump forward to the next
available option. Decrement messages make it jump backward.

� Continuous Controls- Each type of relative MIDI controller uses a different interpre-
tation of the 0...127 MIDI-controller value range to identify value increments and
decrements:

Convention (Mode) Increment Decrement
Relative (Signed Bit) 001�064 065�127
Relative (Signed Bit 2) 065�127 001�064
Relative (Bin Offset) 065�127 063�001
Relative (2's Comp.) 001�064 127�065

Please consult the documentation that came with your MIDI controller if you need further
information on relative MIDI controllers.
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21.3 Relative Session View Navigation

Notice that you can make not only absolute mappings to individual slots and scenes, but
also relative mappings to move the highlighted scene and operate on the highlighted clips.

In Key or MIDI Map Mode, a strip of assignable controls appears below the Session grid:

1 234

The Relative Session
Mapping Strip.

1. Assign these buttons to keys, notes or controllers to move the highlighted scene
up and down.

2. Assign this scene number value box to a MIDI controller, preferably with an
endless knob, to scroll through the scenes. For details, see the discussion of
Relative Map Modes.

3. Assign this button to launch the highlighted scene. If the Misc Preferences'
�Select Next Scene on Launch� option is checked, you can successively go
through the scenes.

4. Assign these buttons to launch the clip at the highlighted scene, in the respective
track.

Relative session mapping is useful for navigating a large Live Set, as Live always keeps the
highlighted scene at the Session View's center.
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21.4 Mapping to Clip View Controls

The Clip View displays the settings for whichever clip happens to be currently selected.
It might also display settings for a clip multi-selection. In avoiding unpleasant musical
surprises, it is important to remember that creating remote-control mappings for any control
in the Clip View interface could potentially affect any clip in the Live Set. For this reason, we
recommend mapping Clip View controls to relative MIDI controllers to prevent undesirable
jumps in parameter values.



Chapter 22

Mackie Control

The comprehensive Mackie Control mixing surface puts all of Live's real-time creative power
at your �ngertips.

Mackie Control allows for mouse-free program operation and navigation. Through the
bi-directional connection between Live and the Mackie Control, any changes made in the
program are re�ected in the mixing surface, and vice versa. To establish this connection,
open Live's MIDI/Sync Preferences. At the bottom of the window, you will �nd the Remote
Control Surfaces options. Selecting �Mackie Control� from the Control Surface chooser,
and then setting the necessary input and output, will establish the connection between Live
and the control surface.

It is possible to expand the number of Mackie Control channel strips available using a
hardware extension. This extension is separately set up in Live's Preferences (signi�ed by
�MackieControlXT� in the Control Surface chooser). If the Mackie Control extension is
selected from the topmost chooser, it will control the Live tracks beginning at the left-hand
side of the program, and should therefore be placed to the left of the Mackie Control mixing
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surface. If selected from the lower chooser, the Mackie Control extension should be placed
to the right of the main Mackie Control.

The following sections will describe how to operate the Mackie Control with Live. You may
�nd the mixing chapter to be particularly useful in locating and understanding Live's track
controls.
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22.1 Channel Strips

The Eight Channel Strips
and the Master Strip.

The Mackie Control's eight channel strips and master strip are automatically assigned to
tracks in Live. Each of these strips has a set of track controls, including a motorized fader and
a V-Pot, for controlling any number of track parameters. The Mackie Control's bank/channel
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controls allow reassigning the channel strips to access an unlimited number of Live tracks.

1. Arm � By default, this arms the track for recording in exclusion of all other tracks.
To arm the track nonexclusively (i.e., in addition to other tracks), hold down the
Mackie Control's Control button while pressing this. Note that a Misc Preference
setting in Live allows deactivating exclusive track arming. When this setting is
deactivated, the behavior of this knob with respect to exclusive and nonexclusive
arming is reversed.

2. Signal LED � Shows an armed track's input signal level from MIDI or audio; shows
an unarmed track's output signal level.

3. Solo � Activates/deactivates soloing for the track in exclusion of all other tracks.
To solo the track nonexclusively (i.e., in addition to other tracks), hold down the
Mackie Control's Control button while pressing this. Note that a Misc Preference
setting in Live allows deactivating exclusive track soloing. When this setting is
deactivated, the behavior of this knob with respect to exclusive and nonexclusive
soloing is reversed.

4. Mute � Mutes/unmutes the track nonexclusively.

5. Select � Selects the track, both in Live and on the Mackie Control, for various
functions.

6. V-Pot/Fader � The fader controls track volume by default but can be �ipped to
control track panning. Please see the next section for the details on V-Pots.
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22.2 V-Pots and Assignment Switches

The V-Pots and
Assignment Switches.

The Mackie Control's V-Pots have dual functionality in many cases, as they can be both
rotated and pressed. When being used to adjust single parameters (those belonging to
track devices, for example), pressing a V-Pot returns a control to its default value. Pressing a
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V-Pot when dealing with a control that has various options (�lter type choosers, for example),
selects the options in sequence. With controls having only two options (e.g., an on/off
switch) pressing a V-Pot toggles the options.

There are six assignment switches to the right of the channel strips on the Mackie Control.
These select which parameters are displayed in the main display, and set these parameters
to be available for control with the V-Pots. The two-character display above the assignment
switches shows the currently selected assignment mode.

1. I/O � Switches the V-Pot and main display to I/O mode. This allows Live's track
inputs and outputs to be set with the V-Pots.

� Click once to select the track's Input Type chooser.

� Click twice to select the track's Input Channel chooser.

� Click three times to select the Output Type chooser.

� Click four times to select the Output Channel chooser.

2. Send � Switches the V-Pot to control the levels of all available Send controls
for the currently selected track. If more than eight sends are available, you can
navigate through them using the previous and next buttons (see item 5, below).

3. Pan � Assigns the V-Pot and main display to the track's Pan control.

4. Devices � Pressed once, this will bring up all available devices for the currently
selected track in the main display. Using the page buttons (see item 5, below),
you can then scroll through the available devices and choose a particular device
to edit by pressing the V-Pot. When you are done editing device settings, you
can change the selected track or press the device assignment switch again to
return to scrolling and selecting devices.

When device settings are being changed, the name and settings of the selected
device are shown in the main display. You can use the V-Pot to change parameter
values as described in the introduction to this section.
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5. Previous/Next � If, in any of the above assignment modes (especially with de-
vices), more than one page of parameters is available, these buttons will scroll
through the pages. LEDs above these switches illuminate when more pages are
available before or after the current one.
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22.3 Bank/Channel and Flip/Return

Bank, Channel, Flip and
Return Buttons.

1. Bank � If more than eight tracks are being used in Live, these buttons can be
used to page through the additional tracks and set them to the Mackie Control's
eight channel strips. The bank �+� and �-� buttons page the channel strips in
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increments of eight (or more, if a fader extension is installed) to the right or left,
respectively. To go to the �rst/last page, hold down the Mackie Control's Shift
button while pressing these.

2. Channel � You can use the channel �+� and �-� buttons to scroll through the
additional tracks singly, setting them to the Mackie Control's eight channel strips.
To go to the �rst/last track, hold down the Mackie Control's Shift button while
pressing these.

3. Flip � When �ip mode is enabled (as shown by the illuminated LED above the
button), the functionality of the V-Pots and faders is switched. This is the case in
all available assignment modes.

4. Return � By default, the channel strips display only those tracks in Live that
contain clips. When return mode is enabled (as shown by the illuminated LED
above the button), the channel strip will show and control the return tracks. All
assignments and modes will function otherwise identically.
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22.4 Transport

The Transport Controls.

1. Previous/Next Locator � Using these buttons, you can skip forward or backward
through the Arrangement from locator to locator. Note that the Arrangement
start and end are also marked with �invisible� locators to which you can navigate
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using these buttons. The LEDs above these buttons are illuminated when a
previous/next locator is available in the respective direction.

2. Loop On/Off � Toggles the Arrangement Loop switch on/off.

3. Punch-In/Punch-Out � Toggles Live's Punch-In/Punch-Out switches on/off.

4. Home � Jumps to the Arrangement start, 1.1.1.

5. End � Jumps to the Arrangement end.

6. Rew/Forw � When pressed once, these buttons will move the play position one
beat backward/forward. When held down, the buttons move forward/backward
in increments of one bar during Arrangement playback, one beat if the Ar-
rangement is stopped. Holding down the Mackie Control's Alt button when the
Arrangement is playing will also move in one-beat increments forward/backward.

7. Stop � Stops Arrangement playback.

8. Play � Plays the Arrangement from the song start or insert marker.

9. Record � Toggles the Record button on/off.

10. Arrows �

� In the Session View, the arrows navigate through the Session View grid.
Pressing the zoom button in the middle of the arrows will �re the currently
selected clip, or stop another playing clip in the same track if the currently
selected slot is empty. To stop playing the selected clip, hold down the
Mackie Control's Options button while pressing zoom, and use the Alt
button to add/remove the selected slot's Clip Stop button.

Note that the LEDs associated with the zoom buttons will display the play
status of a clip: an illuminated LED signi�es a playing clip; a blinking LED
signi�es a clip that has been triggered but is not yet playing; and an unillu-
minated LED signi�es a stopped clip or empty slot.
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� In the Arrangement View, with the zoom button enabled (i.e., its LED illu-
minated), you can use the arrow buttons for zooming and scrolling in the
currently selected track. When zoom is not enabled, the arrow buttons can
be used to select tracks.

11. Scrub � This �res the currently selected scene in the Session View and has no
effect in the Arrangement View. To stop all running clips, hold down the Mackie
Control's Options button while pressing this.

12. Jog Wheel � In the Session View, the jog wheel scrolls through the scenes. In
the Arrangement View, the jog wheel moves the play position. To change global
quantization, hold down the Mackie Control's Control button while turning the
jog wheel. You can also use the Mackie Control's Alt button in the Arrangement
View to move the play position in smaller increments.
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22.5 Software-Speci�c Controls

The Software-Speci�c
Controls.

1. Shift, Option, Control, Alt � Used to access additional Mackie Control options.

2. SMPTE/Beats � Toggles between displaying beats/bars and SMPTE in the time
display.
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3. Name/Value � Switches the meters in the main display on/off. Note that these
meters appear only when pan assignment mode is active.

4. F-Keys � These keys can be mapped freely to controls in Live.

5. ViewArr (On) � Toggles Arrangement View and Session View. When the Mackie
Control's Shift key is held down, this sets the program focus to the Arrangement
View or Session View, whichever is currently on screen.

6. ToggleDetail (Rec/Rdy) � Toggles Clip View and Track View. When the Mackie
Control's Shift key is held down, this sets the program focus to the Clip View or
Track View, whichever is currently on screen.

7. ViewBrowser (SnapShot) � Shows/hides the Browser. When the Mackie Control's
Shift key is held down, this sets the program focus to the Browser.

8. ViewDetail (Touch) � Shows/Hides the Clip/Track View. When the Mackie Con-
trol's Shift key is held down, this sets the program focus to the Clip View or Track
View, whichever is currently on screen.

9. Undo and Redo � Undoes/redoes the last change made to the Live Set. The LED
will illuminate if there is an available action to undo/redo.

10. BTA (Cancel) � Stops clips in the Session View from playing differently than how
they were recorded into the Arrangement, and returns to playing the Arrange-
ment. The LED will illuminate if there is an Arrangement state available to which
to return.

11. Locator (Marker) � Deletes a locator when a locator is currently selected and the
song is stopped. Otherwise, it creates a new locator at the current play position.

12. DrawMode (Enter) � Enables/disables Draw Mode, for drawing notes and en-
velopes.

13. Follow (Mixer) � Toggles Follow Mode, which scrolls Live's display to follow
playback.



Chapter 23

Synchronization and ReWire

23.1 Synchronizing via MIDI

The MIDI protocol de�nes two ways to synchronize sequencers, both of which are supported
by Live. Both protocols work with the notion of a sync master, which delivers a sync signal
that is tracked by the sync slave(s).

� MIDI Clock. MIDI Clock works like a metronome ticking at a fast rate. The rate of the
incoming ticks is tempo-dependent: Changing the tempo at the sync master (e.g., a
drum machine) will cause the slave to follow the change. The MIDI Clock protocol also
provides messages that indicate the song position. With respect to MIDI Clock, Live
can act as both a MIDI sync master and slave.

� MIDI Timecode. MIDI Timecode is the MIDI version of the SMPTE protocol, the
standard means of synchronizing tape machines and computers in the audio and
�lm industry. A MIDI Timecode message speci�es a time in seconds and frames
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(subdivisions of a second). Live will interpret a Timecode message as a position in the
Arrangement. Timecode messages carry no meter-related information; when slaving
Live to another sequencer using MIDI Timecode, you will have to adjust the tempo
manually. Tempo changes cannot be tracked. Detailed MIDI Timecode preferences
are explained later in this chapter. With respect to MIDI Timecode, Live can only act
as a MIDI sync slave, not a master.

23.1.1 Synchronizing External MIDI Devices to Live

Live can send MIDI Clock messages to an external MIDI sequencer (or drum machine). After
connecting the sequencer to Live and setting it up to receive MIDI sync, turn the device on
as a sync destination in Live's MIDI Preferences.

Choosing a MIDI Slave
for Live.

The lower indicator LED next to the Control Bar's EXT button will �ash when Live is sending
sync messages to external sequencers.

23.1.2 Synchronizing Live to External MIDI Devices

Live can be synchronized via MIDI to an external sequencer. After connecting the sequencer
to Live and setting it up to send sync, use Live's MIDI Preferences to tell Live about the
connection.
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Setting up Live as a MIDI
Slave.

Then, activate external sync either by switching on the EXT button in the Control Bar or
using the External Sync command in the Options menu. The upper indicator LED next to
the EXT button will �ash if Live receives useable sync messages.

The External Sync
Switch.

When Live is synced to an external MIDI device, it can accept song position pointers from
this device, syncing it not only in terms of tempo but in terms of its position in the song. If
the master jumps to a new position within the song, Live will do the same. However, if the
Control Bar's Loop switch is activated, playback will be looped, and song position pointers
will simply be �wrapped� into the length of the loop.

23.1.3 MIDI Timecode Options

Timecode options can be set up per MIDI device. Select a MIDI device from the MIDI/Sync
Preferences' Active Device list to access the settings.

The MIDI Timecode Frame Rate setting is relevant only if �MIDI Timecode� is chosen from
the MIDI Sync Type menu. The MIDI Timecode Rate chooser selects the type of Timecode
to which Live will synchronize. All of the usual SMPTE frame rates are available. When the
Rate is set to �SMPTE All,� Live will auto-detect the Timecode format of incoming sync
messages and interpret the messages accordingly. Note that you can adjust the Timecode
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format that is used for display in the Arrangement View: Go to the Options menu, and then
access the Time Ruler Format sub-menu.

The MIDI Timecode Offset setting is also only relevant if �MIDI Timecode� is chosen from
the Sync Type menu. You can specify a SMPTE time offset using this control. Live will
interpret this value as the Arrangement's start time.

23.1.4 Sync Delay

The Sync Delay controls, which are separately available for each MIDI device, allow you to
delay Live's internal time base against the sync signal. This can be useful in compensating
for delays incurred by the signal transmission. The Sync Delay for a speci�c MIDI device
appears as you select the MIDI device from the MIDI Preferences' Active Device list. To
adjust the delay, have both Live and the other sequencer play a rhythmical pattern with
pronounced percussive sounds. While listening to the output from both, adjust the Sync
Delay control until both sounds are in perfect sync.

Adjusting Sync Delay.

23.2 Connecting via ReWire

Live supports the ReWire interface for connecting with another ReWire-compatible audio
program running on the same computer.
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The ReWire technology, developed by Propellerhead Software, provides ReWire-compatible
programs with:

� common access to the audio hardware;

� shared transport functionality;

� synchronization to audio word clock and song positioning;

� exchange of audio streams.

The programs in a ReWire connection play distinct roles: The ReWire master accesses the
audio hardware and provides mixing facilities; the ReWire slave(s) have no direct link to the
audio hardware, but instead send their audio output into the Master's mixer.

Common ReWire master applications are Digidesign Pro Tools, Steinberg Cubase and
Nuendo, Emagic Logic Audio, MOTU Digital Performer, Cakewalk Sonar and Cycling 74
Max/MSP. Common ReWire slave applications are Propellerheads Rebirth, Propellerheads
Reason, Arturia Storm, Cakewalk Project 5 and Cycling 74 Max/MSP. Live can act as both a
ReWire master and slave.

Note that the ReWire protocol itself does not consume much CPU power. However, as
expected, running two audio-intensive programs on the same computer requires more
resources than running a single program.

23.2.1 Running Live in ReWire Master Mode

The step-by-step procedure for sending MIDI to and receiving audio from a ReWire slave
program is presented in the routing chapter.
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23.2.2 Running Live in ReWire Slave Mode

If you have not used Live yet, please launch Live so that it can install its ReWire engine in
your system.

Live will run in ReWire slave mode if it detects a running ReWire master application upon
startup. Therefore, always start the ReWire master application �rst, and then start Live.

Likewise, you will �rst have to quit Live, then the ReWire master application.

Live's operation in ReWire slave mode differs from the usual operation in some regards:

� Live will not have direct access to the audio interfaces; audio input/output is handled
by the ReWire master application. No audio input will be available to Live.

� The sample rate is determined by the host application rather than by Live.

� External synchronization will be disabled (synchronize to the ReWire master application
instead). Live will not send sync or controller messages to the MIDI output. Controlling
Live via MIDI is still possible.

� Live will not act as a ReWire master application. For instance, you cannot run Rebirth
as a ReWire slave of Live while Live is running as a ReWire slave of Cubase. You can,
however, run both Live and Rebirth as ReWire slaves of Cubase at the same time.

23.2.3 More on ReWire

You can �nd tutorials on connecting Live to speci�c ReWire master programs at the Ableton
tutorial website1.

The Ableton FAQ website2 is the �rst place to go if you encounter ReWire-related problems.

1http://www.ableton.com/tutorials
2http://www.ableton.com/faq

http://www.ableton.com/tutorials
http://www.ableton.com/tutorials
http://www.ableton.com/faq
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If you cannot seem to �nd an answer there, please contact the Ableton support team3.

3http://www.ableton.com/support

http://www.ableton.com/support


Chapter 24

Computer Audio Resources and
Strategies

Real-time audio processing is a demanding task for general-purpose computers, which were
likely designed to run spreadsheets and surf the Internet. An application like Live requires
a powerful CPU and a fast hard disk. This section will provide some insight on these issues,
and should help you avoid and solve problems with running audio on a computer.

24.1 Managing the CPU Load

To output a continuous stream of sound through the audio hardware, Live has to perform
a huge number of calculations every second. If the processor can't keep up with what
needs to be calculated, the audio will have gaps or clicks. Factors that affect computational
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speed include the processor's clock rate (e.g., speed in MHz or GHz), architecture, memory
cache performance (how ef�ciently the processor can grab data from memory) and system
bus bandwidth � the computer's �pipeline� through which all data must pass. For this
reason, many people involved with pro audio use computers that are optimized for musical
applications.

The CPU Load Meter.

The Control Bar's CPU meter displays how much of the processor's computational potential is
currently being used. For example, if the displayed percentage is 10 percent, the computer
is just loa�ng along. If the percentage is 100 percent, the processor is being maxed out � it's
likely that you will hear gaps, clicks or other audio problems. Note that the CPU meter takes
into account only the load from processing audio, not other tasks the computer performs
(e.g., managing Live's user interface). Audio calculations have the highest priority in Live.
Therefore, even if the CPU shows a high percentage of processor usage, the audio stream
should remain uninterrupted. However, non-critical functions (such as screen redraws) might
slow down because these tasks are handled only when the audio processing �lightens up�
a bit.

24.1.1 CPU Load from Multichannel Audio

One source of constant CPU drain is the process of moving data to and from the audio
hardware. This drain can be minimized by disabling any inputs and outputs that are not
required in a project. There are two buttons in the Audio Preferences to access the Input
and Output Con�guration dialogs, which allow activating or deactivating individual ins and
outs.

Live does not automatically disable unused channels, because the audio hardware drivers
usually produce an audible �hiccup� when there is a request for an audio con�guration
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change.

24.1.2 CPU Load from Tracks and Devices

Generally, every track and device being used in Live incurs some amount of CPU load.
However, Live is �smart� and avoids wasting CPU cycles on tracks and devices that do not
contribute anything useful.

For example, dragging devices into a Live Set that is not running does not signi�cantly
increase the CPU load. The load increases only as you start playing clips or feed audio into
the effects. When there is no incoming audio, the effects are deactivated until they are
needed again. (If the effect produces a �tail,� like reverbs and delays, deactivation occurs
only after all calculations are complete.)

While this scheme is very effective at reducing the average CPU load of a Live Set, it cannot
reduce the peak load. To make sure your Live Set plays back continuously, even under
the most intense conditions, play back a clip in every track simultaneously, with all devices
enabled.

24.1.3 Track Freeze

Live's Freeze Track command, available from the Edit menu, can greatly help in managing
the CPU load incurred by devices and clip settings. When you select a track and execute
the Freeze command, Live will create a sample �le for each clip in the track, calculating and
�freezing� the contribution of devices and clip parameters. Thereafter, clips in the track will
simply play back their freeze samples rather than repeatedly calculating processor-intensive
device and clip settings in real time.

Most device and clip features in frozen tracks are not accessible. However, launching clips
can still be done freely, and mixer controls such as volume, pan and the sends are still
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available. Note that track freeze is not part of Live's Undo history, but executing the Edit
menu's Undo command to undo an action that affected a frozen clip will automatically
unfreeze the respective track.

Once any processor issues have been resolved (or you have upgraded your machine!), you
can always select a frozen track and choose Unfreeze Track from the Edit menu to change
device or clip settings. On slower machines, you can unfreeze processor-intensive tracks
one at a time for editing, freezing them again when you are done.

Besides providing an opportunity to conserve CPU resources on tracks containing a large
number of devices, the Freeze command simpli�es sharing projects between computers.
Computers that are a bit low on processor power can be used to run large Live Sets as
long as any CPU-intensive tracks are frozen. This also means that computers lacking certain
devices used in one Live Set can still play the Set when the relevant device tracks are frozen.

The samples generated by the Track Freeze command are stored in your temporary recording
folder until you save your Live Set, at which point they are moved to your Sounds folder.

Note: Frozen Arrangement View tracks will play back any relevant material stretching beyond
the lengths of their clips (e.g., the �tails� on Reverb effects). In the Session View, only
two loop cycles are included in the frozen clip, which means that clips with unlinked clip
envelopes will play back differently when frozen if those envelopes are longer than two loop
cycles.

24.2 Managing the Disk Load

A hard drive's access speed (which is related to, but not identical to, rotational speed) can
limit Live's performance. Most audio-optimized computers use 7200 RPM or faster drives.
Laptops, to save power, often use 5400 RPM or slower drives, which is why projects on
laptops usually have lower track counts. The amount of disk traf�c Live generates is roughly
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proportional to the number of audio channels being written or read simultaneously. A track
playing a stereo sample causes more disk traf�c than a track playing a mono sample.

The Disk Overload
Indicator.

The Disk Overload indicator �ashes when the disk was unable to read or write audio quickly
enough. When recording audio, this condition causes a gap in the recorded sample; when
playing back, you will hear dropouts.

Do the following to avoid disk overload:

� Reduce the amount of audio channels being written by choosing mono inputs instead
of stereo inputs in the Audio Preferences' Channel Con�guration dialog.

� Use RAM Mode for selected clips.

� Reduce the number of audio channels playing by using mono samples instead of
stereo samples when possible. You can convert stereo samples to mono using any
standard digital audio editing program, which can be called up from within Live.
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Live Keyboard Shortcuts

25.1 Showing and Hiding Views

Windows Macintosh
Toggle Full Screen Mode F11 Ctrl F11

Toggle Session/Arrangement View
Toggle Track/Clip View
Hide/Show Track/Clip View F12 F12

Double-Click Clip / Track Double-Click Clip / Track
Hide/Show Info View ? ?

Hide/Show Overview Ctrl Alt O Alt O

Hide/Show In/Out Ctrl Alt I Alt I

Hide/Show Sends Ctrl Alt S Alt S

347
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Windows Macintosh
Hide/Show Mixer Ctrl Alt M Alt M

Hide/Show Crossfader Ctrl Alt F Alt F

Open the Preferences N/A ,

Close the Preferences N/A Esc

25.2 Accessing Menus

Under Windows, you can access each menu by pressing Alt and the �rst letter of the
menu ( Alt F for �File�, for instance). While a menu is open, you can use:

� to navigate the menu items;

� to open the neighboring menu;

� Return to choose a menu item.

25.3 Adjusting Values

Windows Macintosh
Increment/Decrement
Large Increment/Decrement Page Page Page Page

Return to Default Delete

Type in Value 0   .. 9 0   .. 9

Go to Next Field (Bar.beat.16th) . , . ,

Abort Value Entry Esc Esc

Con�rm Value Entry Return Return
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25.4 Browsing

In addition to the shortcuts shown here, editing shortcuts can also be used in the Browser.

Windows Macintosh
Activate Browser Search Mode Ctrl F F

Load Selected Item From Browser Return Return

or Double-Click or Double-Click
Scroll Up/Down
Open/Close Folders
Preview Selected File
Set Selected Folder as Browser Root Return Return

25.5 Transport

Windows Macintosh
Play from Start Marker/Stop Space Space

Continue Play from Stop Point Space Space

Play Arrangement View Selection Ctrl Space Alt Space

Record F9 F9

Back to Arrangement F10 F10

Activate/Deactivate Track 1..8 F1 .. F8 F1 .. F8
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25.6 Editing

Windows Macintosh
Cut Ctrl X X

Copy Ctrl C C

Paste Ctrl V V

Duplicate Ctrl D D

Delete Delete

Undo Ctrl Z Z

Redo Ctrl Z Z

Rename Ctrl R R

Select All Ctrl A A

By holding down an additional modi�er key, some of the above commands can also be
applied to:

Windows Macintosh
Clips and Slots Across all Tracks
Time Across all Tracks
The Selected Part of the Envelope Alt Alt

can be used to move from one track or scene to another while renaming.

25.7 Loop Brace and Start/End Markers

The loop brace and start/end markers must �rst be selected before any of the following
commands will apply to them.
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Windows Macintosh
Move Start Marker to Position Click Click
Nudge Loop Left/Right
Move Loop By Loop Length
Double/Halve Loop Length Ctrl

Shorten/Lengthen Loop Ctrl

Select Material in Loop Click Loop Brace Click Loop Brace
or Ctrl L or L

25.8 Session View Commands

See also the editing commands.

Windows Macintosh
Launch Selected Clip/Slot Return Return

Select Neighbouring Clip/Slot Arrow Keys Arrow Keys
Select all Clips/Slots Ctrl A A

Copy Clips Ctrl Drag Alt Drag
Add/Remove Stop Button Ctrl E E

Insert MIDI clip Ctrl M M

or Double-Click Slot or Double-Click Slot
Insert Scene Ctrl I I

Insert Captured Scene Ctrl I I

Drop Browser Clips as a Scene Ctrl



25.9. ARRANGEMENT VIEW COMMANDS 352

25.9 Arrangement View Commands

The shortcuts for zooming, snapping/drawing and loop/region settings also work in the
Arrangement View. See also the editing commands.

Windows Macintosh
Split Clip at Selection Ctrl E E

Consolidate Selection into Clip Ctrl J J

Loop Selection Ctrl L L

Insert Silence Ctrl I I

Pan Left/Right of Selection Ctrl Alt Alt

Unfold all Tracks Alt Unfold button Alt Unfold button
Scroll Display to Follow Playback Ctrl F F

25.10 Commands for Tracks

See also the editing commands.

Windows Macintosh
Insert Audio Track Ctrl T T

Insert MIDI Track Ctrl T T

Insert Return Track Ctrl Alt T Alt T

Rename Selected Track Ctrl R R

While Renaming, Go to next Track
Arm/Solo Multiple Tracks Ctrl Click Click
Add Device from Browser Double-Click Double-Click
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25.11 Commands for Breakpoint Envelopes

The shortcuts for zooming, snapping/drawing and loop/region settings also work in the
Envelope Editor and Arrangement View. See also the editing commands.

Windows Macintosh
Finer Resolution for Dragging Ctrl

Enable Dragging Over Breakpoints

25.12 Key/MIDI Map Mode and the Computer MIDI Key-
board

Windows Macintosh
Toggle MIDI Map Mode Ctrl M M

Toggle Key Map Mode Ctrl K K

Computer MIDI Keyboard Ctrl K K
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25.13 Zooming, Display and Selections

Windows Macintosh
Zoom In + +

Zoom Out - -

Drag/Click to Append to a Selection
Click to Add Adjacent Clips to Multi-Selection
Click to Add Nonadjacent Clips to a Multi- Ctrl

Selection
Follow (Auto-Scroll) Ctrl F F

Pan Left/Right of Selection Ctrl Alt Alt

25.14 Clip View Sample Display

The shortcuts for zooming and loop/region settings also work in the Sample Display.

Windows Macintosh
Move Selected Warp Marker
Select Warp Marker Ctrl

Scroll Display to Follow Playback Ctrl F F

Move Clip Region with Start Marker
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25.15 Clip View MIDI Editor

The shortcuts for zooming, snapping/drawing and loop/region settings also work in the
MIDI Editor.

Windows Macintosh
Quantize Ctrl U U

Scroll Editor Vertically Page Page Page Page

Scroll Editor Horizontally Ctrl Page Page Page Page

Copy Note Ctrl Drag Alt Drag
Change Velocity From Note Editor Alt Drag Drag
Add/Delete Note in Edit Mode Double-Click Double-Click
Scroll Display to Follow Playback Ctrl F F

Move Clip Region with Start Marker

25.16 Grid Snapping and Drawing

Windows Macintosh
Toggle Draw Mode Ctrl B B

Narrow Grid Ctrl 1   1   

Widen Grid Ctrl 2   2   

Triplet Grid Ctrl 3   3   

Snap to Grid Ctrl 4   4   

Fixed/Zoom-Adaptive Grid Ctrl 5   5   

Bypass Snapping While Dragging Alt
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25.17 Global Quantization

Windows Macintosh
Sixteenth-Note Quantization Ctrl 6   6   

Eighth-Note Quantization Ctrl 7   7   

Quarter-Note Quantization Ctrl 8 8

1-Bar Quantization Ctrl 9 9

Quantization Off Ctrl 0   0   

25.18 Working with Sets and the Program

Windows Macintosh
New Live Set Ctrl N N

Open Live Set Ctrl O O

Close Live Set Ctrl W W

Save Live Set Ctrl S S

Save Live Set As... Ctrl S S

Quit Live Ctrl Q Q

Hide Live N/A H

Render to Disk Ctrl R R

Export MIDI �le Ctrl E E
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25.19 Working with Plug-Ins and Devices

Windows Macintosh
Show/Hide Plug-In Windows Ctrl P P

Open Second/Multiple Windows with Ctrl

Plug-In Edit Button
Open Mac Keystroke Plug-In Window N/A
with Plug-In Edit Button
Group/Ungroup Devices Ctrl G G

Activate/Deactivate All Devices in Group Alt Alt

Device Activator Device Activator
Click to Append Devices to a Selected
Device
Load Selected Device From Browser Return Return

or Double-Click or Double-Click

25.20 Using the Context Menu

A context menu is available in Live for quick access to many commonly used menu items.
To access the context menu, (PC) / Ctrl (Mac) on the part of the interface where
you would like to execute a particular command. It is worth noting that Live's context menu
may sometimes contain applicable settings from the Preferences. You should change these
options with care, as they will affect not only the currently selected item but the general
settings of the program.

Some commands only appear in the context menu. These are: the Create Folder, Analyze
Audio, Search In Folder, Close All Folders and Refresh commands from the Browser; the
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special grid marker commands for directing Auto-Warp; detailed options for zoom-adaptive
and �xed grid line width; and copying and pasting for Operator's envelopes and oscillators.
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Index
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Auto-Warp . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 118
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and grid lines . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .218
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recording . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 214

Automation Control chooser . . . . . . . . . . . . . . . . . . . 217
Automation Device chooser . . . . . . . . . . . . . . . . . . . . 217

B

Back to Arrangement button . . . . . . . . . . . 28, 86, 215
Beat Repeat effect . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 240
beat-time ruler

and Arrangement editing . . . . . . . . . . . . . . . . . . . 65
and editing envelopes . . . . . . . . . . . . . . . . . . . . . 233
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envelopes
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Browser . see File Browser, see Live Device Browser,

see Plug-In Device Browser
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C

Capture and Insert Scene command . . . . . . . . . . . . . 85
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Clip Envelope Control chooser . . . . . . . . . . . . . . . . . 224
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scrambling beats with . . . . . . . . . . . . . . . . . . . . . 227
unlinking from clips . . . . . . . . . . . . . . . . . . . . . . . . 233
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Clip Launch button . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 79
Clip Name �eld . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 92
Clip Nudge buttons . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 94
Clip Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 88

for zooming/scrolling . . . . . . . . . . . . . . . . . . . . . . . 98
Clip Quantization chooser . . . . . . . . . . . . . . . . . . . . . .141
Clip Record button . . . . . . . . . . . . . . . . . . . . . . . . . 39, 184
Clip Signature �elds . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 93
Clip Stop button . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 79

adding/removing . . . . . . . . . . . . . . . . . . . . . . . . . . . 84
Clip Update Rate preference . . . . . . . . . . . . . . . . . . . 110
Clip View. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .88

and playing the Arrangement . . . . . . . . . . . . . . . 68
and remote-control mapping . . . . . . . . . . . . . . 320
scrub area . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 100

Clip View boxes selector . . . . . . . . . 91, 125, 139, 223
clips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25

adding fades to . . . . . . . . . . . . . . . . . . . . . . . . . . . 106
arranging/editing . . . . . . . . . . . . . . . . . . . . . . . . . . . 71
as templates. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .229
audio clips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29
clip multi-selections . . . . . . . . . . . . . . . . . . . . . . . . .89
deactivating/muting . . . . . . . . . . . . . . . . . . . . . . . . 92
editing MIDI notes/velocities . . . . . . . . . . . . . . 124
importing from �les . . . . . . . . . . . . . . . . . . . . . . . . . 51
in Arrangement View . . . . . . . . . . . . . . . . . . . . . . . 71
in audio/MIDI tracks . . . . . . . . . . . . . . . . . . . . . . . . 28
in Session View . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 79
Live Clips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58
managing meter offset . . . . . . . . . . . . . . . . . . . . . .95
MIDI clips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .30

renaming . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 92
reversing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 107
saving settings for . . . . . . . . . . . . . . . . . . . . . . . . . 105
setting properties of . . . . . . . . . . . . . . . . . . . . . . . . 88

Close All Folders command . . . . . . . . . . . . . . . . 48, 197
Complex Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 123
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and automation editing. . . . . . . . . . . . . . . . . . . .215
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and track freeze . . . . . . . . . . . . . . . . . . . . . . . . . . . 344

Unfold Track button . . . . . . . . . . . . . . . . . . . . . . . . 72, 217
Unfreeze Track command . . . . . . . . . . . . . . . . . . . . . . 344
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